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1 What’s New in This Release
What’s New in Siebel Pharma Handheld

Table 1 lists descriptions of the changes made to this version of the documentation to support 
Release 7.8 of the software.

Table 1. What’s New in Siebel Pharma Handheld, Version 7.8

Topic Description

“Configuration Guidelines for Siebel 
Handheld” on page 20

Revised and expanded the general guidelines, including 
screen and view design, for configuring Siebel Handheld 
applications.

“Performing Setup for Initial String 
Translation” on page 31

Revised setup procedure for allowing translation capability in 
Siebel Handheld applications.

“Configuring Signature Capture 
Capabilities in Siebel Handheld” on 
page 36

Revised and expanded this topic with information on enabling 
signature capture, signature display, and the Signature 
Capture applet control user properties.

“Creating Siebel Handheld Views” 
on page 47

Revised procedures for creating new views in the Siebel 
Handheld applications and adding those views to a user’s 
responsibilities.

“About Thread Throttling” on 
page 51

Added new topic describing the method for allowing the 
maximum number of concurrent synchronizations.

“Configuring Application Settings for 
Siebel Handheld” on page 53

Added new topic describing parameter settings in the 
Administration - Mobile screen.

“Administering Barcode Settings for 
Siebel Handheld” on page 58

Revised and expanded this topic with information on enabling 
barcode scanning, mapping a button for the Socket In-Hand 
Scan Card, and creating barcode definitions.

“Acting Upon Synchronization Errors 
in Siebel Handheld” on page 69

Added descriptions of user options after encountering 
synchronization errors.

Data Filtering

“Constructing Business Component 
and Business Object Filters” on 
page 88

“Examples of Default Business 
Object Declarations” on page 90

Revised and expanded Data Filtering chapter with examples 
of business component filter syntax, business object filter 
syntax, and default business object declarations.
Siebel Pharma Handheld Guide Version 7.8 11



What’s New in This Release ■ 
Logging Levels

“Configuring Direct Server Sync 
Logging Levels” on page 98

“Configuring Companion Sync 
Logging Levels” on page 99

Added information on Logging Level parameters and how to 
configure them.

“Providing Synchronization Security 
with Secure Sockets Layer” on 
page 101

Added information on securing the synchronization data 
stream by using Secure Sockets Layer (SSL).

“Editing the Handheld Application 
Installation Configuration File” on 
page 102

Revised and expanded this table of setup.ini parameters and 
their descriptions.

“Changing the SyncURL on Siebel 
Handheld Devices” on page 108

Updated information on using SyncURL to allow 
communication between the handheld synchronization client 
and the handheld synchronization server.

“Preventing Synchronization 
Transaction Conflicts with Siebel 
Handheld” on page 113

Revised the information on Extended Pick processing and 
handling Insert Failure processing.

“Using Companion Synchronization 
with the Handheld Client” on 
page 136

Revised information on performing Companion Sync, 
including Integrated Sync.

“Companion Sync Checklist” on 
page 184

“Direct Server Sync Checklist” on 
page 185

Revised troubleshooting information to help users determine 
why or when a synchronization has failed.

“Log Files” on page 186 Revised this section on logs and output files to include 
information on logging Siebel Handheld synchronization 
errors.

“SQLTrace” on page 188 Added information on enabling and using SQL tracing.

“PrinterType” on page 239 Revised the list of supported printers for Siebel Handheld.

Table 1. What’s New in Siebel Pharma Handheld, Version 7.8

Topic Description
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2 Overview of Siebel Pharma 
Handheld
This chapter includes the following topics:

■ “About Siebel Handheld” on page 13

■ “Overview of Siebel Handheld Synchronization” on page 14

■ “Siebel Handheld Synchronization Methods and Architecture” on page 14

■ “Overview of Siebel Handheld Client Application Configuration” on page 15

About Siebel Handheld
Siebel Handheld provides a focused subset of functionality to that of the Siebel Web Client. The Siebel 
Handheld Client differs from the Siebel Web Client and the Siebel Mobile Web Client in that it uses a 
selected subset of views, accommodates smaller screen sizes, and has a reduced memory capacity. 
For a list of functional differences, see Chapter 3, “Application Development.”

Some features that are available on the Siebel Mobile Web Client are not available on the Siebel 
Handheld. Scripting and Siebel engines (for example, Pricing and Reporting) are not supported on 
the handheld. For a list of features that are not supported, see “Unsupported Features for Siebel 
Handheld” on page 18. 

Some supported features of the Siebel Handheld client are as follows:

■ Application Development with Siebel Tools. Siebel Handheld applications can be configured 
in Siebel Tools using the Web Applet Designer. You can take your existing Siebel application and 
use this as the basis for the Siebel Handheld application, or you can create a new application by 
using the Siebel Tools application shipped on the Siebel Handheld application DVD. See 
Chapter 3, “Application Development,” for more information.

■ Data filtering. Filtering allows you to specify a subset of data to be used on the handheld device. 
Filtering is an important feature of a Siebel Handheld deployment because of the relatively large 
size of the average enterprise database in comparison to the relatively limited memory 
capabilities of handheld devices. It is important that you allocate sufficient time in the project 
plan to create and test the handheld filters. See “Application Development” on page 17 for more 
information.

■ Installation options. The Siebel Handheld application can be installed on Windows-powered 
devices in one of two ways. The first is to create a partnership between a desktop or laptop PC 
and the handheld device using Microsoft ActiveSync. The second is to install the Siebel Handheld 
application from external media, for example, a Cabinet (CAB) file. Handheld patches can be 
remotely deployed using PatchAgent. For more information, see Chapter 8, “Installing the 
Handheld Application.”
Siebel Pharma Handheld Guide Version 7.8 13



Overview of Siebel Pharma Handheld ■ Overview of Siebel Handheld Synchronization
■ Patch Updates. Siebel Handheld automatically applies the latest software patches to the 
handheld device when needed. Companion Sync allows users to Synchronize the Handheld 
Database to the local database on Companion PC and invokes Siebel Remote to synchronize the 
local database with the server database.

PatchAgent automates the deployment of patches to handheld devices as part of the 
synchronization process. For more information on PatchAgent, see “Installing the Siebel Handheld 
Application from External Media” on page 108.

■ Backing Up and Restoring Data. The Siebel Handheld application provides database backup 
functionality. A database restore utility is also included with the application. See “Enabling 
Handheld User Database Backup” on page 105 for details.

Overview of Siebel Handheld 
Synchronization
The Siebel Handheld Synchronization (Sync) client synchronizes data between the Siebel Handheld 
database and the Mobile Web Client database or server database. The synchronization process does 
the following: 

■ Updates the Siebel server database with changes made to the Siebel Handheld database

■ Updates the database on the handheld device with changes made to the Siebel server database

■ Downloads metadata changes, such as object definitions for new or modified screens or views

■ Allows users to select filters to limit the amount of data that is downloaded

■ Automatically applies the latest software patches to the handheld device when needed

Siebel Handheld Synchronization 
Methods and Architecture
The following methods can be used to synchronize data on the handheld device with data in the 
Siebel server database: Companion Sync (CS), Direct Server Sync (DSS) and Direct Server Sync via 
Proxy (DSSvP). The architecture of these methods is discussed in the following sections.

Handheld Synchronization 
A Handheld synchronization server component run on the Siebel application server can accept 
concurrent synchronization requests from multiple synchronization clients. When connecting directly 
to a server, the Siebel Handheld Sync client synchronizes its data directly to a server database. 
Companion Sync allows users to synchronize the Handheld Database to the local database on a 
companion PC device and invokes Siebel Remote to synchronize a local database with the server 
database. 
Siebel Pharma Handheld Guide Version 7.814 



Overview of Siebel Pharma Handheld ■ Overview of Siebel Handheld Client Application
Configuration
In Direct Server Sync mode, the Siebel Handheld Synchronization client uses the HTTP(S) protocol 
over a network connection to communicate with the handheld synchronization server. Users should 
configure their handheld devices for communication over the desired network.

A companion synchronization server runs on a companion personal computer with a Mobile Web 
Client installation and supports synchronization with a data source specified in a client configuration; 
the database resides on the companion PC.

Companion Sync
Companion Sync allows users to synchronize the Siebel Handheld application and database with a 
Siebel Remote database on a Mobile Web Client.

Microsoft ActiveSync is used to connect the handheld device and the companion PC through a serial 
or USB connection. The user launches Siebel Handheld Sync from companion PC or the device. The 
user can change the default filters using Siebel Handheld Sync.

Direct Server Sync
Direct Server Sync allows users to synchronize their Siebel Handheld application and database 
directly with the Siebel server. The user connects the handheld device to the Siebel application server 
through a network connection that uses the HTTP protocol. The connection runs through a IIS Web 
server to the application server, where the Sync server components are installed and running.

Direct Server Sync via Proxy
Direct Server Sync via Proxy (DSSvP) allows users to synchronize their Siebel Handheld application 
and database directly with the Siebel server. The user connects the handheld device to the Siebel 
application server through ActiveSync and the network connection established by the companion PC. 
The connection runs through a IIS Web server to the application server, where the Sync server 
components are installed.

Overview of Siebel Handheld Client 
Application Configuration
The following provides an overview of the configuration process of the Handheld client. Complete the 
following steps to configure your handheld client application.

To configure the Siebel Handheld client

1 Define the user functionality. 

Determine which user interface elements (such as screens, views, toolbars, applets, find, and 
help) will be necessary for your Siebel Handheld Client end users. For more information, see 
“About Defining User Functionality in Siebel Handheld” on page 20.
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Overview of Siebel Pharma Handheld ■ Overview of Siebel Handheld Client Application 
Configuration
2 Configure the Siebel Handheld Client user interface. 

The process for configuring user interface elements in the Siebel Handheld Client is the same as 
that for other Siebel clients. For more information, see “Configuring User Interface Elements in 
Siebel Handheld” on page 25 and Configuring Siebel Business Applications.

3 Identify all eScript or VB script.

Siebel Handheld applications do not currently support scripting, including eScript or VB script. 
Scripting used in your Siebel application may conflict with your Siebel Handheld application 
configuration.

4 Compile the new configuration.

For more information, see “Compiling the Siebel Handheld Application” on page 30.

5 Test the new configuration. 

Test the configuration, repeating the previous steps, to address any configuration errors.

After completing the Siebel Handheld Client configuration, you are ready to install it on the handheld 
devices. To install the Siebel Handheld configuration on a handheld device, see the instructions in 
“Installing the Siebel Handheld Application” on page 121.
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3 Application Development
This chapter includes the following topics:

■ “Overview of Siebel Handheld Architecture” on page 17

■ “Unsupported Features for Siebel Handheld” on page 18

■ “About Defining User Functionality in Siebel Handheld” on page 20

■ “Configuration Guidelines for Siebel Handheld” on page 20

■ “About Creating Siebel Handheld Projects” on page 22

■ “Designing Screens and Views for Siebel Handheld” on page 23

■ “Configuring User Interface Elements in Siebel Handheld” on page 25

■ “Scripting in the Siebel Handheld Client” on page 29

■ “Compiling the Siebel Handheld Application” on page 30

■ “Configuring Printing from the Siebel Handheld Application” on page 33

■ “Configuring Signature Capture Capabilities in Siebel Handheld” on page 36

■ “Testing the Siebel Handheld Application” on page 43

Overview of Siebel Handheld 
Architecture
The process for configuring a Siebel Handheld Client has a few differences, described in this chapter, 
from the process for configuring other types of Siebel clients.

NOTE: Readers should familiarize themselves with the Siebel client configuration process described 
in Configuring Siebel Business Applications before attempting to configure the Siebel Handheld 
Client.

The five layers in the Siebel Handheld architecture are comparable to those used on the Siebel Web 
Client: 

Application layer. The application layer starts and closes the application.

User Interface layer. The user interface layer renders the display and interacts with actions of the 
user.

Object Manager layer. The object manager layer provides a consistent object behavior and 
interaction between all business objects within the application.

Data Manager layer. The data manager layer maintains an object-oriented abstraction of the native 
data stored in the data repositories for the benefit of the object manager.
Siebel Pharma Handheld Guide Version 7.8 17



Application Development ■ Unsupported Features for Siebel Handheld
Database layer. The database layer includes the data that Siebel Handheld users access.

Your Administrator configures an application on the Siebel client using Siebel Tools and compiles the 
Siebel repository (.srf) file. During the synchronization process, information specific to the Siebel 
Handheld Client is extracted from the Siebel repository file. This information is used to create a 
repository metalanguage (.rml) file, which is downloaded to the handheld device. 

The repository metalanguage file contains the layout information for the handheld device but not the 
database layer. The database layer is generated in the transport file called dbfile.txt, which is 
downloaded and imported to the handheld database (siebelDB.sdf).

For more information on Siebel Tools, see Using Siebel Tools. 

Unsupported Features for Siebel 
Handheld
The differences between configuring user interface elements for the Siebel Web Client and the Siebel 
Handheld Client are shown in Table 2.

The following are not supported in Siebel Handheld applications:

■ The following applet types are not supported:

■ Chart

■ Explorer

■ Group boxes are not supported. See “Group Boxes” on page 26 for more information.

■ Alarm Manager is not supported. Therefore, if an alarm check box is added to an applet and the 
check box is selected, no alarm sounds.

■ The base time zone is determined by the system settings on the server and cannot be changed 
on the handheld device.

■ Alphabet tabs are not supported.

■ Scripting is not supported. However, any scripts on the business components will be executed 
during synchronization.

■ Siebel Workflow is not supported. 

See the following topics which outline, more specifically, other unsupported features. 

Table 2. Configuring Siebel Client User Interface Elements

Client Siebel Tools SWT Template Files
Specialized 
Algorithms

Siebel Web Client Yes Yes No

Siebel Handheld Client Yes No Yes
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Application Development ■ Unsupported Features for Siebel Handheld
Multi-Value Groups (MVG)
The Multi-Value Group applet is not supported on the Siebel Handheld Client; however, the Multi-
Value Group relationship is supported. The Multi-Value Group (MVG) control button does not appear 
on fields in Siebel Handheld Client applications. Instead, MVGs can be implemented as parent-child 
views. As a result, MVG fields are not editable within the parent record. In the Siebel Web Client, 
addresses of accounts are added, deleted, or edited through the Business Address MVG applet. 
However, in the Siebel Sales Handheld Client, these functions must be done through a Business 
Address child applet with an Account applet as its parent.

On the handheld device, all MVG fields are displayed as read-only, with the primary record visible. 
The first record will be displayed if the primary record is not specified. If you have an application or 
business requirement that requires the user to view or update all the records in the MVG, you must 
configure a separate view for that MVG. For example, the Address field in the Accounts or My 
Accounts view is an MVG. In the Siebel Handheld Client that field is read-only and displays the 
primary record. In order for the handheld user to see and update the addresses, the new Address 
view is configured in Siebel Tools. This new Address view is visible in the Show drop-down list.

Functions
Siebel Handheld applications support most of the calculated fields and operations used in the Siebel 
Web applications with a few exceptions. See Table 3 for a list of the unsupported functions.

Table 3. Unsupported Functions

Function Name

BCHasRows

DockingNodeId

DockingNodeName

DockingNodeRoutId

EAILookupExternal

EAILookupSiebel

EXISTS

GetHQInstanceId

GetHQInstanceName

GetNumBCRows

GetProfileAttr

GetXAval

IsDocked

LanguageName

LocaleName
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Application Development ■ About Defining User Functionality in Siebel Handheld
The NOT key word is not supported on Booleans. Use the != operator instead. For example, "Active" 
!= "Y".

The RowIdToRowNum function is supported differently in the handheld applications than in the Web 
applications. In Web applications, RowIdToRowNum converts a row Id to a numeric value. In the 
handheld applications, the row ID itself is returned.

About Defining User Functionality in 
Siebel Handheld
The first step in configuring a Siebel Handheld Client is to determine which user interface elements 
are necessary. Siebel Handheld Client users have different requirements from Siebel Web Client 
users. Keep in mind the differences in display size, memory capacity, and input methods between 
handheld devices and larger computers, such as desktop computers.

The goal is to create applications that are easy for your end users to use and which take advantage 
of the strengths of the handheld device platform. Because of processing speed, memory limitations, 
and form factor differences, you should only include those user interface elements that are necessary 
for users to complete their job responsibilities.

Configuration Guidelines for Siebel 
Handheld
There are a few general guidelines you should bear in mind when configuring for the Siebel Handheld 
application. Use these guidelines when you design any new objects for the Siebel Handheld Client. 
This approach facilitates a logical separation of the Siebel Handheld Client user interface elements 
from the Siebel Web Client user interface elements. 

■ Identify User Activities

■ To conserve memory (and thereby improve performance) and ease navigation, identify 
business processes that are required by end users and develop applications that support 
these processes. 

LookupMessage

LookupTranslation

NOT

RepositoryId

RepositoryName

RowIdToRowNum

ToolsLanguage

Table 3. Unsupported Functions

Function Name
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■ If more than one type of user needs a Siebel Handheld Client application, it is preferable to 
divide the application into multiple responsibilities rather than give all possible users access 
to all available screens and views. Responsibilities are fully configurable by the application 
developer.

■ Do not include additional functionality that is not required to reside on the device.

■ Limit the number of screens and views

■ Keep the number of views in your application to 30 or fewer. Determine critical business 
processes that the handheld will support and only pick the views that are necessary and are 
compliant with your business requirements. 

■ Limit the number of views within a screen to 12 or fewer to keep the View drop-down list 
concise. 

■ Limit the number of screens to 6 or fewer to keep the Screen drop-down list concise.

■ Keep screen names to about 15 characters or fewer, so that they fit in the Screen drop-down 
list. The number of characters is a general guide because characters vary in width. 

■ Keep view names to about 30 characters or fewer so that they fit in the View drop-down list. 
The number of characters is a general guide because characters vary in width.

■ Limit the number of applets for each view

Design each view so that it has one or, at most, two applets. Limiting the number of applets 
enhances performance, and enriches the user experience.

NOTE: Some views contain three applets. Use the toggle button to navigate between the two 
child applets.

■ Limit the number of columns and fields for each applet to minimize scrolling

Consider the following when designing your applets:

■ Design applications that contain as few screen and view hierarchy levels as possible. In a 
Web-based application, you may have views with many applets, and the user toggles 
between the applets. However, for handheld applications, create more views with fewer 
applets to allow users to quickly find information with a minimal amount of toggling.

■ Include the most important fields and columns that a user needs to see at a glance before 
scrolling. For example, if you have a form applet that is a parent, include only needed fields 
to avoid scrolling.

■ If you are using a list applet, determine how wide it needs to be.

■ Design each applet so that it only contains columns and fields that are required for end-user 
tasks. 

■ Consider moving required and editable fields into visible area of the applet where users can 
enter data and would not have to scroll. Because there is less screen space on a handheld 
device than on a laptop or desktop, the most important data should be immediately visible.

■ The Date Column can be formatted to show only the date instead of Date and Time where 
Time is not relevant. This saves the user from having to scroll.

■ To minimize horizontal scrolling, limit the number of columns displayed in a list applet to no 
more than ten. 
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■ There is no limit on the number of fields in form applets of single-applet views. However, to 
minimize scrolling, keep the number of fields to 20 or fewer. 

■ Use a form applet for the parent for each parent-child view.

■ In a multi-applet view, limit the number of fields in form applets to five or fewer. Add 
additional fields only if the field width is short. For example a check box field. 

■ Reduce the number of fields if the fields are multi-line, for example, a Comments box that 
contains three lines of text.

■ Do not include read-only check boxes in form applets. It is very difficult for users to discern 
that the check box is not editable.

■ Do not add pick applets or set the Runtime property to true for Read-Only fields that have a 
picklist value associated to them. This will improve overall extraction time, synchronization 
time and dbfile.txt file size since the process will not be forced to extract all the picklist values 
for these fields. 

■ Keep query names to about 15 characters or fewer, so that they fit in the Queries drop-down 
list. For example, North American Organization is too long for a query name, so you should 
change it to a shorter name, such as N. American Org. The number of characters is a general 
guide because characters vary in width (for example, W is wider than i).

■ For each screen, create a single-applet More Info view. Create this applet as a form applet. 
For example, for the Contacts screen, create a More Info view that has the Contacts form 
applet only.

■ For each screen, create a view called My * or All * as a single list applet view. For example, 
for the Activities screen, create a My Contacts view that has the Contacts list applet only.

■ Design Data Filters

■ Limit the size of the dbfile.txt file to less than three megabytes (MB). The RDBMS on the 
handheld device is approximately three times the size of dbfile.txt. If the data files are so 
large that they cannot be imported into the database with the available memory, users 
cannot successfully synchronize their data. See Chapter 5, “Data Filtering” for information on 
how to design data filters to limit the amount of data that is synchronized to the handheld.

■ When working with assessment creation functionality, you need to name your templates in 
such a way that they will filter only the needed templates that will be downloaded to the 
device. Without properly setting up filters, all templates will be downloaded to the device.

About Creating Siebel Handheld Projects
The Siebel Handheld projects appear in the list of projects in Siebel Tools; when Project is selected 
in the Object Explorer, the list of projects is displayed in the Object List Editor.
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Use a naming convention that allows you to easily identify applications, screens, views, and applets 
belonging to a particular Siebel Handheld application. This allows you to locate all the object 
definitions in a Siebel Handheld application by querying on the name in the Object List Editor. For 
example, all of the Siebel Handheld Client screens, views, applets, toolbars, and menus use either 
an SHCE prefix (for example, SHCE Sales Account List view) or a CE suffix. Use the Object List Editor 
to query for views that contain the prefix SHCE or the suffix CE; doing so displays all of the Siebel 
Handheld Client views.

If you create a new Siebel Handheld application, create a new suffix or prefix to identify the name 
of the application and each screen, view, and applet name. For example, you could use PPC_SHCE 
for an application.

Designing Screens and Views for Siebel 
Handheld
Each view in a Siebel Handheld application can display a maximum of two applets at a time, 
regardless of the number of applets in the view. If there are more than two applets in a view, the 
user can navigate to additional applets by toggling.

Screen Allocation
The amount of screen space available for applets is determined by the type of applets in the view. 
Two applets are stacked above one another. A parent form applet in a two-applet view displays 
multiple fields on a screen. Users use the scroll bar to navigate. The form applet dynamically resizes 
if there are fewer than five fields and, therefore, does not waste screen display space with empty 
lines. The maximum number of fields that are displayed at one time is configurable by setting the 
Max Parent Applet Size preference in the User Preferences dialog. See “Setting User Preferences in 
the Siebel Handheld Application” on page 133 for more information on this user preference.

Toggling Between Multiple-Applet Views 
The Siebel Handheld Client application displays up to two applets at one time. If the view has only 
one applet, the applet takes up the entire display area. For views with two or more applets, the first 
two applets in the view are displayed, and the user toggles to see the other applets. The first applet 
is always displayed and the second applet changes as you toggle.

By default, the user toggles by choosing the View > Toggle menu item. In addition, it is 
recommended that you provide a toggle button as a visual cue to the end user that there are 
additional applets. Add a toggle button to each applet except the first applet. Identify the button with 
a Toggle caption and set methodInvoked to ToggleApplet.

Drill-Down Only Views
Some views may be drill-down only views—that is, they can only be accessed by navigating from 
another view. These views should not be accessible through the Show drop-down list. However, when 
the end user navigates to the view, the view title appears in the Show drop-down list. To configure 
a drill-down only view, set the view title as you would for any other view and set the ScreenMenu 
property to FALSE. See Configuring Siebel Business Applications for more information.
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Applet Focus Behavior
When navigating between views, there may be instances when you need to override the default 
behavior for giving focus to an applet

The GotoView method is used to navigate from one view to another. A button control is added to the 
applet in the view you want to navigate from, the button’s methodInvoked property is set to 
GotoView and the button’s View property is set to the view that is to be created. When the GotoView 
method is executed, it builds the specified view. If the view includes a parent and child applet, 
GotoView gives focus to the child applet. This is the desired behavior in most instances when you 
are simply navigating from one view to another.

If the desired behavior is to navigate to a new view and, additionally, to create a new record, then 
you must use the GotoViewNewRecord method. This method calls two methods; first it calls 
GotoView, and then it calls NewRecord, which creates a new record in the new view. 

In some instances the default behavior of these methods does not produce the intended behavior. 
For example, in the Orders view of the Service Requests screen, when you tap the Create New Order 
button, it takes you to the Order Details view, which contains a parent form applet (Service Request 
Order) and a child list applet (Service Order Entry Line Item). In this instance, when the Create New 
Order button’s GotoViewNewRecord method is executed, you want a new order to be created. 
However, the default behavior is to give focus to the child applet rather than creating a new record 
in the parent applet. Therefore, you need to override the default behavior of GotoView with the 
control user property OverrideDefaultApplet, and set the value to the applet that you want to give 
focus. The valid values are 0 (parent) and 1 (child). For example, if you create a button labeled 
“Create Service Request Order,” you would define user properties shown in Table 4:

Views with Associated Print Templates or Reports
Print templates are text files that you design and create for printing. After creating a print template, 
you associate it with an applet. When an end user chooses to print from a view, the print template 
that is associated with the applet is automatically selected and used for printing. Follow these 
guidelines when creating print templates:

■ Only one print template can be associated with an applet.

■ The print template name for a particular display applet is registered in the Mail Template property 
in the Applet object associated with the applet.

■ The template must be placed in the Templates directory.

■ The template name that goes into the Mail Template property should not include a path name or 
extension. For example, if the full path of the template is \Program Files\Siebel 
Handheld\Templates\InvoiceTemplate.txt, you would enter only the root name InvoiceTemplate 
in the property field.

Table 4. User Properties

Name Value

View SHCE Service Order Line Items View

OverrideDefaultApplet 0
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■ The template file itself must have a .txt extension on the device. 

For more information, see Appendix F, “Print Configuration Settings.”

Configuring User Interface Elements in 
Siebel Handheld
When configuring user interface elements on the Siebel Handheld Client, also consider the processing 
speed and memory constraints of handheld devices. The constraint on processing speed affects the 
performance of a handheld device. The performance of a handheld device is also related to the 
number of screens and views downloaded to the handheld device. Because handheld devices are not 
meant to provide the same functionality as larger devices, such as laptops, the number of screens 
and views must be kept to a minimum on the handheld device.

Due to size constraints on handheld devices, the Siebel Handheld Client displays user interface 
elements differently from the Siebel Web Client. Consider these differences when configuring the 
Siebel Handheld Client application. For example, Siebel Handheld Client does not support an 
alphabetical index.

Configuring List Applets for the Handheld Client
You configure list applets and list columns for Siebel Handheld applications the same way you 
configure them for other Siebel applications. 

Recommended Strategy for Configuring List Applets
The recommended strategy when configuring the Siebel Handheld Client is to use the list applets for 
record navigation and to rely on form applets to provide the record details.

The following are additional guidelines to follow when designing list applets:

■ Configure specific list applets for your Siebel Handheld application, rather than reusing Siebel 
Web Client list applets.

■ Remove all but the essential list columns. Because there is limited screen area to display list 
columns, omit all unnecessary columns to minimize horizontal scrolling. 

You may either remove the columns from the application or set the Show in List property on the 
column to FALSE. These two methods are different in the following ways. If the columns are 
removed from the application, these data won't be downloaded to the handheld device, which 
keeps the handheld data and a minimum and, in turn, optimizes synchronization performance. 
If the Show in List property on the column is set to FALSE, the data is still downloaded to the 
device but is not shown by default. This second approach, though without the synchronization 
optimization benefit, does allow convenience for the user who wants to customize visible 
columns. You should take these concerns into account when setting up users. 

■ Reorder the remaining list columns so that the most frequently used columns are furthest to the 
left.
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■ Reduce the default width of the list columns so that more columns can be viewed at one time.

■ Use hyperlinks to ease navigation by enabling users to drill into a form applet. 

These changes can minimize the amount of horizontal scrolling and column reordering that users 
must do. Limiting the number of list columns to those that are essential minimizes the amount of 
data downloaded to the device, resulting in faster synchronization times and more economical use 
of device memory.

NOTE: All required fields on form and list applets appear with an asterisk (*). If an administrator 
specifies that a field is required, the field appears with an asterisk in the user interface.

Use Siebel Tools to modify, or rearrange List Columns. For more information on the List Column 
options, see Configuring Siebel Business Applications.

Configuring Form Applets for the Handheld Client
The handheld uses a specialized algorithm to format and display form applets. Due to the display 
limitations on the device, only one pair of label and field controls are displayed on each row of the 
form, regardless of the layout shown within Siebel Tools.

Layout Sequence
When configuring for the handheld device, the Applet Web Template Items in the Applet Web 
Template determine the controls that appear on a form applet. The layout of form applets on the 
handheld device is determined by the HTML Sequence field set on control objects.

The HTML Sequence field determines the screen layout of a handheld device. Controls are ordered 
from top-to-bottom based on their HTML Sequence property values. Label and control pairs that do 
not fit on the same line as other label and control pairs wrap to the next line.

Labels
Keep field labels in applications short (approximately 12 characters or fewer, depending on the 
character width). Use abbreviations where possible. Labels that are too long are truncated.

Group Boxes
Group boxes are not supported and are not displayed in form applets, even if they are added in the 
Web Applet Designer. Therefore, reword the field labels to include group box information if necessary. 
For example, you may have two group boxes on the form, one labeled Ship To and another labeled 
Bill To. Each group box includes a field named Address. Because group boxes are not supported, the 
Ship To and Bill To labels are lost, and two fields with the identical Address label remain. Therefore, 
you must rename the Address labels “Ship To Addr” and “Bill To Addr” or some other label that 
distinguishes them.
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Using Auto Pop-Up Lists in the Handheld Client
Sometimes when a user encounters a new view, he or she must perform an action, such as filling in 
a required field by selecting a value from a pop-up list. Rather than requiring the end user to tap the 
control to open the pop-up list, you can configure the view so that the pop-up list automatically opens 
when the end user gets to that view. To configure a pop-up list to open automatically, add the user 
property on the applet with Name set to AutoPopupField. Depending on the type of applet, this 
property is set differently:

■ For list applets, set the AutoPopupField property to the Business Component field name.

■ For form applets, set the AutoPopupField property to the name of the control.

About Home Page Applets in Siebel Handheld
To configure a Home Page applet, create an applet that has controls of HTML Type Button only. Use 
the following guidelines in creating your Home Page applets:

■ Set the MethodInvoked property of these controls to GotoView. Then add a user property for the 
control, and set the Name parameter to “View” and set the Value parameter to the view name.

■ Set the Caption field.

■ Set the HTML Sequence field according to the order in which the buttons are laid out on the 
device. The buttons appear on the Home Page applet of the handheld device, laid out in rows of 
three buttons.

■ Set the class property of the Applet to CSSFrameCEHome.

About Buttons in Handheld
Set the HTML Type field on buttons to Button, MiniButton, PushButton, or MiniButtonEditNew. All of 
these HTML Types map to the same button control on the handheld device.

Buttons with text labels on them are sized to the minimum width required to fit the text on the 
buttons.

NOTE: You cannot use scripting to augment the button functionality in handheld applications.

You may add buttons as long as the method invoked is supported by the class or superclass of the 
frame or business component. You may also remove buttons from an applet. Be careful when 
removing buttons because you may alter the behavior of your application in unintended ways. Table 5 
describes the behavior of buttons on the different screens. Use this table to guide your decisions 
about removing buttons from your handheld applications.
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About the Menu Bar in Handheld
The menu object definition in the Siebel repository that is implemented in handheld applications is 
named SHCE Generic. The default menu bar configuration for the Siebel Handheld Client includes the 
following menus: File, Edit, View, and Help. You may remove or rename menus on the menu bar, but 
you cannot add new menus. You may reorder the menu items by changing the Position property for 
the menu items. Generally, use the default menu bar configuration for all of your Siebel Handheld 
Client applications. 

About Toolbars in Handheld
This section describes how to configure the toolbar for your application.

Table 6 shows the supported toolbar functions.

The default toolbar can be configured in Siebel Tools by configuring the SHCE Main toolbar object. 
SHCE Main is the main toolbar that is downloaded to the handheld device. If a toolbar named SHCE 
Main does not exist in your repository, a default toolbar, Main, is downloaded instead.

Table 5. Button Functionality 

Screen View Button Button Functionality

Accounts Views Measurem
ents

Goes to the Asset Measurements view.

Accounts Views Warranties Goes to the Asset Warranties view.

Accounts Views Componen
ts

Goes to the Asset Sub-Components view.

Browser Views Check 
Substitute

Checks for substitute parts for the current part. 
Navigates to the Part Browser Substitutes view.

Table 6. Supported Toolbar Functions

Toolbar Functions

Back, Forward

New Record

New Query, Execute Query

Next Record, Previous Record, First Record, Last Record

Minimize/Maximize

Delete Record
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The SHCE Main toolbar contains the default buttons for the device: Back, Forward, New Record, New 
Query, and Execute Query. Change the order of the buttons on the display by modifying the Position 
property of the toolbar items. Remove a toolbar button by deleting it or making it inactive.

You can add additional default buttons to the toolbar by creating toolbar items whose Command 
property matches the name of an active bitmap in the SHCE Command Icons bitmap category. Do 
not add bitmaps to the SHCE Command Icons bitmap category because only those commands, which 
are already provided, are supported on the device. No additional commands are supported. You can 
remove a bitmap or make a bitmap inactive if you do not want it to appear in the Customize Toolbar 
dialog box.

You can change the bitmap for a toolbar by reimporting the bitmap from the SHCE Command Icons 
bitmap category.

An end user can personalize the toolbar by selecting View > Toolbar.

For more information on toolbars, refer to Configuring Siebel Business Applications.

About the Status Bar in Handheld
The status bar is located above the toolbar. The status bar displays the status of an applet with focus, 
including the applet title and record item count (for example, Contacts: 1 of 13).

About Hyperlinks in Handheld
Configuring a drilldown, or clicking a hyperlink or dynamic hyperlink in the Siebel Handheld Client, 
is performed the same way as with other Siebel clients. For more information on configuring 
drilldowns, see Configuring Siebel Business Applications.

Scripting in the Siebel Handheld Client
The Siebel Handheld Client does not execute Siebel Visual Basic (VB) or Siebel eScript scripting.

The Siebel Handheld Client application runs Siebel VB or Siebel eScript scripts and specialized 
business component logic at synchronization time, rather than in real time on the handheld device. 
This has significant consequences in applets and controls, because scripts attached to applets and 
controls are ignored.

CAUTION: Be aware of the following additional issues with respect to scripts and validation: 

■ Deactivating scripts. Do not deactivate existing scripts in Siebel Tools to make the handheld 
device or the synchronization process accept data it is excluding. Errors may occur within the 
Siebel Web Client or elsewhere where these scripts are run.

■ Calls to user interface methods. When a business component script makes a call to a user 
interface method (such as MsgBox), the script cannot be executed, and the record update, 
deletion, or addition is rejected during synchronization. Strictly speaking, a script attached to a 
business component should not interact with the user interface.
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Any Siebel Visual Basic code should be restricted to the business component level. Applet-level Siebel 
Visual Basic will not execute and, therefore, should not be written for the Siebel Handheld Client 
application. As a substitute to using Siebel Visual Basic on the Siebel Handheld Client application, for 
real-time execution, use the following business component user properties:

■ BC/Field Read Only Field...for making fields or business components read-only dynamically.

■ Pickmap for fields on the picklist.

Do not use message boxes or prompts in the Siebel Visual Basic code used in conjunction with the 
Siebel Handheld Client application business components. If the business component is shared 
between the Siebel Handheld Client application and a laptop, use the following construct to 
determine if the code is being executed in real time on the laptop or during synchronization:

'ActiveViewName is only available when the script is called real time on the laptop

If (TheApplication.ActiveViewName<>"") then

MsgBox"....."

End If

■ Business component level scripting will be executed during synchronization. Error handling may 
need to be enhanced if the business component is shared between the handheld application and 
the laptop.

Compiling the Siebel Handheld 
Application
Compiling the repository for the Siebel Handheld Client is identical to compiling on the Siebel Web 
Client. For more information, see Using Siebel Tools. For deployment to production, always perform 
a full compilation. This assumes that you have organized all of your handheld object definitions in 
one project or a limited set of projects.

When you compile your application, a Siebel repository file (.srf) is created and put in the destination 
directory you specified during the compile procedure. Make this .srf file the source of repository 
information for the Siebel Handheld test client machine, defining all Siebel applications for that 
client, when you move it to your local \Siebel\objects directory.

It is strongly recommended that you make a backup of the existing .srf file in your local 
\Siebel\objects directory before overwriting it with the new one. That way, if you make an error or 
you want to revert to the original application, you have a backup that you can easily restore. 
Versioning for the repository is tracked, and if the .cfg, schema, or repository files have changed, 
the sync process will automatically rebuild the .rml and schema. For more information, see Using 
Siebel Tools.
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Installing and Setting Up End User 
Translation Functionality
End User Translation functionality provides you with the ability to translate the text strings within 
the Siebel Handheld application. The translation process should be undertaken during the 
development cycle and once completed your development team can then package the translated 
strings for distribution. 

The translation process requires the generation of a file of strings from the handheld binaries which 
are then translated and distributed to the user base. This file, userstr.txt, containing the translated 
strings is then used to override the strings within the existing handheld binaries. Therefore, you will 
be required to build a copy of userstr.txt into the installation media for your handheld application. 

The translation string file is version specific so you must repeat this process every time you upgrade 
your Siebel Handheld application.

Performing Setup for Initial String Translation
In order to perform the initial string translation you must perform the following steps prior to 
installation:

To setup Siebel Handheld application for initial string translation

1 In the Handheld installation directory, add the following two lines to the setup.ini file

[EndUserLocalization]

UserDefinedLang=Y

2 Install the Siebel Handheld application.

During application initialization and the subsequent startup, the file 'userstr.tmp' is generated 
within the ApplicationDataDirectory (by default this is \Program Files\Siebel Handheld). This file 
is generated upon startup whenever the UserDefinedFlag is set to Y within the handheld registry 
and an existing userstr.txt cannot be found.

3 Copy the generated file over to the computer where you will be performing the string translation.
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4 Translate the strings as required and remove any untranslated strings from the file.

For example, given the following section of exported strings:

33872|HTML\

33873|Tab delimited text file\

33874|Export\

33875|Format:\

33876|Only Active applet\

33877|All applets in view\

33878|Output file name\

33879|Browse…\

33880|And paste output to clipboard\

33881|And open file\

Translate the required strings and remove any untranslated strings as follows:

33873|Archivo delimitado por tabulaciones\

33874|Exportar\

33875|Formato:\

33876|Sólo el applet activo\

33877|Todos los applets de la vista\

33878|Nombre del &archivo de salida:\

33880|Y pegar salida en el &portapapeles\

33881|Y &abrir el archive

NOTE: Strings 33872 and 33879 were removed from the userstr.txt as they were not required to be 
translated.

5 Save the file as userstr.txt in a UNICODE file format and then copy back into the 
ApplicationDataDirectory on the handheld device.

6 After restarting the Siebel Handheld application, the translated strings are read from userstr.txt 
in place of the strings included in the handheld binaries.

Distributing Translated Strings
Once you have generated and tested the userstr.txt file of translated strings, you should include this 
file in the installation media for the Siebel Handheld application.
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To distribute translated strings
Create a new language sub-directory named UserDefinedLanguage within the Siebel Handheld 
installation directory from which end user devices are installed and which contains the setup.exe. 

This directory with the name UserDefinedLanguage will exist alongside the language sub-directories 
shipped with the application. The new userstr.txt file should be placed in this subdirectory. 

Upon installation of the Siebel Handheld application, the custom file will be placed in the 
ApplicationDataDirectory of the destination device along with the usual handheld files.

Configuring Printing from the Siebel 
Handheld Application
Users may print from any view in the application. However, they are not necessarily printing what 
they see on their screen. They may print a portion of the data they view or data that is not viewable 
at the time. 

A print template defines the document that is to be printed. After the template has been defined, it 
must be associated with an applet in a view.

This section provides information on the following topics:

■ Defining documents

■ Designing print applets

■ Configuring applets for printing

■ Creating print buttons

■ Creating print templates

Defining Documents for Handheld
Defining documents for printing includes several steps:

■ Determine the documents your users need to print.

■ Determine the views from which they are most likely to print the documents.

■ Lay out the document for printing.

Determining which documents users will need and the views from which they are most likely to print 
requires that you have a good understanding of the users’ day-to-day work.

Whether the existing applets in a view include most of the required data or only a small portion is a 
secondary consideration. It is not likely that a printout of the existing applets, which are formatted 
for an electronic PDA interface, will provide an acceptable or usable printed document. In most 
instances, you need to create additional applets that are specifically used for printing data.

The printed document will be composed of several applets which are added to the view. The applets 
pull the data from the underlying business components. These applets, in turn, direct the data to the 
print templates discussed in Appendix E, “Print Tagging Language.”
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Designing Print Applets for Handheld
The print template references applets associated with the view and is how you specify what data 
appears in the printed document. For information on print templates, see “Creating Print Templates 
for the Handheld Application” on page 36. As you design your applets, you should be aware of the print 
specifications of the printers used in the field. Portable printers typically print on two-inch or 
four-inch wide paper. You need to design your applets so that the data fits within the limits of the 
paper width. Keep your documents simple so that they work with different sizes of paper. The 
following are some guidelines to use when designing your applets to accommodate the smaller paper 
sizes.

Form Applets 
Data from only one business component can be displayed on each line in your document. When you 
design your form applets, keep in mind that you can display a maximum of two columns of data in 
form applets. You can specify that each column of data is preceded by an optional caption column. 
This means you can have up to four columns displayed in your document—two data columns and two 
caption columns. Alternatively, you may have no captions, and simply display one or two columns of 
data.

The ratio between caption and data columns is, respectively, 35 percent and 65 percent. This is a 
fixed relationship that cannot be customized in the template.

Limitations on multiple columns in printed output are largely hardware dependent. In printing 7 fields 
on a 40 column printer, physical limitations allow only 4-5 characters per field (40 - (7-1))/7 = 4.85. 
To print more than 4 columns, an 80 column printer is recommended. Generally, the capabilities of 
impact printers are lower than those of Thermal printers. 

List Applets 
When specifying the width of a column, you can either specify it with a unit of measurement or as a 
percentage of the total page width. For example, you can specify that the first column is 20 mm, and 
the second column is 40 mm. If the width of the paper you print to is narrower than 60 mm, the 
column widths automatically adjust to fit the printable width as a proportion of the specified width. 
Therefore, the first column will always be 33 percent, and the second column will be 67 percent of 
the paper width. The minimum width for a column is 8 mm, which includes a 3 mm gutter margin 
between columns.

You can specify any number of columns in your list applet. However, if the width of the column is less 
than 8 mm, the application ignores the column and does not print it.

On narrow paper widths, data from a field may not all fit on one line. Data that does not fit can be 
specified, in the Applet tag, to wrap to the next line and keep wrapping until the data in that field is 
completely displayed. The printable width of the page is equal to the paper width minus the left and 
right margins (PaperWidth – [LeftMargin + RightMargin]). These parameters are set in the setup.ini 
file. For more information on setting these parameters, see Appendix F, “Print Configuration Settings.”
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Configuring Applets for Printing for the Handheld 
Application
Configure print applets as you would any other applet using Siebel Tools. In addition, set the 
following properties for each applet in the view.

■ Set the HTML Popup Dimension value to 0x0. 

The 0x0 setting hides the applet from the end user who should not see the applet that is used to 
generate the document. Exposing these applets would complicate a product that is tightly 
configured for an effective and efficient workflow on a small mobile device.

NOTE: For compatibility with previous versions, Siebel Systems continues to support the name, 
Popup Dimension, for this property. However, it is recommended that you use HTML Popup 
Dimension.

■ Set the name of the Mail Template to be the name of the print template file. For more information 
on the print template file, see “Creating Print Templates for the Handheld Application” on page 36. 
For more information on the Mail Template property, see “Views with Associated Print Templates 
or Reports” on page 24.

Configuring Print Buttons for the Handheld Application
While users can use the File > Print menu option to print a document, it is helpful to include a Print 
button on the applet to give users a visual reminder that it is possible to print from a particular view.

When you design your applets, keep the following in mind when deciding where to place the print 
button:

■ Add the print button to the applet that is visible to the user. Do not add the print button to the 
print applet, which the user never sees.

■ Consider what the desired behavior is when determining the placement of a print button. 

For example, in a parent-child view, you may want to add the print button to the parent applet 
to ensure that the print button is always enabled. This is not necessarily true if the print button 
is placed on the child list applet. If there are no items in the list applet, the print button is 
disabled, and the end user cannot print from that view. If you only want the end user to print 
when there are list items, then placing the button on the child list applet is appropriate.

To configure a print button

1 From Siebel Tools, add a control to the print applet and specify HTML Type = Button.

2 Set Method Invoked = Print.

3 Set the Display Name property of the button. Generally, this is set to Print.
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Creating Print Templates for the Handheld Application
Once you have identified and created the necessary views, you are ready to create print templates. 
A print template is a text file that includes instructions for printing a document. It specifies the data 
to be printed, document layout options, and text formatting. These instructions are specified using 
a print tagging language that is described in Appendix E, “Print Tagging Language.”

Configuring Signature Capture 
Capabilities in Siebel Handheld
You can configure the Siebel Handheld Application to capture, view, and print signatures. The 
following sections provide details on configuring signature capture:

■ “Enabling Signature Capture” on page 36

■ “Invoking Signature Capture Dialogue Box and Display” on page 37 

■ “Signature Capture Dialogue Box and Signature Display” on page 37

■ “Configuring Signature Capture in Activities More Info View in Siebel Handheld” on page 38

■ “Adding a Signature Capture Button in Siebel Tools” on page 40

■ “Signature Capture Applet Control User Properties” on page 41

NOTE: This feature allows customers to develop their custom signature capture capability on 
Siebel Handheld. It can not be used to edit or change the Pharma Handheld signature capture 
preconfigured functionality, which allows you to capture signatures for samples disbursed. For 
more information on configuring Pharma Handheld signature capture for samples disbursed, 
please refer to “User Properties for Signature Capture Verification” on page 74.

Enabling Signature Capture
Enabling signature capture requires implementing the required supporting field and column 
definitions, adding a signature control to the applet and, if required, configuring an applet button 
through which the signature capture dialogue box can be invoked. A field can be configured as a 
signature control in any list or form applet. Multiple signature controls can be added to a single 
applet. Once captured, signatures are converted to an ASCII encoding data and stored with the 
Siebel database as ASCII text.

When enabling Signature Capture, the following basic configuration is required: 

■ The Business Component field mapped to the signature control should be of Type DTYPE_NOTE

■ The underlying Table Column on which the Business Component field is based on Physical Type 
LONG
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■ The Applet Control should have a Control User Property called "Signature" with a value "Y". The 
Control's HTML Type property should be set to "Field"

NOTE: The Applet Control by default does not redisplay the signature data if there is data in the 
underlying business component field. In this case, you will see the field as read only and will not be 
able to see the signature that was captured. To redisplay signatures, add another Control User 
Property called "Show Data" with a value "Y". With this additional configuration, the control is still 
read-only, but you will be able to see the signature that was captured. For a full list of User Properties 
available for configuring signature capture, see “Signature Capture Applet Control User Properties” on 
page 41.

Invoking Signature Capture Dialogue Box and Display
There are two ways to invoke the Signature Capture dialogue box or Signature Display. By default, 
the basic configuration specified in the Enabling Signature Capture section allows you to invoke the 
signature capture dialogue box or display a signature using the (...) ellipses button.

You may also use the following basic configuration to invoke the Signature Capture dialogue box or 
display with the Applet Signature button.

■ Create a new Control with properties HTML Type =  MiniButton, Method Invoked = StartSignature

■ Add a Control User Property to the MiniButton control to indicate the signature field in the 
business component (for example, the field that is being used to store signature in the business 
component on which the applet is based).

For examples, see “Configuring Signature Capture in Activities More Info View in Siebel Handheld” on 
page 38 and “Adding a Signature Capture Button in Siebel Tools” on page 40.

Signature Capture Dialogue Box and Signature Display
The Signature Capture dialogue or display box consists of three controls in the client area: header, 
signature, and footer. A toolbar displays various buttons depending on the existence of signature 
data. 
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Initially, when signature data does not exist or has not yet been captured, the user sees a single line 
of text within the field control that reads Not Signed. Once the signature capture dialogue box or 
signature display is invoked, this message appears at the bottom of the screen. The Clear and Cancel 
buttons are also enabled, while the Accept button is disabled. Once the Signature area within the 
dialogue box is populated, the Accept button is automatically enabled. Table 7 describes the 
functionality around these three buttons.

Once the signature is committed (for example, signature captured and accepted in the database), 
the user sees a single line of text "x Signed x" within the applet field control. 

The Header and Footer is a line or unlimited number of lines of text in one or more paragraphs. The 
specific Header or Footer values that appear as well as how they appear in the dialogue box is 
controlled by a set of user properties. See “Signature Capture Applet Control User Properties” on 
page 41. 

Configuring Signature Capture in Activities More Info 
View in Siebel Handheld
The following example provides detailed steps to configure signature capture in Activities More Info 
View in SIA Sales Handheld. The Activities More Info View has one applet 'SIS HH Activity Entry 
Applet - CE', which is based on the Action Business Component, which in turn is based on S_EVT_ACT 
Table. The following example shows how to configure a field within the Action Business Component 
called Signature, which is based on a new column created from S_EVT_ACT_X Table. To enable basic 
signature capture (for example, no header or footer), follow these steps:

1 In Siebel Tools, add an extension column to the table S_EVT_ACT_X. 

Table 7. Signature Capture Dialogue Box Buttons

Button Description

Accept Tap this button to commit the signature to the 
database.

Clear Tap this button to reset and clear the signature 
field.

Cancel Tap this button to discard the signature and 
close the display.

For this Field Add This Value

Name SIGNATURE

User Name Signature

Type Extension

Nullable TRUE

Physical Type Long
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2 Add a field to Action business component with the following values:

3 Add control to applet. For this example, you will add the control to the 'SIS HH Activity Entry 
Applet - CE'.

Length 0

Cascade Clear Ignore

Transaction Log Code TRUE

Status Active

Sequence 999

Comments Extension Column for Activity Signature Capture

For this Field Add This Value

Name Signature

Join X_EVT_ACT_X

Column SIGNATURE

Text Length 16,383

Type DTYPE_NOTE

Use Default Sensitivity TRUE

Comments Custom Field added for Signature Capture

For this Field Add This Value

Name Signature

Caption Signature

Caption String Reference SBL_SIGNATURE-1005113048-35Y

Field Signature

HTML Display Mode EncodeData

HTML Row Sensitivity TRUE

HTML Type Field

Runtime TRUE

Text Alignment Left

Visible TRUE

Comments Custom control added to display 
and invoke Signature Capture.

For this Field Add This Value
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4 Add two Control User Properties to the new 'Signature' control with the following values:

5 Add the new control to the Edit Web Template for 'SIS HH Activity Entry Applet - CE'.

You can now invoke the signature capture dialogue box by tapping on the ellipsis (...) on the 
signature field on the applet. 

Adding a Signature Capture Button in Siebel Tools
Optionally, you can also configure the signature capture dialogue box by placing a button on the 
applet. The following configuration steps provide details on doing this.

To create a new minibutton control

1 Create a new MiniButton control against the 'SIS HH Activity Entry Applet - CE'.

2 Add a Control User Property to the MiniButton control to indicate the Signature field in the 
business component:

■ Name = SignatureField

■ Value = Signature

User Property Name Value

Signature Y

Show Data Y

For this Field Add This Value

Name SignatureCapture

Caption Sign

Caption String Reference SBL_SIGN-1005113047-35W

HTML Type MiniButton

MethodInvoked StartSignature

Comments Custom MiniButton to Invoke 
Signature Capture.
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Signature Capture Applet Control User Properties
The user properties, shown in Table 8, are optional and provide you with the ability to modify the 
style and layout of the Signature Capture applet.

Table 8. Style and Layout Modification Properties

User Property
Description

Sample 
Value

Signature If Y the field becomes a signature field Y

ShowData If Y, the signature data can be redisplayed. Setting this User 
Property to 'N' disables the ellipses in the signature applet 
control, when there is signature data already existing

Y or N

EncryptKey Encrypt key string. If this is not specified, an internal 
mechanism is used to generate the encryption key.

1 and 
99999999

WritingGuide Defines appearance of writing guide in signature control. Y or N

BorderStyle Defined the border style of the signature control. Double

InkColor Defines the ink color. Uses a Hex format (OxBBGGRR) of blue, 
green, red.

OxFF0000 
(Blue)

InkWidth Defines ink width 2 (Pen width)
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The user properties shown in Table 9 are added to support header and footer display and the save 
function.

Table 9. Header and Footer Display Properties

User Property Description Sample Value

SignatureDataField This property is used to specify a destination field 
for the captured signature in scenarios where it 
differs from the current UI field. When specified, it 
specifies the name of the business component field 
that the signature data is fetched from and saved 
to.

SigDataField

SignatureHeaderField Specifies the name of the BC field from which the 
header value is fetched.

SigHeader

SignatureFooterField Specifies the name of the BC field from which the 
footer value is fetched.

SigFooter

SignatureHeaderSaveField Specifies the name of the BC field to which the 
header value is saved.

SigHeaderSave

SignatureFooterSaveField Specifies the name of the BC field to which the 
footer value is saved.

SigFooterSave

MaximumHeaderLines Specifies the maximum height of the header 
display control in number of text lines. If the 
header text exceeds this number, the user needs to 
scroll down the control to view the rest of the 
header text. (Default = 4).

4

MaximumFooterLines Specifies the maximum height of the footer display 
control in number of text lines. If the header text 
exceeds this number, the user needs to scroll down 
the control to view the rest of the header text. 
(Default = 4).

4

SignatureHeight Specifies the height of the signature capture 
control by pixels (default = 80, max = 200).

Integer between 1 
and 200.

SignatureDate If set to Y, the current date is appended below the 
last line of the footer. The date string is saved to 
footer save field.

Y

SignatureTime If set to Y, the current time is appended below the 
last line of the footer to the right of date if date is 
specified. The time string is saved to footer save 
field.

Y

ConfirmAccept If set to Y, a confirmation message is displayed 
after accept button is pressed. Otherwise, no 
confirmation message is displayed.

Y
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NOTE: If the content of the Header or Footer exceeds the MaximumHeaderLines or 
MaximumFooterLines, respectively, then the content can be scrolled vertically using the pen. No 
scrollbar will be generated.

Testing the Siebel Handheld Application
Before deploying your application to your end users, be sure to thoroughly test the application by 
synchronizing to a handheld device. The handheld configuration is downloaded to the device where 
you can test the functionality and verify that you have the desired behavior. Another equally 
important aspect of handheld testing is to check to see how much data is downloaded to the device. 
If too many records are downloaded, this increases the length of time it takes to synchronize the 
handheld device and slows down the application performance. Check the server log file to see how 
many records are downloaded for each business component. You must turn on logging to capture 
this information in the log file. 

For more information on enabling logging for Direct Server Sync, see “Configuring Direct Server Sync 
Logging Levels” on page 98. 

For more information on enabling logging for Companion Sync, see “Configuring Companion Sync 
Logging Levels” on page 99.
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4 Application Administration
This chapter includes the following topics:

■ “Overview of Siebel Handheld Administration Screens” on page 46

■ “Setting Up Users in Siebel Handheld” on page 47

■ “Assigning User Responsibilities to Siebel Handheld Users” on page 47

■ “Creating Siebel Handheld Views” on page 47

■ “Setting Business Component Filters for Siebel Handheld Users” on page 49

■ “Setting Business Object Filters for Siebel Handheld Users” on page 50

■ “Configuring Application Settings for Siebel Handheld” on page 53

■ “Configuring Component Level Settings for Siebel Handheld” on page 58

■ “Administering Barcode Settings for Siebel Handheld” on page 58

■ “About Monitoring Synchronization Sessions for Siebel Handheld” on page 66

■ “Monitoring Synchronization Sessions for Siebel Handheld” on page 67

■ “Obtaining Error Details from Siebel Handheld Synchronization Sessions” on page 67

■ “Obtaining Business Component Information from Siebel Handheld Synchronization Conflicts” on 
page 68

■ “Obtaining an Audit Trail for Siebel Handheld Synchronization Sessions” on page 68

■ “Acting Upon Synchronization Errors in Siebel Handheld” on page 69

■ “Process for Administering Siebel Pharma Handheld” on page 69

■ “Managing Samples Records in Pharma Handheld” on page 70

■ “Administering Disclaimer Text in Siebel Pharma Handheld” on page 71

■ “Configuring Distributor Names in Siebel Pharma Handheld” on page 71

■ “Performing a Signature Audit in Siebel Pharma Handheld” on page 72

■ “Verifying Signature Capture in Siebel Pharma Handheld” on page 73

■ “Configuring User Properties for Closing Inventory Periods in Siebel Pharma Handheld” on page 75

■ “Configuring User Properties for Signature Capture Verification in Siebel Pharma Handheld” on 
page 76

■ “Validation Logic of the Sign and Submit Buttons in Siebel Pharma Handheld” on page 77

■ “Validating the DEA Number in Siebel Pharma Handheld” on page 84

■ “Preparing Receipts for Calls in Siebel Pharma Handheld” on page 85
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Overview of Siebel Handheld 
Administration Screens
This chapter is designed to show you how to administer Siebel Handheld. Key tasks are outlined that 
you can perform using the Administration - Mobile screen. Your organization may follow a different 
task sequence according to its business requirements.

Following are the views used for administering Siebel Handheld applications. You can access the 
Administration - Mobile screen through either the Siebel Web Client or Siebel Mobile Web Client.

■ Session Administration: This view contains a detailed information about user synchronization 
sessions. Use this view to monitor and investigate handheld user synchronization activities. 

■ Server Component Administration: This view allows you to manage server-level settings for 
synchronization components. These settings are used by the synchronization engine to extract 
application definition and user data. These settings will override the application-level settings.

■ Application Administration: This view lists all the handheld applications available within your 
enterprise. From this view you can create new application settings and administer settings that 
have already been created. The contents of the following views are used by the synchronization 
engine to extract application definition and user data.

■ Business Component Filters: Use this view tab to change synchronization filter settings 
for business components. If you wish to restrict the contents of selected business 
components to reduce the data set otherwise visible to your users, you can change filter 
settings in this view.

■ Business Object Filters: Use this view tab to define business object level filters, which 
restrict data that is downloaded to the handheld client upon synchronization.

■ Settings: Use this view tab to define parameter settings for your application. 

■ Conflict Administration: This view allows you access selected transaction errors.

■ Audit Trail: Use this view tab to obtain information about action taken on a particular data 
conflict. Audit Trail must first be enabled for the conflict data. The business components are 
Handheld Transaction Error and Handheld Txn Error Message.

■ Business Components: Use this view tab to see business component information 
associated with a particular data conflict. 

■ Error Details: Use this view tab to get detailed information about specific data conflicts. You 
are also able to take particular action on any given conflict. 

■ Barcode Administration: This view allows you to create new barcode definitions for your 
handheld applications.

■ User Administration: This view allows you to manage user-specific settings, such as business 
object and business components filters, that filter the data that display to the user. The data sets 
contained in these user views are used by the synchronization engine to extract application 
definitions and user data. The Siebel Handheld application is populated by these data when the 
user performs synchronization. These settings override the server component-level and 
application-level settings.
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■ User Business Components: Under this view tab, you can set user-specific sync filter 
directives for business components. These settings override application-level settings.

■ User Business Objects: Under this view tab, you can set user-specific filters for business 
objects. In this setting, you limit the data set that is downloaded, at the time of sync, to the 
Handheld client. These settings override application-level settings.

■ User Settings: Under this view tab, you can control user-specific settings which override 
server component-level and application-level settings. 

■ Barcode Enabling: In this view you can enable barcode scanning for chosen views in the Siebel 
Handheld application. For more information on enabling barcode in your handheld application, 
see Siebel Sales Handheld Guide. 

Setting Up Users in Siebel Handheld 
To set up users on a Siebel Handheld application, perform the following tasks: 

■ “Assigning User Responsibilities to Siebel Handheld Users” on page 47

■ “Creating Siebel Handheld Views” on page 47

■ “Setting Business Component Filters for Siebel Handheld Users” on page 49

■ “Setting Business Object Filters for Siebel Handheld Users” on page 50

Assigning User Responsibilities to Siebel Handheld 
Users
You must create user accounts and assign responsibilities and passwords for each handheld user. The 
steps are the same as those for creating user accounts, assigning responsibilities and passwords for 
the Siebel Web Client. See Applications Administration Guide for more information on this topic.

Creating Siebel Handheld Views
The handheld synchronization engine extracts views based on configuration (SRF) and the 
responsibility set up in the Application Administration view.

To configure a new view in your handheld application, follow the list below. Knowledge of Siebel Tools 
is required to perform these tasks.

1 Create the new view in Siebel Tools. For information on creating views, see Configuring Siebel 
Business Applications.

2 Add that view to the handheld screen. For more information on adding views to screens, see 
Configuring Siebel Business Applications. 

3 Add the screen to the handheld application if required. For more information on adding screens 
to applications, see Configuring Siebel Business Applications.

4 Compile the project. For information on compiling projects, see Using Siebel Tools.
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5 Add the new view to the Siebel Handheld user’s responsibility. See “To add a handheld view to a 
user’s responsibility” on page 48.

To add a handheld view to a user’s responsibility

1 Launch the Web Client application that uses the same database that the Siebel Handheld 
application synchronizes with.

2 Choose Navigate > Site Map > Application Administration> Views.

3 Add the new views.

4 In the Responsibilities view, associate each view with the appropriate handheld responsibility.

5 Add appropriate users to the responsibility.

NOTE: For more detailed instructions on adding views and associating views with 
responsibilities, see Applications Administration Guide.

Specifying Views for the Handheld Application
The Siebel Handheld application uses a small subset of views used in the Siebel enterprise 
application. Because there are memory resource constraints on handheld devices, it is recommended 
that you compile an SRF to extract only those views that are used on the device. 

The combination of the SRF and the user's responsibility determines which views are extracted. The 
handheld device only extracts views whose parent screen is included in the handheld application and 
are part of the user's responsibility.

About Business Component Filters
Business component filters are used in some cases to restrict the size of extractions that otherwise 
might be excessive. They suppress the extraction of business component records. Business 
component filters should be employed with discretion because excessive filtering can cause server 
data integrity problems.

Business component filters can be specified at either the Application level or the User level, but not 
at the Component level. They should not be specified at the user level outside of your test 
environment, and once tested should be migrated to the Application level. 

If you are configuring for handheld synchronization, a suggested practice, is to start with no business 
component filters at all. Attempt a sync and even if the sync fails due to excessive data extraction 
volumes, view the extraction results to determine the business components for which the data 
extraction was excessive. If any business component extraction is found to be excessive, you can 
reduce the extraction by adjusting the existing search specs specified in Siebel Tools (applets and 
business components), or Handheld Settings (for example, in DefaultBusObj), and selection filters 
(business object filters). If nothing else works, a business component filter can be used to force a 
reduction in the result set for a particular business component.
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Setting Business Component Filters for Siebel Handheld 
Users
The Business Components view in the Application Administration screen contains the sync filter 
settings for business components. If you wish to add or remove business component filter settings 
for users, you do so in this view. 

To add a business component filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration. 

2 In the Application Administration screen, select the appropriate application, then click the 
Business Component view tab.

3 Click New, then enter the required information. 

Some fields in the Business Component view are described in the following table: 

To remove a business component filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration. 

2 In the Application Administration screen, select the appropriate application, then click the 
Business Component Filters view tab.

3 Select the filter setting record wish to remove. 

4 From the Business Component Filters menu, choose Delete Record. 

Field Comments

Owner Read only. Contains the Siebel Handheld application to which 
the business component will be associated. For example, 
Siebel <Application name> for CE.

Business Component A text box. Enter the business component name. 

Name A text box. Enter the business component filter name. For 
example, Filter 1.

Query A text box. Enter the syntax for the query. For example, 
[Start Date] <=Today()

For more information on developing queries, see “Data 
Filtering.”
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About Business Object Filters
The Siebel Web client supports named queries on most or all screens. These queries restrict the 
result set displayed to the user. Business object filters are the Handheld Sync equivalent to these 
named queries. Just like client based queries, they are applied to a specified business object. They 
also contain search or sort specifications for business components that are part of that business 
object. 

The Default column is the only difference from the query syntax appearing in a PDQ filter for the 
Siebel Web client. The Default column is unique to the business object filter mechanism. For Web 
Client queries, users can set a default query for each view in their Preferences screen. If users do 
not do this, there is no default query, so all records are returned by default. This is not recommended 
for handheld deployments as this would result in excessive data extraction volumes. Thus, the 
Default column allows you to decide what filter should be used by default if a user does not make a 
selection. There is also a client option to revert to default filters selection. There should be at most 
a single default filter for each business object name. It is not recommended that you set more than 
one filter as the default for a particular business object. Note however, that the same default choice 
will be made by all clients.

Business object filters can be specified at either the Application level or the User level, but not at the 
Component level. Business object filters specified at the User level will override a filter specified at 
the application level provided the application-level filter has the identical values for the business 
object name and filter name. The list of filter choices presented to the user is the merged list of all 
application filters except those overridden at the user level, plus all user filters. 

Setting Business Object Filters for Siebel Handheld 
Users
The Business Object Filters View in the Application Administration screen contains the sync filter 
settings for business objects. If you wish to add or remove business object filter settings for users, 
you do so in this view.

To add a business object filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile. 

2 In the Application Administration screen, select the appropriate application, and then click the 
Business Object Filters view tab.

3 Click New, and then enter the required information. 
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4 The fields in the Business Object Filters view are described in the following table: 

To remove a business object filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration. 

2 In the Application Administration screen, select the appropriate application, and then click the 
Business Object Filters view tab.

3 Select the filter setting record wish to remove. 

4 From the Business Object Filters menu, choose Delete Record. 

About Thread Throttling
When a large number of users attempt to synchronize simultaneously, the load on a single server 
can become excessive. Thread throttling significantly reduces the total number of simultaneously 
active transaction processor threads and database extraction threads, thereby increasing the overall 
throughput for synchronization, without reducing the number of concurrent users. Synchronization 
performance degrades slightly but will successfully complete for all users.

Field Comments

Owner Read only. Contains the Siebel Handheld application to which 
the business component will be associated. For example, 
Siebel <Application Name> for CE.

Default Check to allow you to decide what filter will be used by 
default if a user does not make a selection. 

Business Object A text box. Enter the business object name. For example, 
Account.

Name A text box. Enter the business object filter name. For 
example, BOFilter 1.

Query A text box. Enter the syntax for the query. For example, 
'Account'.Search = "[Account Status] = LookupValue ( 
""ACCOUNT_STATUS"", ""Active"" )" 'Account'.Sort = 
"Name, Location".

For more information on developing queries, see “Data 
Filtering.”
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Thread throttling allows the maximum possible number of concurrent users. It throttles in a manner 
that maximizes application server usage during any mixture of transaction processor and database 
extraction threads. Thus, if the server supports x concurrent transaction processing threads, it will 
allow this number of transaction processing threads while disallowing all database extraction 
threads. Similarly, if the server supports y concurrent database extraction threads, it will allow this 
number of database extraction threads while disallowing all transaction processing threads. If fewer 
than x transaction processing threads are currently active, some database extraction threads are 
allowed to execute concurrently. Similarly, if fewer than y database extraction threads are currently 
active, some transaction processing threads are allowed to execute concurrently. 

For information on thread throttling settings, see “Configuring Application Settings for Siebel 
Handheld” on page 53.

To enable thread throttling, see “To add a new application setting” on page 57.

About Settings in the Handheld 
Administration Screens
Settings can appear at three levels: Application, Component, or User. Certain settings are only 
allowed at specific levels.

There are also two types of settings: single-line and multi-line settings. For a single-line setting, only 
one row may contain a unique setting name at a given level. Thus, a single-line setting at the User 
level may only be used once at that level. For single-line settings, the Sequence column should 
always contain a value of zero. For multi-line settings, the sequence column is necessary to allow 
multiple rows. The sequence column has no effect on actual processing, but is part of the logical key 
in the database table. When you create a new record in this database table, the record must have a 
unique logical key.  For single-line settings, you may leave the sequence column value alone, which 
will result in a default value of zero being assigned.  For multi-line settings, each line must include 
a different sequence number to avoid logical key conflicts.  If the combination of setting name and 
sequence number is not unique for a particular parent record (Application, Component, or User), you 
will receive an error message when stepping off or saving the record. Multi-line entries must contain 
correct the key values before they can be saved to the database.

The rules for override are that any setting, whether single line or multi-line, specified at the lower 
levels overrides that same setting name at higher levels. Thus the settings at the application level 
apply unless specific settings are overridden for a particular component or a particular user. When 
an override occurs, it occurs for the complete setting name. Thus, if a particular multi-line setting 
has three rows at the user level and twelve rows at the application level, the resulting multi-line 
setting value for that setting will contain only the three rows at the user level. There is also an 
override mechanism to allow a setting to be removed, rather than replaced. To remove a setting from 
a higher level, specify the setting name to be removed, with an empty setting value.
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Configuring Application Settings for 
Siebel Handheld
The Administration-Mobile screen contains a Settings list that allows you to change default settings. 
Some of the settings are described in Table 10.

The Handheld setting value field has a limit of 2000 characters. To create a default business object 
(DefaultBusObj) setting value with more than 2000 characters, use the following general approach:

Break the value into multiple lines of DefaultBusObj settings. These settings should all be entered 
using the same DefaultBusObj value format: 

■ BusObj|Visibility|Query|BusComp_1|query specifications_1[|BusComp_n|query 
specifications_n]

When defining multiple lines of DefaultBusObj settings for a single business object, all view modes 
and filters should match. If a business component is found in multiple DefaultBusObj settings for a 
single business object, then the business component’s query specifications will be concatenated with 
a space and appended into the previous business component’s query specifications. You should be 
aware of this in order to decide if both query specifications should be combined with an OR or AND 
operative. 

The DefaultBCuserProps and DefaultFields settings for a single business component can also be 
broken into multiple lines of settings if their values exceed 2000 characters. These settings should 
all be entered using the same value format as well:

■ BusComp|BCUserProp_1[|BCUserProp_n] or BusComp|Field_1[|Field_n]

Table 10. Application Settings

Setting Name Definition Valid Values

AllowRememberPassword Single-line setting. Specifies whether the 
Remember Password check box will be 
displayed on the Handheld Client 
Synchronization screen.

TRUE or FALSE

ApplicationDirectory Single-line setting. Specifies the working 
directory (UNC path) of the Siebel 
Handheld synchronization component 
where user data are stored.

\\server 
name\directory 
name
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DBExtractThreadLoad Single-line setting. Enables Thread 
Throttling functionality for database 
extract threads. It is the load (or weight) 
that will be assigned to each individual 
Database Extractor thread. For each 
running database extracting thread, this 
load value will be used to determine the 
total system load, which is then 
compared against the 
MaxTotalThreadLoads value. A new 
thread will only be started if the total 
system load does not exceed the 
MaxTotalThreadLoads value. A value of 
zero disables throttling of Database 
Extractor threads.

integer >= 0; 
default is 2

DefaultBCUserProps Multi-line setting. Reduces the number of 
User Properties that are extracted to the 
device metadata, thus decreasing the 
number of fields for a business 
component that need to be extracted. 
These reductions lower the metadata 
extract size and optimize client 
performance by removing irrelevant user 
properties from the handheld 
configuration. If this directive is not 
specified for a business component, then 
all user properties will be extracted. 

DefaultBusObj Multi-line setting. Used to force the 
extraction of a business object and its 
designated business components. This is 
typically used when a business 
component is not extracted because it is 
not specified via the “DefaultView” 
directive and is required for the 
application to function correctly. Another 
use of this directive is to designate 
business components that function as 
RBOs (reverse business objects). 

Business Object 
Name|Visibility 
Level||Business 
Component 
Name|QBE query 
construct

For more on QBE 
(query by example) 
structure, see 
“Constructing 
Business Component 
and Business Object 
Filters” on page 88.

Table 10. Application Settings

Setting Name Definition Valid Values
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DefaultFields Multi-line setting. Used to force the 
extraction of fields for a particular 
business component. This is typically the 
case where the business component is 
extracted via the “DefaultView” directive 
but because the field is not visible on the 
applet, it is not extracted. Also when a 
hidden business component is extracted 
via the “DefaultBusObj” directive, it is 
necessary to specify all of the fields that 
need to be extracted for the business 
component. If no fields are specified via 
this directive, then the business 
component will not be extracted for this 
case. 

Business 
Component 
Name|Field1|Field2
|…

DefaultHandheldInsertMode Single-line setting. Enables insert failure 
processing for synchronization. If 
enabled, synchronization will stop upon 
encountering a data conflict during an 
insert operation. End users or 
administrators must resolve the data 
conflict before synchronization can 
resume. This feature is disabled by 
default.

NoFail or 
FailOnError

DefaultHandheldSyncPickMode Single-line setting. Enables Extended 
Pick processing for synchronization. If 
enabled, synchronization will stop upon 
encountering a data conflict during a pick 
operation. End users or administrators 
must resolve the data conflict before 
synchronization can resume. This feature 
is disabled by default.

NoFail or 
FailOnError

EnableBatchExtraction Single-line setting. Enables or disables 
Batch Sync functionality. 

TRUE or FALSE

EnableThrottleDebugMode Single-line setting. This parameter 
enables or disables Thread Throttling 
functionality. 

TRUE or FALSE

MaxThrottleWaitTime Single-line setting. For Thread Throttling 
functionality. This is the upper limit on 
the amount of time (in minutes) any 
individual throttling request will be 
allowed to wait.

integer >= 0; 
default is 5

Table 10. Application Settings

Setting Name Definition Valid Values
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MaxTotalThreadLoads Single-line setting. For Thread Throttling 
functionality. It defines the maximum 
number of total thread loads (determined 
by DBExtractThreadLoad and 
TranProcThreadLoad for each type of 
thread) that will be allowed to run across 
the scope defined by 
ThreadThrottleScope. If a throttling 
request is made that causes this 
maximum to be exceeded, the requesting 
thread is delayed. The default value is 
zero, which completely disables the 
throttling mechanism.

integer >= 0; 
default is 0

NoDatabaseBusComp Multi-line setting. Defines a business 
component that must be omitted from 
the device database and excluded from 
database extraction.

NoExtractBusComp Multi-line setting. Defines a business 
component that must be excluded from 
database extraction.

SchemaChangeNotification Multi-line setting. Defines a Business 
Service that should receive the Handheld 
Schema Change Notification.

(Siebel internal)

ThreadThrottleScope Single-line setting. For Thread Throttling 
functionality. It defines the scope of the 
thread throttling mechanism as using 
one of two different modes: Process 
Thread (throttling occurs independently 
within each process), or Application 
(throttling occurs across all processes 
running the same handheld sync 
application on a single server). Only the 
first character of the 
ThreadThrottleScope parameter will be 
used to determine the value. All other 
characters are ignored. Thus “aardvark” 
is interpreted as “Application.” Case is 
also ignored. The default value is 
“Application.”

Application or 
Process

Table 10. Application Settings

Setting Name Definition Valid Values
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To add a new application setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration > Settings. 

2 From the Settings list menu, select New Record.

3 Click in the name field and select the desired application setting. 

4 Click in the Value field and enter the text of the setting.

TranProcThreadLoad Single-line setting. For Thread Throttling 
functionality. It is the load (or weight) 
that is assigned to each individual 
Transaction Processor thread. For each 
running transaction processing thread, 
this load value is used to determine the 
total system load, which is then 
compared against the 
MaxTotalThreadLoads value. A new 
thread will only be started if the total 
system load does not exceed the 
MaxTotalThreadLoads value. A value of 
zero disables throttling of transaction 
processing threads. 

integer >= 0; 
default is 3

TranProcThreshold Single-line setting. For Thread Throttling 
functionality. This is the minimum time 
(in minutes) that the Transaction 
Processor will continue processing 
transactions before performing a 
handshake with the client. Once this 
value has been exceeded, a handshake 
occurs instead of starting to process the 
next transaction. Doing so prevents the 
client from timing out the session when 
thread throttling is enabled.

integer >= 0; 
default is 5

TranReapplyComponent Single-line setting. Server component to 
use for playback of Companion Sync 
transactions for parent Companion Sync 
component.

TranReapplyServer Single-line setting. Siebel Application 
Server to use for playback of Companion 
Sync transactions for parent Companion 
Sync component.

Table 10. Application Settings

Setting Name Definition Valid Values
Siebel Pharma Handheld Guide Version 7.8 57



Application Administration ■ Configuring Component Level Settings for Siebel Handheld
Configuring Component Level Settings 
for Siebel Handheld
You administer server components for your handheld device from the Administration-Mobile > Server 
Component screen. The component displayed is based on the application selected in the Application 
Administration view. The Server Component Administration screen is used for overriding application 
settings at the component level on a specific server. The data entered here is used by the 
synchronization engine when the user synchronizes with the server. 

NOTE: You can use this method for Direct Server Sync but not Companion Sync.

The Server Component screen contains a list of server components associated with the application 
that was selected in the Application Administration screen. For each server component, the Settings 
view details the associated settings. 

The Name field value needs to be the exact component name, such as "SalesceObjMgr_enu", of the 
Handheld Sync server component.

Server component settings are used primarily for functionality required for individual server 
components. For example, thread throttling is dependent on components running on a particular 
server and is best set at the server component level. Examples of settings that might be made at 
the component level are MaxTotalThreadLoads, TranProcThreadLoad, DBExtractThreadLoad, and so 
on. Generally, settings made at the application level are shared by all server components. 

Administering Barcode Settings for 
Siebel Handheld
Siebel Handheld can scan and parse data from HIBC and UCC/EAN barcodes. Siebel Administrators 
can set up Siebel Handheld to scan and parse any one-dimensional barcode and render the 
corresponding data in an applet. For example, if a control in a list applet is enabled for barcode 
scanning and the barcode scanned is valid, the handheld application will parse the barcode, create 
a new record, and fill in the field with parsed data. In form applets, after the user scans an item, the 
data representing the item automatically populates the barcode-enabled field. In order to do this, 
Siebel Administrators must define the barcodes and how data will be parsed from these barcodes in 
the Barcode Administration view. 

Enabling Barcode Scanning in Siebel Handheld
Before using the barcode scanning feature, you must add the following parameter value in setup.ini:

EnableBarcode = Y

NOTE: In the event that your handheld application is not preconfigured to enable barcode scanning, 
you must make an Application Event Services entry in Siebel Tools.
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To enable barcode scanning

1 Navigate to Application object, and then select Siebel ePharma CE.

2 Expand to Application Event Services object, add a new entry  with the following:

Name: SHCE Core Barcode Service
Event Name: HHCE_Start
Business Service: SHCE Core Barcode Service

Mapping a Button for Socket In-Hand Scan Card
Siebel Handheld applications support embedded barcode scanners provided in Symbol and Intermec 
devices. In addition, Siebel Handheld applications support certain Socket scan cards. See System 
Requirements and Supported Platforms on Siebel SupportWeb for a list of supported handheld 
devices and Socket scan cards. Note that different Socket scan cards will require different scan card 
driver programs to be installed. Check with the card vendors/websites for required driver program 
installation. 

For Intermec and Symbol devices, the barcode scanning can be triggered by the built-in buttons. If 
you are using Socket scan cards, the following steps are required to be taken on the Handheld device 
for mapping a button to the barcode-triggering utility software, SocketTrigger.exe.

To map a button to SocketTrigger.exe (Socket Scan Card only)

1 Navigate to Start > Settings > Personal > Buttons.

2 From the Button list, select a button to trigger In-Hand Scan Card. 

3 In the Button Assignment field, select SocketTrigger, and then tap OK.

Creating New Barcode Definitions for the Handheld 
Application
You can define new one-dimensional barcodes in the Barcode Administration views. To define a new 
barcode, you need to create a new barcode definition in the Barcodes list, then create corresponding 
records in the Barcode Item list to define data elements within the barcode. 

To create a new barcode definition

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Barcode 
Administration.
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2 Click New, then fill in the fields. 

The fields in the Barcodes list are described in the following table: 

Field Comments

Name Required. Any descriptive name for the barcode. Must be 
unique for all records defined in the Barcode screen.

Sequence Required. This is the sequence for barcode parsing. The 
lower of two sequence numbers takes precedence when 
deciding which barcode in the list to match. For example, 
if a scanned barcode matches two entries in the barcode 
list, the one with a lower sequence number will be picked 
for the match. The lowest sequence number is 1.

Barcode Type Required. Type of barcode standard. Can either be Location 
or Code. For a Location type barcode, the barcode data 
element parsing is done solely by the Sequence field in 
Barcode Item list. For a Code type barcode, the barcode 
data is first parsed into multiple sections by the Code field 
in the Barcode Item list, then is further parsed by the 
Sequence field for each section. 

See “Example of Location Type Barcode” on page 62 and 
“Example of Code Type Barcode” on page 63.

Buscomp Optional. Used to designate into which business component 
the target data is placed.

Min Length Optional. The minimum length for the barcode data in 
digits. If it is not set, the default minimum length is 1. 

Max Length Optional. The maximum length for the barcode data in 
digits. If it is not set, the default maximum length is 10000. 

Prefix Optional. Defines the value that the parsing algorithm uses 
to identify barcode definition to use. The allowed format for 
Prefix is any ASCII character for exact match, '#' for any 
single digit number match (that is, 0 - 9), '&' for any 
alphabet character in lower and upper case, or '*' for a wild 
card match. For example, you can enter ##9&* as the 
prefix, which means the first two characters can be any 
number, the third character has to be '9', the fourth 
character can be any alphabet character, and the fifth 
character can be any ASCII character.

Suffix Optional. Allows you to associate suffixes with individual 
fields. The allowed format for Suffix is the same as the one 
specified for Prefix. In addition, the rules for matching 
Suffix are the same as the ones for Prefix.

Description Optional. Detailed description for this barcode.
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3 In the Barcode Item list, add new records to identify how data will be parsed from barcode.

Depending on the type of barcode standard you just defined (either Location or Code), you then 
need to create new records in the Barcode Item list to identify how data is parsed.

4 In the Barcode Item list, Click New, then update the required fields.

Some of the fields are described in the following table:

Field Comments

Name Required. Name of the barcode item (for example, Product 
Name corresponds to the Product Name field). This name 
does not determine which field in BusComp the parsed data 
is written to. That field is determined by the "Data Desc" 
field. 

Code Applicable for Code barcodes only. Used to break a barcode 
into multiple barcode sections.

Sequence Required. The sequence for barcode data elements 
parsing. For Location barcodes, this corresponds to the 
sequence used to parse data elements from the barcodes. 
For Code barcodes, this corresponds to the sequence used 
to parse data elements within barcode sections.

Min Length Required. Minimum Length of the character string for this 
data element. If this is a variable length string, then 
Minimum Length is not equal to Maximum Length. 

Max Length Required. Maximum Length of the character string for this 
data element. If this is a variable length string, then 
Minimum Length is not equal to Maximum Length. 

Data Desc Optional. Used by algorithm to identify what field to parse 
this data into. For example, Product Name corresponds to 
the Product Name field.

Data Format Optional. Defines format for data element (for example, 
MMDDYY is for date).

Action Optional. Defines the action for the data element. Both 
Data Format and Action are written to the field specified in 
"Data Desc" by the following format: "<parsed data 
element>,<Data Format>,<Action>". 

See the example in Table 14.
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Example of Location Type Barcode
The two entries for the Barcode list, HIBC Secondary and IBM, are shown in Table 11.

Entries for Barcode - HIBC Secondary in the Barcode Item list are shown in Table 12.

If the barcode being scanned is +$$90010039509283C001LZ, both barcode entries  "HIBS 
Secondary" and "IBM" are good matches. Since HIBC Secondary has a lower sequence as 1, it is 
picked as the final match for parsing the barcode. The data is parsed as follows:

{(Prefix, "+$$9") (Quantity, "00100") (Exp flag, "3") (Expiration Date, "950928,YYMMDD") (Lot #, 
"3C001") (Link, "L") (Check, "Z")}

NOTE: In this example, the use of “Prefix” in the two tables is different. The Prefix column in the 
Barcode list table is required for matching the record in the Barcode list. The Prefix row in the 
Barcode Item list table is a user-defined data element to be parsed for a particular barcode.

Table 11. Location Type Barcode List Entries

Name
Sequen
ce

Barcod
e Type Buscmp

Min 
Length

Max 
Length Prefix Suffix

Descrip
tion

HIBC 
Seconda
ry

1 Location Medical 
Product

31 +$$9##
###3

IBM 2 Location Tech 
Product

30 +$$9##
###39

Table 12. Location Type Barcode Item List Entries

Name Code
Sequenc
e

Min 
Length

Max 
Length

Data 
Desc

Data 
Format Action

Prefix 1 4 4 Prefix

Quantity 2 5 5 Quantity

Exp date 
flag

3 1 1 Exp flag

Date 4 6 6 Expiration 
Date

YYMMDD

Lot 5 0 13 Lot #

Link 6 1 1 Link

Check 7 1 1 Check
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Example of Code Type Barcode
Entries for Code type barcode in the Barcode list are shown in Table 13.

Entries for Code type barcode in the Barcode Item list are shown in Table 14.

The barcode UCC/EAN is parsed to three sections, 01, 30, and 240. If the barcode being scanned is 
01103123456789033050240ABCDEFG, the data is parsed as follows:

Parsed Data = {(AI 01, "01") (Indicator, "1") (UCC/EAN, "031234567890") (Link, "3") (Quantity 
section, "3050,1000,Validate") (Product #, "ABCDEFG")}

NOTE: The Code portions in the barcode appear in bold text.

Enabling Applications Views for Barcode Scanning
You can enable any existing or new view for barcode scanning.

Table 13. Code Type Barcode List Entries

Name
Sequen
ce

Barcod
e Type

Buscom
p

Min 
Length

Max 
Length Prefix Suffix

Descrip
tion

UCC/
EAN 

1 Code Medical 
Product

37 01

Table 14. Code Type Barcode Item List Entries

Name Code
Sequenc
e

Min 
Length

Max 
Length

Data 
Desc

Data 
Format Action

AI 01 01 1 2 2 AI 01

Packaging 
Indicator

01 2 1 1 Indicator

UCC/EAN 
#

01 3 12 12 UCC/EAN

Link 01 4 1 1 Link

Quantity 
Section

30 1 3 5 Quantity 
Section

1000 Validate

AI 240 240 1 3 3

Product # 240 2 1 13 Product #
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To enable an application view for barcode scanning

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Barcode 
Enabling.

2 Click New, then enter the necessary information. 

The fields in the Barcodes list are described in the following table: 

Example: Process of Creating a New Barcode Definition 
in the Service Handheld Application
Although this example is for the Siebel Service Handheld device, it pertains to all Siebel Handheld 
products. You can define new one-dimensional barcodes in the Barcode Administration views. To 
define a new barcode, you need to create a new barcode definition in the Barcode list, then create 
corresponding records in the Barcode Item list to define data elements within the barcode. 

To create a new barcode definition, complete the following procedures:

■ “To create a new barcode definition for Siebel Service Handheld” on page 64

■ “To enable the SHCE Service FS Activity Parts Movements views for barcode scanning” on page 65

To create a new barcode definition for Siebel Service Handheld

1 From the application level menu, select Navigate > Site Map > Administration-Mobile > Barcode 
Administration.

2 Click New, then fill in the necessary fields.

The following table describes the fields in the Barcodes list.

Field Comments

View The view in the handheld application from which the scan 
occurs.

Applet The applet within the view from which the scan occurs.

Buscomp The business component from which information is drawn.

Buscomp Field The specific field within the business component that 
should be updated through barcode scanning.

Field Sample Data

Name Hard Disk 100 GB

Sequence Set to the greatest number in the current 
list view plus one

Barcode Type Location

Buscomp FS Activity Parts Movement
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3 In the Barcode Item list, add a new record to identify how data will be parsed from the barcode. 

The following table describes the fields in the Barcode Item list.

NOTE: Reducing the amount of barcode seed data extracted to the Service Handheld application 
improves client performance and reduces synchronization database extract size.The following 
steps provide an example of extracting only the barcode standards that are required for the 
Service Handheld application. This is applicable as long as all the barcode records for the Service 
Handheld application defined in the Barcode list have the Description attribute set to "Service." 

4 From the application level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration. 

5 In the Application Administration view, select “Siebel Service for CE.”

6 Click the Settings view tab, and make sure the parent record is the application “Siebel Service 
for CE.”

7 Locate the "DefaultBusObj" directive that has the following value: 

■ "SHCE Barcode|0||SHCE Barcode||SHCE Barcode Item||SHCE Barcode Enable|". 

Replace that value with the following value:

■ "SHCE Barcode|0||SHCE Barcode|[Description]="Service"|SHCE Barcode Item||SHCE 
Barcode Enable|".

To enable the SHCE Service FS Activity Parts Movements views for barcode scanning

1 From the application-level menu, select Navigate > Site Map > Administration - Mobile > Barcode 
Enabling. 

The Barcode Enable list appears.

Min Length 12

Max Length 12

Prefix #

Description Service

Name Sequence Min Length Max Length Data Desc

UPC Code 1 1 1

MFG Code 2 5 5

Product Name 3 5 5 Product Name

CC 4 1 1

Field Sample Data
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2 If the following record does not exist, create a new record to enable the Product Name field in 
the SHCE Service FS Activity Part Movements List Applet for barcode scanning with the following 
information:

3 If the following record does not exist, create a new record for the Product Name field in the SHCE 
Service FS Activity Part Movements Form Applet for barcode scanning with the following 
information:

4 Save the changes. Now the Buscomp Field "Product Name" in both the "SHCE Service FS Activity 
Part Movements" view and the "SHCE Service FS Activity Part Movements (More Info)" view have 
been enabled for barcode scanning. The Buscomp Field "Product Name" specified here matches 
the value in the Data Desc column in the Barcode Item list defined earlier.

NOTE: The example provided above assumes that the product Hard Disk 100GB has been defined 
and properly set in the appropriate product catalog.

About Monitoring Synchronization 
Sessions for Siebel Handheld
You monitor Siebel Handheld application synchronization sessions and synchronization conflicts from 
a number of screens within the Siebel Mobile Web Client, or if you are using DSS or DSSvP you do 
so by way of the Siebel Web Client. Every time a user synchronizes with the server, a record is made. 

The following topics relate to synchronization monitoring. 

■ “Monitoring Synchronization Sessions for Siebel Handheld” on page 67

■ “Obtaining Error Details from Siebel Handheld Synchronization Sessions” on page 67

■ “Obtaining Business Component Information from Siebel Handheld Synchronization Conflicts” on 
page 68

View Applet Buscomp
Buscomp 
Field

SHCE Service 
FS Activity 
Part 
Movements

SHCE Service 
FS Activity 
Part 
Movements 
List Applet

FS Activity 
Parts 
Movement

Product Name

View Applet Buscomp
Buscomp 
Field

SHCE Service 
FS Activity 
Part 
Movements 
(More Info)

SHCE Service 
FS Activity 
Part 
Movements 
Form Applet

FS Activity 
Parts 
Movement

Product Name
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■ “Obtaining an Audit Trail for Siebel Handheld Synchronization Sessions” on page 68

■ “Acting Upon Synchronization Errors in Siebel Handheld” on page 69

Monitoring Synchronization Sessions for 
Siebel Handheld
The Session Administration view allows you to gather all data related to each sync session a user 
performs. The Sync Status list appears above two child lists: Sync Sessions and Extraction Info. 
These lists allow you to do the following:

■ Sync Status: Allows you to monitor each user sync session, and includes such data as: sync 
status, the date, type of sync and so on. 

■ Sync Sessions: Allows you to gather further information on the status of each sync session, 
including conflicts during the sync, the size of the data extracted, and so on.

■ Extraction Info: Allows you a detailed look at all data extracted during the sync session, including 
business component information, the number of records extracted. You use this list to help get 
answers to questions such as the following:

■ Why did a particular record download to the device?

■ Why is an expected server record not downloaded to the device?

■ Why is the total number of records showing up in some view so big?

■ Why is the total number of records showing up in some view so small?

■ Why does the extraction take so long?

There is one extraction record for each unique extraction context. The extraction record will 
list the filters used to control the extraction, the context of the extraction, how many records 
exist in that context for those filters, and how long it took to extract that set of records. By 
analyzing these records, and looking at all extraction changes resulting from filter changes, 
and, or changes to search specs (defined in Siebel Tools), you can answer all of the above 
questions.

To monitor synchronization sessions
■ From the application-level menu, select Navigate > Site Map > Administration-Mobile > Session 

Administration. 

The Sync Status list appears, with the two child lists, Sync Sessions and Extraction Info, below it.

Obtaining Error Details from Siebel 
Handheld Synchronization Sessions
The Conflict Administration view allows you to obtain details of sync errors that occur during 
individual sync sessions. 
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To obtain synchronization error details

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

2 In the Transactions list, select the appropriate record, and then click the Error Details view tab.

3 In the Error Details list, select or query for the desired record. 

Obtaining Business Component 
Information from Siebel Handheld 
Synchronization Conflicts
The Transactions view on the Conflict Administration screen allows you to obtain business component 
information related to synchronization errors that occur during individual sync sessions. 

To obtain business component error details

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

The Transactions view appears.

2 In the Transactions view, select the appropriate record, and then click the Business Components 
view tab.

Obtaining an Audit Trail for Siebel 
Handheld Synchronization Sessions
The Transactions view on the Conflict Administration screen allows you to obtain audit trail 
information for an action that was taken against a particular transaction.

NOTE: You must enable Audit Trail separately. For information on enabling Audit Trail, see 
Applications Administration Guide. 

To obtain audit trail information for synchronization error details

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

The Transactions view appears.

2 In the Transactions view, select the appropriate record, and then click the Audit view tab.
Siebel Pharma Handheld Guide Version 7.868 



Application Administration ■ Acting Upon Synchronization Errors in Siebel Handheld
Acting Upon Synchronization Errors in 
Siebel Handheld
Upon reviewing a synchronization error, you can act upon it by performing one of three different 
actions. 

To act upon handheld sync transaction errors

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration.

The Transactions list appears. The transaction buttons are described in the following table:

2 Click either Reapply, Export, or Ignore depending on your needs.

Process for Administering Siebel Pharma 
Handheld
Siebel administrators should see Siebel Life Sciences Guide for detailed information about managing 
samples. The following sections cover only those administration procedures that apply to the 
handheld version of Pharma.

The following sections cover the designated topics and procedures:

Action Result

Reapply Reapplies the selected transaction with values listed in the 
view (or Field Value view). These values override the 
results provided by the server.

TranReapplyComponent and TranReapplyServer are 
necessary when using Companion Sync and ignored for 
Direct Server Sync. These are used when selecting 
transactions to reapply from the Administration - Conflict 
screen.

If TranReapplyComponent and TranReapplyServer are not 
specified, it is impossible to reapply transactions 
originating from Companion Sync.

Export Exports the content of the transaction in the same format 
used by the sync engine. This output file can be sent to 
Siebel Technical Support for problem analysis.

Ignore Accepts the current status and does not act upon the error. 
The record becomes read-only. There is no impact, except 
that the error will no longer appear in queries for 
unresolved conflicts.
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■ “Managing Samples Records in Pharma Handheld” on page 70

■ “Administering Disclaimer Text in Siebel Pharma Handheld” on page 71

■ “Configuring Distributor Names in Siebel Pharma Handheld” on page 71

■ “Performing a Signature Audit in Siebel Pharma Handheld” on page 72

■ “Verifying Signature Capture in Siebel Pharma Handheld” on page 73

■ “Configuring User Properties for Closing Inventory Periods in Siebel Pharma Handheld” on page 75

■ “Configuring User Properties for Signature Capture Verification in Siebel Pharma Handheld” on 
page 76

■ “Validation Logic of the Sign and Submit Buttons in Siebel Pharma Handheld” on page 77

■ “Validating the DEA Number in Siebel Pharma Handheld” on page 84

■ “Preparing Receipts for Calls in Siebel Pharma Handheld” on page 85

Managing Samples Records in Pharma 
Handheld
Administrators can manage samples inventory using either Siebel Pharma Handheld or Siebel Life 
Sciences, but should not use both. In order to keep samples inventories in sync, end users should 
be prevented from submitting a samples transaction on the server when the same record is still 
editable on their handheld device.

When a user submits a record, the status changes to Submitted and it becomes read-only, meaning 
no additional operations are allowed on the record. By updating a user property and writing two small 
Visual Basic scripts, you can specify that synchronized records are also read-only.

■ First, the administrator changes the value of the user property “Update Status To Synchronized” 
to Y. 

Making this change invokes the UpdateStatusToSynchronized method on the Sample Txn 
business component. 

■ Then, the administrator writes a small Visual Basic script for this method to change the status 
on the Sample Txn to “Synchronized.” 

■ Finally, the administrator writes another Visual Basic script to specify that the record becomes 
read-only when its status changes to “Synchronized.” 

This prevents users from accidentally submitting the sample transactions on the server while the 
same record is still editable on their handheld device.

NOTE: Sample transactions are not logged upon submitting a sample drop. They only appear on the 
handheld device after syncing.
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Administering Disclaimer Text in Siebel 
Pharma Handheld
Your legal department may require that a change be made to the disclaimer text that appears below 
the signature area on the Siebel Signature Capture display of Siebel Pharma Handheld. Only one 
disclaimer can be active at a time.

NOTE: Signature capture configurability is only available on handheld applications, not on Siebel 
Web client applications.

To edit the disclaimer text

1 From the application–level menu, select View > Site Map > Samples Administration > Disclaimer 
Administration.

The Disclaimer Administration view appears.

2 In the Disclaimers list, add a record.

3 Enter the new text in the Disclaimer field.

The Status, Start Date, End Date, Created By, and Created fields are read-only.

4 Click Submit.

The submitted disclaimer becomes active, and the status and date fields are updated. When sales 
representatives next synchronize, the disclaimer on their Pharma handheld device is updated.

Configuring Distributor Names in Siebel 
Pharma Handheld
The name of the distribution company appears by default on the Siebel Signature Capture display. 
You may need to change this name if, for example, there is a name change as a result of a merger 
between two companies.

In addition, a company may use a contract sales force to distribute some of its products. You can 
use the Distributor by Employee feature to customize the display to show the name of the contract 
distributor for the contract sales representatives and to show the name of the primary 
pharmaceutical company for its sales representatives.

To change the distributor name in the Siebel Signature Capture display

1 From the application–level menu, choose Navigate > Site Map > Application Administration > 
System Preferences.

The System Preferences Administration view appears.

2 Find the Company Name system preference and change the value to the new company name.

When the sales reps next synchronize their PDAs, the new company name is downloaded to their 
Siebel Pharma Handheld applications.
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3 From the application–level menu, select Navigate > Site Map > User Administration > 
Employees.

The Employees Administration view appears.

4 Select the employee from the Employees list. 

5 In the More Info view, enter the account of the distributor in the External Account field. (The 
external account must already have been set up as an account.)

If the External Account field is blank for an employee, the company name set in the System 
Preference Administration view, set in Step 2, is used.

6 Repeat Step 4 and Step 5 for each employee of the distributor.

Performing a Signature Audit in Siebel 
Pharma Handheld
The Siebel administrator is typically assigned responsibility for checking the validity of signatures 
recorded electronically. This is done using the Verify button in the Signature Audit Administration 
view. For more information about the logic behind the Verify button, see “Validation Logic of the Sign 
and Submit Buttons in Siebel Pharma Handheld” on page 77.

As the samples administrator, you should check Signature Audit Administration regularly and perform 
signature capture verification to make sure that signatures collected from each contact are 
consistent. 

Users may see an error message if Signature Audit Administration tasks are performed on a desktop 
computer running multiple versions of Siebel Pharma. Make sure that only the latest version of Siebel 
Pharma is running, and uninstall all previous versions.

To verify signatures

1 From the application–level menu, select Navigate > Site Map > Samples Administration > 
Signature Audit Administration.

2 In the Sample Signatures list, create a query.

3 Visually compare the signatures for consistency.

Contact names are retained even if the Contact record is deleted. If a Contact record is deleted from 
Navigate > Site Map > User Administration > Persons, the contact name is removed from all applets 
with reference to that contact’s name in the S_CONTACT table. Therefore, if the Contact Id is deleted 
from the S_ACT_SIGN table, the last name and first name fields appear empty in the Sample 
Signature form in the Signature Audit Administration view.

However, the Contact Full name is not affected by deleting a contact record because it is stored in a 
text field in the same table. In the Signatures applet, the control above the signature displays the 
full name of the contact at the time of the call (that is, no reference to the S_CONTACT table). 
Because the contact’s name is not removed from this applet, a permanent and complete electronic 
record of calls captured with signatures recorded electronically is maintained.
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Verifying Signature Capture in Siebel 
Pharma Handheld
Signature capture verification compares information captured at the time of signature (the signature 
event string) with the current call information (the current call string) to assess if the call information 
has been modified. Reasons the call information might be modified include:

■ Re-creation of a sample receipt

■ Sample adjustments

■ Fraud

Signature capture verification is launched from the Verify button on the Signature Audit 
Administration view. For an example of signature audit administration, see “Performing a Signature 
Audit in Siebel Pharma Handheld” on page 72.

The Signature Key
When the signature is first created, a signature key is calculated from the signature and stored. 
When the signature is verified, this key is recalculated from the current signature and compared to 
the stored key. If the two keys do not match, the signature key checksum fails. A failed checksum 
indicates that the current signature has been altered since the time of capture. If the checksum fails, 
the signature is not displayed in the Signature Audit Administration view.

Outcomes of Checksums
The signature capture verification status (Passed, Adjusted, or Failed) is determined by the outcome 
of checksums: user property checksums, which compare text saved at the time of the signature 
capture with fields in the current call record and the signature key checksum. See Table 15 on 
page 73 for examples of checksum combinations.

NOTE: You may need to expose the Verification Status field using Siebel Tools. This is a configuration 
change that may need to be performed before implementation of Siebel Pharma Handheld. For more 
information, see the release notes documentation for Siebel Pharma Handheld.

Each user property checksum returns results for a different group of fields involved in the signature 
capture. Checksum examples and verification status settings are shown in Table 15.

Table 15. Checksum Examples

If…
Then the verification status is set 
to…

All checksums pass Passed

Any of the checksums fail Failed

One or two checksums return Adjusted and the others 
pass

Adjusted
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User Properties for Signature Capture Verification
In the default installation of Pharma Handheld, there are three user properties that set fields for the 
checksums (Checksum Field: 1, Checksum Field: 2, and Checksum Field: 3). These user properties 
and their default configurations are described in the following sections. 

Using Siebel Tools, you can create additional checksums. For more information, see “Creating New 
Checksum Field User Properties” on page 77.

Checksum Field: 1—Signature Header Text
This checksum compares the signature header text recorded at time of signature with the similar 
string in the current call record. The three possible outcomes (Passed, Adjusted, and Failed) for this 
checksum depend upon the signature header text strings and the (signature) Status field, as shown 
in Table 16.

Checksum Field: 2—Signature Body Text
This checksum compares the signature body text recorded at the time of signature with the similar 
string in the current call information.

The outcome (Passed and Adjusted) for this checksum depends on whether the signature body text 
strings match, as shown in Table 17.

Checksum Field: 3—Sales Representative’s Row Number
This checksum compares the identity of the call creator at time of signature with the identity of the 
current creator of the call. The employee’s row number is used to identify the call creator. 

An employee’s row number can be obtained by selecting the employee in the Employees view 
(Navigate > Site Map > User Administration > Employees) and then selecting Help > About Record. 
The Employee’s Row # appears in the About Record dialog box.

Table 16. Checksum Status for Signature Header Text

The Checksum 
Status Is… If the Signature Event String…

Passed Equals the current call string.

Adjusted Is different from the current call string and the (signature) Status is 
Inactive.

Failed Is different from the current call string and the (signature) Status is Active.

Table 17. Checksum Status for Signature Body Text

The Checksum 
Status Is… If the Signature Event String…

Passed Equals the current call string.

Adjusted Is different from the current call string.
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The outcome (Passed and Failed) for this checksum depends on whether the sales representative 
name text strings match, as shown in Table 18.

Configuring User Properties for Closing 
Inventory Periods in Siebel Pharma 
Handheld
The recommended process for closing an inventory period is:

1 Synchronize the handheld device with Siebel server immediately before closing the period.

2 Close the inventory period.

3 Synchronize the handheld device with Siebel server a second time, immediately after closing the 
inventory period.

End users must synchronize the handheld with Siebel server before closing the inventory period 
because there may be calls on the handheld that have not yet been synchronized with Siebel server. 
Only the current active period is downloaded to the handheld device. Therefore, after the current 
inventory period is closed, they must synchronize a second time in order to bring down the next 
active period.

To enforce this procedure, the inventory period closure logic has been added. When it is enabled, 
this logic goes into effect during the inventory period reconciliation. It ensures that the end user 
synchronizes his handheld with Siebel server before closing the inventory period, and it requires the 
end user to submit all outstanding calls (that is, when an electronic signature has been captured, 
but the call has not been submitted).

The following user properties have been created on the Pharma Inventory Period business 
component to support the inventory period closure logic:

■ Inventory Closure Validation. The default value is N (No), and the Inventory Period Closure 
logic is not triggered. To activate the Inventory Period Closure logic, set this parameter to Y (Yes). 
Setting the parameter to Y forces the end user to synchronize the handheld with Siebel server 
prior to closing the inventory period.

Table 18. Checksum Status for Sales Representative’s Row

The Checksum 
Status Is… If the Signature Event String…

Passed Equals the current call string.

Failed Is different from the current call string.
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■ Acceptable Period to Complete Synchronization. The default value is 30 (minutes). When 
Inventory Closure Validation is set to Y, the Acceptable Period to Complete Synchronization user 
property determines a grace period during which the end user must synchronize the handheld 
before closing the inventory period. If the end user does not synchronize within the time period, 
he will not be permitted to close the inventory period.

If Inventory Closure Validation is enabled and the Acceptable Period to Complete Synchronization 
user property is not created, the default value of 30 minutes is used. 

After the end user successfully closes the inventory period, he sees a message that prompts him to 
synchronize the handheld device with Siebel server. Note, however, this step is not enforced. 
However, if the end user fails to synchronize a second time, the handheld device will not receive the 
current period, and this can potentially cause synchronization errors the next time the end user 
synchronizes.

NOTE: The same logic is enforced during inventory reconciliation.

Configuring User Properties for 
Signature Capture Verification in Siebel 
Pharma Handheld
Use Siebel Tools to edit the following user properties:

■ Turn checksums on or off

■ Add additional fields to checksums

■ Remove fields from checksums

■ Create new checksums of the same form as Checksum Field: 3

Editing Checksum Field: 1—Signature Header Text
This checksum compares the Signature Header Text field in the Pharma Call Signature business 
component with the concatenated text string of the Header Text Fields (Header Text Field: 1 to 
Header Text Field: 7) in the Pharma Professional Call business component.

In Siebel Tools, you can edit these user properties by adding, deleting, or editing the Header Text 
Fields in the Pharma Professional Call business component. The maximum allowed number of Header 
Text Fields is 20 (Header Text Field: 20).

Editing Checksum Field: 2—Signature Body Text
This checksum compares the signature body text in the Pharma Call Signature business component 
with the concatenated text string of the Signature Body Text Fields (Signature Body Text Field: 1 to 
Signature Body Text Field: 3) in the Pharma Call Sample Dropped business component. 

In Siebel Tools, you can edit these user properties by adding, deleting, or editing the Signature Body 
Text Fields in the Pharma Call Sample Dropped Call business component. The maximum allowed 
number of Signature Body Text Fields is 10 (Signature Body Text Field: 10).
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Editing Checksum Field: 3—Sales Representative’s Row Number
This checksum compares the “Created by” field of the Pharma Call Signature business component 
with the “Created by” field of the Pharma Professional Call business component. 

In Siebel Tools, you can edit these user properties by replacing “Created by” with any field found in 
both business components. 

Creating New Checksum Field User Properties
In Siebel Tools, you can create user properties for up to 25 checksums that compare fields in the 
Pharma Call Signature business component with fields in the Pharma Professional Call business 
component. 

Use Checksum Field: 3 as a template to create new user properties with the same format. 

Name the new user property Checksum Field: n, where n is less than or equal to 25. See Table 19.

Validation Logic of the Sign and Submit 
Buttons in Siebel Pharma Handheld
You can edit the validation logic for the Signature and Submit buttons for professional and account 
calls.

Default Validation Logic Flowcharts
The default validation logic for the Signature and Submit buttons is shown in the following 
flowcharts:

■ Signature button, Figure 1 on page 78

■ Professional Call Submit button, Figure 2 on page 79

■ Account Call Submit button, Figure 3 on page 80

Not all implementations of Pharma Handheld require the extensive validation as shown in the 
following flowcharts. Before most validation steps, the procedure consults a user property to 
determine if the field should be used during the validation. For example, if it is not necessary to 
validate the License Number field, the user property Validate License Number is set to false. The 
Signature button validation then skips the validation question “Is the License Number field 
populated?”.

Table 19. Checksum Field User Properties

User Property 
Name Value

Checksum Field: 3 “Created by”, “Created by”

Checksum Field: n “field in Pharma Call Signature”, “field in Pharma Professional Call”
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User Properties that can be used to alter validation logic are described in “Changing Validation Logic 
by Editing User Properties” on page 80.

Figure 1. Default Validation Logic Flowchart for Signature Button
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Figure 2. Default Validation Logic Flowchart for Professional Call Submit Button
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NOTE: The numbers in the flowchart correspond to the numbers of the user properties show in 
Table 20 on page 81

Changing Validation Logic by Editing User Properties
Validation logic uses user properties to determine whether a field should be used during validation.

Figure 3. Default Validation Logic Flowchart for Account Call Submit Button
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Table 20 explains the user properties you can use to alter the validation logic of the Sign, Professional 
Call Submit, and Account Call Submit buttons.

Table 20. User Properties for Setting Sign and Submit Button Logic 

Flowchart 
Reference User Property Action if Y… Action if N…

Default 
Value

1 “Validate OK to Sample”

Use to enforce confirmation 
that the OK to Sample flag is 
selected before launching 
the Signature Capture 
display.

Enforce the OK to 
Sample validation.

Skip the OK to 
Sample validation.

Y

2 “Validate License Number”

Use to enforce validation 
that the License # is 
populated before launching 
the Signature Capture 
display.

Enforce the License 
Number validation.

Skip the License 
Number validation.

Y

3 “Validate License Number 
Status”

Use to enforce validation 
that the License # status = 
Active before launching the 
Signature Capture display.

Enforce the License 
Number Status 
validation.

Skip the License 
Number Status 
validation.

N

4 “Validate License Number 
Expiration”

Use to enforce validation 
that the Expiration date on 
the License # is later than 
Today before launching the 
Signature Capture display.

Enforce the License 
Number Expiration 
validation.

Skip the License 
Number Expiration 
validation.

N
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N/A “Validate Address DEA 
Number”

Use to enforce that the DEA 
number is valid (DEA # 
checksum algorithm) at the 
time the value is entered 
into the DEA # field on the 
Address child applet (on the 
handheld).

This user property applies to 
both the laptop and the 
Siebel Handheld 
applications.

Enforce the 
Address DEA 
Number validation 
(field is populated 
and number is 
valid).

Skip the Address 
DEA Number 
validation (field is 
populated and 
number is valid).

Y

6 “Validate Signature DEA 
Number”

Use to enforce that the DEA 
number is populated and 
that the value is valid (DEA 
# checksum algorithm) 
before launching the 
Signature Capture display.

Enforce the DEA 
Number validation 
in the Signature 
button (field is 
populated and 
number is valid).

Skip the DEA 
Number validation 
in the Signature 
button (DEA 
number is valid per 
the checksum 
routing and the 
field is populated).

Y

7 “Validate DEA Number 
Expiration”

Use to enforce validation 
that the Expiration date on 
the DEA is later than Today 
before launching the 
Signature Capture display.

Enforce the DEA 
Number Expiration 
validation in the 
Signature button 
(expiration date is 
later than today).

Skip the DEA 
Number Expiration 
validation in the 
Signature button 
(expiration date is 
later than today).

N

8 “Validate Professional 
Profile”

Use to validate if the 
professional’s Last Name, 
First Name, Title, and 
Address fields are populated 
before launching the 
Signature Capture display.

Enforce the 
Professional Profile 
validation.

Skip the 
Professional Profile 
validation.

Y

Table 20. User Properties for Setting Sign and Submit Button Logic 

Flowchart 
Reference User Property Action if Y… Action if N…

Default 
Value
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9 “Validate Sign Lot Number”

Use to validate if the lot 
number is populated on 
launching the Signature 
Capture display.

Enforce the 
Signature button 
Lot Number 
validation.

Skip the Signature 
button Lot Number 
validation.

N

10 “Validate Submit Lot 
Number”

Use to validate if the lot 
number is populated on 
submitting a call.

Enforce the Submit 
button Lot Number 
validation.

Skip the Submit 
button Lot Number 
validation.

Y

11 “Sample Disbursed 
Required”

Use to require that at least 
one sample be disbursed 
before submitting the call.

Enforce that at 
least one sample 
be disbursed.

Do not require at 
least one sample 
disbursed.

N

12 “Must Detail Products”

Use to require that at least 
one product be detailed 
before submitting the call.

Enforce that at 
least one product 
be detailed.

Do not require at 
least one product 
detailed.

N

13 “Paper Reference Number 
Required”

Use to require a sample 
reference number for calls 
with paper signatures.

Enforce the Paper 
Reference Number 
required validation.

Skip the Paper 
Reference Number 
required validation.

Y

14 “SRE Reference Number 
Required” 

Use to require a sample 
reference number for 
signature recorded 
electronically (SRE) calls.

Enforce the SRE 
Reference Number 
required validation.

Skip the SRE 
Reference Number 
required validation. 
(If the Ref # field is 
blank, it will be 
populated with the 
Row ID of the call.)

N

15 “SRE Professional Type”

Use to require that the 
professional type be valid for 
signature recorded 
electronically (SRE) calls.

The professional type (for example, 
“Physician”) must match the value of this 
user property.

If the value is null, all professional types 
are valid.

null 

Table 20. User Properties for Setting Sign and Submit Button Logic 

Flowchart 
Reference User Property Action if Y… Action if N…

Default 
Value
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Validating the DEA Number in Siebel 
Pharma Handheld
In the U.S., the DEA number is a federally authorized number for physicians with a practice at a 
specific address. 

In Pharma Handheld, the DEA number is stored at the address level for each physician. Pharma 
Handheld can confirm that a valid DEA number is populated at the selected address for a professional 
call. Depending on how your Pharma Handheld application is configured, the valid DEA number check 
can be performed at the time of entering the DEA number, upon launching the Siebel Signature 
Capture display, or both.

If:

■ The product dropped is a controlled substance and

■ The user property “Validate Address DEA Number” or “Validate Signature DEA Number” is true

N/A Submit Confirmation

Note: If this user property 
does not exist (for example, 
in the standard Siebel 
Pharma application), 
behavior is equivalent to 
“Submit Confirmation” = Y.

Confirmation 
message appears 
when the Submit 
button is tapped.

No confirmation 
message appears 
when Submit 
button is tapped.

Y

N/A Submit On Sign OK

Note: If this user property 
does not exist (for example, 
in the standard Siebel 
Pharma application), 
behavior is equivalent to 
“Submit On Sign OK” = N. 

Tapping the OK 
button on the 
Siebel Signature 
Capture display for 
new professional 
calls invokes the 
submit method. 
The submit method 
is not invoked for 
account calls nor 
for re–created 
professional calls.

Tapping the OK 
button on the 
Siebel Signature 
Capture display 
closes the display. 
To submit the call, 
tap the Submit 
button.

N

Table 20. User Properties for Setting Sign and Submit Button Logic 

Flowchart 
Reference User Property Action if Y… Action if N…

Default 
Value
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then Pharma Handheld checks the validity of the DEA number by executing the algorithm described 
in Table 21.

 

Preparing Receipts for Calls in Siebel 
Pharma Handheld
As the Siebel administrator, you may be asked to print receipts for sample drops to a physician. From 
the Sample Event Administration view, you generate a list of sample drops and print receipts using 
the Sample Receipt report.

To print receipts for samples dropped

1 From the application-level menu, select Navigate > Site Map > Samples Administration > Sample 
Event Administration.

2 In the Sample Events list, create a query.

3 From the application-level menu, select Navigate > Site Map > Reports to open the Sample 
Events dialog box.

4 From the Select a Report drop–down list, select Sample Receipts and click Run.

5 To print the receipt, click the Print button in the Siebel Report Viewer window.

Table 21. The DEA Number Checksum Algorithm

Step Algorithm Example

1 The first two characters must be uppercase 
letters.

BB1388568

2 Sum the first, third, and fifth digits. 1 + 8 + 5 = 14

3 Sum the second, fourth, and sixth digits. 3 + 8 + 6= 17

4 Double the number obtained in step 2 × 17 = 34

5 Sum the numbers from steps 2 and 4. 14 + 34 = 48

6 If the last digit of the DEA number is the 
same as the last digit of the number 
obtained in step 5, the DEA number is 
considered valid.

The last digit of BB1388568 and 48 is the 
same, “8”. 
This checksum indicates that the DEA 
number is valid.
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5 Data Filtering
The following topics are covered in this chapter:

■ “Developing Data Filters for Handheld” on page 87

■ “Constructing Business Component and Business Object Filters” on page 88

■ “Business Object Filters” on page 89

■ “Recommendations for Managing Handheld Business Object Filters” on page 89

■ “Examples of Default Business Object Declarations” on page 90

Developing Data Filters for Handheld
The following general steps are recommended for developing Handheld synchronization filters.

■ Identify the screens and views of your application. Then identify the business components that 
are required to support each screen and view, noting the areas where each business component 
occurs. For example, identify the form, list, or pick applets that are based on each business 
component.

■ Within Siebel Tools, establish the base parent-child relationships and any reverse relationships 
at the component level.

■ Review the business components that occur in picklists and consider creating business 
component filters for those that will cause large numbers of records to synchronize to the device. 
These filters are created and maintained in the Mobile Administration screens. For each business 
component, determine whether it is possible to apply a search specification to all instances of 
the business component within the Siebel Handheld application. Develop a set of suitable 
business component filters in the Mobile Administration screens. 

Common examples of business components that are suitable for global business component 
filters include: 

■ Employees (for large organizations)

■ Activities (for example, filter for current Activities, Activities of only certain kinds)

■ Accounts (for example, by geography) 

■ Products (for example, active, orderable products)

■ Orders (for example, open, closed in last three months)

■ Create appropriate business object synchronization filters for each business object and make 
sure that each business object includes a default filter. Default filters make sure that users avoid 
accidental download of an excessive number of records.
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Constructing Business Component and 
Business Object Filters
Business component filters are used to limit the extraction of a business component for every context 
in which it is extracted.

Example of Business Component Filter Syntax:
Business component filters use query by example (QBE) syntax.

[Status] = "Not Started" OR [Status] = "In Progress" OR ([Status] IS NULL) OR [Status] = "On Hold" OR 
([Status] = "Done" AND [Done] >= Today() - 7)

For more information on QBE syntax, see Siebel Developer’s Reference.

Business object filters are used to supply filters that a user can select at sync time. These are the 
filters that are displayed in the SetFilters dialog on the device.

Example of Business Object Filter Syntax: 
Business object filters use predefined query (PDQ) syntax.

PDQ syntax rules are a follows: 

■ The business component name should be a valid business component in the business object on 
which the PDQ is based

■ Search and Sort can be specified for all active buscomps in the business object on which the view 
is based, appended to each other in any order using space as delimiter.

The normal search spec and sort spec syntax applies except that quotes in the search spec have to 
be escaped using double quotes since the search spec itself is enclosed in double quotes.

The syntax is as follows. Descriptions of the terms are shown in Table 22.

'Account'.Search = "[State] = LookupValue ( ""STATE_ABBREV"", ""CA"" )" 'Account'.Sort = "Name, Location" 

Table 22. Business Object Filter Syntax

Syntax Term Description

Account business component name

Search key word

"[State] = LookupValue (""STATE_ABBREV"", ""CA"")" search specs using PDQ syntax

State field name

LookupValue function for find an LOV value

STATE_ABBREV LOV type

CA LOV value

'Account'.Sort = "Name, Location" sort spec for sorting the returned list
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For more information on PDQ syntax, see Siebel Developer’s Reference.

Business Object Filters
All Siebel Handheld business object filters are available for selection by a user at the time of sync. 
Additionally, there is no naming convention for business object filters. 

A default filter for a business object is indicated by checking the Default flag in the Administration-
Mobile > Application Administration > Business Object Filters view of the Siebel Web client. Be sure 
to define a default filter for each business object in the Siebel Handheld application. If no filters are 
applied during the synchronization process, an unacceptably high volume of data will be downloaded 
to the handheld device. 

CAUTION: You should select only one filter as the default for each business object. If two filters are 
marked as the default for the same business object, the actual default can be determined only by 
attempting to sync and selecting default filters from the sync client filter selection UI.

Recommendations for Managing 
Handheld Business Object Filters
The following section provides recommendations for creating and managing filters according to 
synchronization methods.

Companion Sync Deployments
Administrators typically provide their users with an initial set of Handheld business object filters and 
instruct them how to manage the synchronization filters themselves later. They are maintained in 
the Administration-Mobile > Application Administration > Business Object Filters view. This view is 
hidden from mobile users so they cannot create their own business object filters. 

You manage these filters at the server level, then replicate any updates you make down to the 
companion computers via Siebel Remote. The Handheld user can then access the updated filters after 
performing a Companion Sync operation. For more information, see “Setting Business Object Filters 
for Siebel Handheld Users” on page 50.

Additionally, there are several sample Handheld business object filters in the sample database, as 
well as in the Siebel 7.8 seed data.

Direct Server Sync Deployments
For Direct Server Sync deployments, administrators can create user-specific business object and 
business component filters in the Administration-Mobile > User Administration view. For more 
information, see “Setting Business Component Filters for Siebel Handheld Users” on page 49 and 
“Setting Business Object Filters for Siebel Handheld Users” on page 50. 
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Both application-level and user-level filters can be used in this deployment. They are managed in the 
same set of views. Changes to any filters will be effective on your next sync session, without having 
to restart the Handheld synchronization OM component.

These business object filters are made available to all end users and, therefore, must be defined with 
the needs of all end users in mind. 

Examples of Default Business Object Declarations
You can set default business object declarations in the Administration-Mobile > Application 
Administration > Settings screen, as described in the following examples.

Example 1
“State Model” default business object setting:

State Model - Engine|0||State Model|[BusComp Name]="Expense"|State Model - 
Transition||State Model - State||State Model - Position|

The first three segments of the declaration are followed by a series of repeating BusCompName 
Search Spec pairs:

1 Business object name

2 Visibility Type

3 (Siebel internal)

4 Root business component name

5 Search spec QBE for root BusComp records

6 Child business component name

7 Search spec QBE for child BusComp records (this should normally be empty, causing all children 
to be extracted)

8 Grandchild business component name

9 Search spec QBE for grandchild BusComp records (this should normally be empty, causing all 
grandchildren to be extracted)

and so on

The total number of fields must be at least 5 and must be an odd number.

Example 2
Action|0||Action||Action Employee|
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This example default business object declaration results in an extraction of the Action and Action 
Employee business components where they occur with visibility 0 using the business object filter 
indicated. The business object filters are generally used only for extracting business components that 
do not correspond to any views or applets. Business object declarations identify specific business 
components within the business object to be extracted. The business object filters normally give a 
query based on the primary business component in the business object and force extraction of any 
business components mentioned in the query when there is no corresponding applet within the 
application that can cause the desired extraction to occur.

Example 3
In the following example, the declaration is used to extract all the Price List Line Items under the 
Order Entry (Sales) business object. 

DefaultBusObjs13=  Order Entry (Sales)|0||Price List Item|

Note that this declaration lacks an associated QBE clause. When this is the case, all of the records 
available to the user for the given visibility are extracted.

Exercise caution when modifying a default business object setting for pick applets, and do so only 
with the support of a skilled Siebel configurator. 

Use default business object declarations to force the extraction of data for a given business 
component in the context of a given business object and Visibility type. For more information on 
visibility designations, see “Designating Visibility” on page 91. The default business object extractions 
are performed in the first phase of data extraction.

You will most often use these declarations to extract additional data that is not extracted as part of 
the user interface extraction. This may be useful for business components that are referenced 
programmatically by other business components, but are not exposed in the user interface. The 
default business object declarations are used to enforce the extraction of a subset of data to the 
handheld that would not have been otherwise extracted or, most commonly, to filter the data 
downloaded for dynamic picklists or pick applets.

All pick data is not downloaded to the device due to the memory constraints on the device. Only pick 
data for fields that are editable is downloaded. Therefore, if you are doing a query on a pick field, 
you may not be able to display the picklist. When viewing a record in an applet, if a pick field is read-
only, its pick button will be disabled. If end users select a read-only field with a pick control, they 
receive the following error: “No data available in picklist because field is read-only.”

Designating Visibility
It is very important that you use the correct visibility designation in the default business object 
declarations. The visibility entered should be the visibility that governs the data displayed for the 
business component within the context of the business object specified in the declaration. In the 
previous Example 1, visibility code 3 is designated. This corresponds to All Visibility, which is the 
visibility that applies to the Account business component when it is used in a pick applet.
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You determine the correct visibility to use by examining View and business component properties 
within Siebel Tools. When creating a default business object declaration to restrict the volume of data 
extracted for a pick applet, begin by examining the Popup Visibility Type in Business Component 
Properties. Cross-reference the visibility type to the list below, and enter the appropriate visibility 
code in the declaration. If the Popup Visibility Type field on the business component is null, the 
default value is All. Table 23 summarizes popup visibility types and the corresponding visibility codes.

.

NOTE: Do not use the Group, Catalog, or Sub Organization Popup Visibility Types. These are not 
supported in the CE handheld applications.

Overriding the Popup Visibility
If the Popup Visibility Type setting is not sufficiently restrictive (for example, All Visibility), this can 
lead to a large number of records being extracted when the picklist is processed during 
synchronization. Making the Popup Visibility Type more restrictive reduces the number of records 
extracted for picklists. The OverridePopupVisibility user property for an applet overrides the Popup 
Visibility Type on a business component. Use this property when the desired visibility differs from the 
business component’s Popup Visibility Type, and you do not want to change the Popup Visibility Type. 
If several picklists use the same business component, you can also use the OverridePopupVisibility 
user property to vary the visibility of the picklists in the different applets.

There are two considerations you should keep in mind if multiple applications are sharing the same 
repository. First, changing the Popup Visibility Type has a global effect for all instances where the 
business component is used. If multiple applications share the same repository and use the same 
business components, changing the Popup Visibility Type for a common business component could 
have an undesirable effect for another application. Second, if multiple applications share the same 
applet, the picklist in each applet shares the same visibility as defined by OverridePopupVisibility 
property. This is because the OverridePopupVisibility property is set on the containing applet.

Table 23. Visibility Codes

Popup Visibility Type Visibility Codes

Sales Representative 0

Manager 1

Personal 2

All 3

None 4

Organization 5

Contact 6
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In Siebel Tools, navigate to Applet > Applet User Properties, and define the OverridePopupVisibility 
user property on the applet containing the control that opens the pick applet. See Table 24 for a 
description of the syntax. Assign a value to this property using the syntax shown, where <buscomp 
field n> is the underlying business component field of an applet control or column, and <visibility 
type> is the code corresponding to the desired visibility of the picklist’s business component. (See 
Table 23 for a list of the visibility codes.) Because the name of the OverridePopupVisibility parameter 
must be unique, append a unique number to the name of the parameter for any other picklists, for 
example, OverridePopupVisibility1, OverridePopupVisibility2, and so on.

NOTE: If OverridePopupVisibility is used, then the picklist and pick applet search specifications are 
ignored during synchronization when the records for the picklist are extracted.

Table 24. OverridePopupVisibility Syntax

Name Value

OverridePopupVisibility <buscomp field 1>, <visibility type>

OverridePopupVisibility1 <buscomp field 2>, <visibility type>

OverridePopupVisibility<n> <buscomp field n + 1>, <visibility type>
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6 Deployment of Siebel Handheld
This chapter includes the following topics:

■ “Overview of Server Installation in Support of the Siebel Handheld Client” on page 95

■ “Process of Server Installation for Siebel Handheld Direct Server Sync” on page 97

■ “About Siebel Handheld Synchronization Performance and Scalability” on page 100

■ “Process of Installing the Siebel Handheld Application” on page 102

■ “Installing Print Templates in the Siebel Handheld Install Directory” on page 107

■ “Setting Up Siebel Handheld Application Installation on a CompactFlash Card” on page 107

■ “Changing the SyncURL on Siebel Handheld Devices” on page 108

■ “Installing the Siebel Handheld Application from External Media” on page 108

Overview of Server Installation in 
Support of the Siebel Handheld Client
This section provides an overview of important factors to consider when planning Direct Server 
Synchronization (DSS) infrastructure. One aspect of successful planning and execution of a Siebel 
Handheld DSS deployment is to understand hardware and network requirements. While these factors 
are generally applicable to all deployments, there are unique aspects to each customer configuration 
and implementation strategy. Therefore, it is highly recommended that customers conduct detailed 
configuration, sizing, and production readiness reviews with Siebel Expert Services. This is especially 
important for complex deployments, such as those supporting large numbers of users over wide 
geographic areas. 

You can also improve the performance and scalability of DSS deployments by working with the Siebel 
application server component parameters. For more information about the Siebel application server, 
see “Optimizing Server Process Management for Direct Server Sync” on page 100.

NOTE: The recommendations in this chapter are general ones and are intended to raise your 
awareness of the key factors in handheld synchronization, performance, and scalability. These 
factors must be confirmed for your actual environment, and the usage patterns in your enterprise 
should be taken into consideration.
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Server Topology Overview
The diagram in Figure 4 shows the servers and components that are required to deploy Direct Server 
Sync. The components are the Siebel database, Siebel server, Siebel Web engine, and Siebel 
Handheld. The synchronization components are the Siebel Sync Engine which resides on Siebel 
server and the Sync client on Siebel Handheld. 

CAUTION: Companion Sync uses Siebel Remote to complete the synchronization process to the 
Siebel server from the laptop. The remote mobile user's routing model must be set to Handheld User. 
Otherwise, sync will fail. For more information, see Siebel Remote and Replication Manager 
Administration Guide.

Recommended Hardware and Network Configuration
There are many factors to take into account when designing and implementing your server and 
network hardware and architecture, and sizing your database. The critical factor in sizing a handheld 
implementation is the expected peak synchronization load. Specific application variables to consider 
in calculating this load are: the number of concurrent users, number of transactions, and size of the 
data file. These variables should be considered within the context of the hardware specifications, 
including memory and processor speed.

The following resources are available as you plan your Siebel Handheld implementation:

■ Refer to Microsoft and manufacturer documentation for comprehensive information on server 
hardware and registry parameters.

■ Refer to Siebel Technical Note 405 for specific recommendations on the following topics: 

■ Server Architecture

■ Server Hardware and Registry Parameters

■ Database Server Sizing

■ Database Tuning

■ Dial-Up and Network

■ Wireless

■ VPN (Virtual Private Networks)

Figure 4. DSS Servers and Components
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■ The Expert Services Handheld Review Package assists customers with planning their hardware 
and network for handheld implementations. Contact Siebel Expert Services for more information 
about this program.

Process of Server Installation for Siebel 
Handheld Direct Server Sync
The server components that are required for Siebel Handheld are installed when you install the Siebel 
server. See the Siebel Server installation guide for your operating system for details on installing and 
configuring Siebel server. The Siebel server installer copies the necessary DLLs to create an Object 
Manager for Direct Server Sync and creates and configures a Server Component and Component 
Group. The rest of this subsection describes which options you must select to correctly install the 
software, along with creating or configuring additional Object Managers.

This process includes the following tasks:

■ “Installing the Direct Server Sync Components Using the Siebel Server Installer” on page 97

■ “Configuring Direct Server Sync Logging Levels” on page 98

■ “Optimizing Server Process Management for Direct Server Sync” on page 100

Installing the Direct Server Sync Components Using the Siebel Server 
Installer
Install the Siebel server, following the instructions in the Siebel server installation guide for the 
operating system you are using. When you reach the Setup Type screen in the Installer wizard, you 
are presented with three installation options:

■ Typical. This setup option installs all Siebel server components except those displayed. 

■ Compact. This setup option installs only those components necessary to run the Siebel server, 
but no additional components or help.

■ Custom. This setup option lets you customize your installation by choosing the specific 
components you want to install.

To install the Direct Server Sync components with your Siebel Server installation

1 During the Siebel Server installation, when the Setup Type screen appears, choose the Custom 
setting, and then click Next.

NOTE: At this screen, you may also choose a different directory for your Siebel server 
installation. 

2 From the following components, choose Handheld Synchronization:

■ Object Manager Component

■ Handheld Synchronization

■ Siebel Data Quality Connector
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■ Remote Search Support

■ Siebel Java Integrator

NOTE: You must enable Handheld Synchronization to enable Direct Server Sync for your DSS 
installation.

3 Click Next.

Continue with the installation in Siebel Installation Guide for Microsoft Windows: Servers, Mobile 
Web Clients, Tools.

The install wizard automatically installs and configures the DSS components. 

DSS Server Component Parameters
See Table 25 for a list of required parameters. For information on adding DSS server components, 
see Siebel System Administration Guide.

Configuring Direct Server Sync Logging Levels
To set the logging level, you need to perform the following two tasks:

■ “To configure server logging levels” on page 99

■ “To configure server logging levels using the Server Configuration screen” on page 99

Table 25. DSS Server Component Parameters

Parameter Default Value Description

ApplicationName Siebel PharmaCE The Siebel Handheld application. This value 
must match the name of the application as 
it is specified in Siebel Tools.

ApplicationTitle Siebel Pharma CE The name of the Siebel Handheld application 
as shown on the title bar on the browser. 
This parameter is only used if the Siebel 
application developed for the handheld is 
run on the Web client.

ApplicationSplashText Siebel Pharma CE The Siebel Handheld application name as 
shown on the splash screen. This parameter 
is only used if the Siebel Tools application 
developed for the handheld is run on the 
Web client.

ComponentName Required for Direct Server Sync, it is 
entered in the registry on the handheld 
device.
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You set the logging level to a value between 1 and 5 as shown in Table 26.

To configure server logging levels

1 Log into Server Manager from a (m:\siebel\bin\w32ud) prompt. 

2 Run the following: 

change evtloglvl HandheldSyncLog=[LogLevel] for comp [OMName], where [LogLevel] = an 

integer between 1 - 5 (5 enables all logging) and [OMName] = the OM name (for example, 

<ApplicationName>CEObjMgr_enu). 

To configure server logging levels using the Server Configuration screen

1 Navigate to Administration - Server Configuration > Servers > Components.

2 In the Component list, query for the appropriate component, such as Handheld Sales CE (ENU).

3 In the Events list, search for the event type Handheld Sync Logging.

4 Set the value to a number between 1-5 and then save the change.

See Table 26 for logging level results.

Configuring Companion Sync Logging Levels
To enable logging for Companion Sync process, you must add a parameter to the [pda] section of 
the CFG file.

To configure Companion Sync logging levels

1 Navigate to \client\bin\enu (or other language directory, such as \client\bin\fra).

2 Add the parameter HandheldSyncLogLevel and a valid value (1-5) to:

phce.cfg. For example, HandheldSyncLogLevel = 5.

See Table 26 for logging level results.

Table 26. Direct Server Sync Logging Levels

Logging Level Results

1 Error listing

2 Warning listing

3 Information listing, 
including SQL tracing

4 Information listing

5 Debug
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Optimizing Server Process Management for Direct Server Sync
Several parameters are outlined below that help optimize server processing for Direct Server Sync. 

To set parameters to optimize server process management

1 Log into the Siebel client as a user with Administrative responsibility.

2 Navigate to Site Map > Administration - Server Configuration > Servers > Components > 
Parameters.

3 In the Component Parameters sub-view, query for SalesCEObjManager.

4 Use the following table to update the parameters.

About Siebel Handheld Synchronization 
Performance and Scalability
There are a number of factors that affect the performance and scalability of handheld 
synchronization. It is very important that administrators and those involved in the design and 
deployment of Siebel Handheld understand the impact of usage parameters on synchronization 
performance and scalability. For more information, see Technical Note 405 for application-specific 
variables affecting synchronization and data from synchronization scalability tests. 

Using Multiple Synchronization Servers
As you scale your deployment, you may need to use multiple synchronization servers to 
accommodate all of your users. Your end users must be manually assigned to a particular server. 
Resonate products cannot be used for load balancing. Refer to Technical Note 405 and to your 
hardware manufacturer’s documentation for more information on scaling deployments.

Parameter Description

Max Tasks Determines the maximum number of threads that can run 
concurrently for a given component. You should set the value 
of this parameter to a number equal to that of the expected 
peak number of concurrent synchronizations.

Min MT Servers Determines how many multithreaded server processes are 
started by default for the Siebel Object Manager.

Max MT Servers Defines the maximum number of processes supported by the 
instance of the Siebel Object Manager. The value for this 
parameter should be the same as Min MT servers and should 
be set so that threads per process (Max Tasks/Max MT 
Servers) is optimized.
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Providing Synchronization Security with 
Secure Sockets Layer
The synchronization data stream can be secured using Secure Sockets Layer (SSL). To employ SSL 
security:

■ Make sure that a certificate has been created and installed on all Web servers that service 
handheld synchronization.

Use the following steps to install the root certificate on each handheld device.

 To install the root certificate on the handheld device running PPC 2003 or newer

1 Navigate to the certificate authority server from your desktop computer.

2 Select the first option (retrieve the CA certificate or certificate revocation list), and click Next.

3 Click on Download CA certificate. 

4 Click Save, and save as certca.cer on your desktop.

5 Use ActiveSync to copy the downloaded certificate, certca.cer, from the desktop to the My 
Documents folder on the handheld device. 

NOTE: Make sure the certca.cer file is copied into the My Documents folder. 

6 Go to My Documents and tap the certificate icon. 

The certificate should be installed. You can validate it by going to Settings > System > 
Certificate.

7 Click the Root tab.

You should see the new certificate on the list.

8 Open up a browser and run the following command, substituting the appropriate server name, 
application name, UserName and Password (in red below).

https://<SERVERNAME>/<APPLICATION NAME>/
start.swe?SWEExtSource=siebelpda&SWEExtCmd=ExecuteLogin&UserName=<USER 
LOGIN>&Password=<PASSWORD> 

9 When a dialog appears, click Yes.

To complete root certificate installation on PPC 2002 device

1 From a web browser, navigate to the Microsoft Web site and download and launch the following 
executable file:

AddRootCert.exe.

2 Double-click to open the executable file. 

A list of certificates appears. 
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3 Select certca.cer. 

Information for the certca.cer Certificate appears.

4 Click Install Certificate. 

5 Following successful installation, click OK. 

Process of Installing the Siebel 
Handheld Application
Before you deploy the Siebel Handheld application, there are several tasks you need to perform. 

NOTE: If you are setting up your Siebel Handheld application to allow end user translation 
functionality, see “Installing and Setting Up End User Translation Functionality” on page 31.

This process includes the following tasks:

■ “Editing the Handheld Application Installation Configuration File” on page 102

■ “Enabling Handheld User Database Backup” on page 105

■ “Deploying Patches to the Handheld Application with Direct Server Sync” on page 109

■ “Deploying Handheld Application Patches with Companion Sync” on page 110

■ “Creating Handheld Application Upgrade Kits for Companion Sync PDA” on page 111

■ “Downloading Patches to the Handheld Device” on page 112

Editing the Handheld Application Installation 
Configuration File
The Siebel Handheld application setup.ini file configures the Siebel Handheld Client application 
installer. Before you deploy a custom-configured Siebel Handheld application, you must update the 
parameters in the setup.ini file so that the correct values are written to the device registry before 
distributing the client installer to end users.

The setup.ini file resides in the Siebel Handheld application directory. To modify this file, create a 
Siebel Handheld installation directory on the network, or create and duplicate a custom DVD-ROM 
for distribution to end users. This installation directory must include the same files and directory 
structure as the original DVD-ROM. Then, modify the setup.ini file in the custom installation 
directory.

NOTE: If you wish to set up parameter values other than default values, add the parameter to the 
setup.ini file and add the proper values.
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Table 27 lists the parameters that you may need to modify in the setup.ini file, their default value, 
and a description of the parameter.

Table 27. Siebel Handheld setup.ini Parameters

Parameter Default Value Description

Version 7.8 Version of the desktop Siebel application 
against which the Siebel Handheld version 
synchronizes.

Application Title Siebel 
PharmaCE

The Siebel Handheld application. This value 
must match the name of the application as it 
is specified in Siebel Tools.

ApplicationName Siebel Pharma 
CE

The Siebel Handheld application. This value 
must match the name of the application as it 
is specified in Siebel Tools. 

ApplicationSplashText Pharma CE 
Handheld

The Siebel Handheld application name as 
shown on the splash screen.

EnableRemote N Used for Integrated Sync. The default value is 
"N". Valid values are "Y" = [Enable Remote 
Sync] checkbox is selected, "N" =  [Enable 
Remote Sync] checkbox is unselected in 
handheld sync window.

MultiCurrency True Required for the application to handle 
multiple currencies.

SyncURL http://Web 
Server Name or 
IP address/
Virtual Directory 
Name

Required for all synchronization methods. 
This value is entered in the registry on the 
handheld. See “Changing the SyncURL on 
Siebel Handheld Devices” on page 108 for 
more information on this parameter.

[EndUserLocalization] Section

User DefinedLang Y

LogUserDefinedLangErrors N

[Printing] Section See Appendix F, “Print Configuration Settings,” 
for more information on the parameters used 
to configure printing.

[Backup] Section Enables handheld database backups.

See “Enabling Database Backup” on page 106 
for more information on settings for the 
parameters in this section of the setup.ini 
file.
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[ApplicationLocation] Section Specifies where the Siebel Handheld 
application and database are installed.

See “Setting Up Siebel Handheld Application 
Installation on a CompactFlash Card” on 
page 107 for more information on the 
parameters in this section of the setup.ini 
file.

InternetOptionReceiveTimeout 600000 Length of time to receive data (except data 
extraction) from the server before the 
handheld client times out. This parameter 
only applies to synchronizations using Direct 
Server Sync.

In milliseconds. The default value, 600000, is 
10 minutes.

InternetOptionSendTimeout 600000 Length of time to send data to the server in a 
single call the handheld client times out. This 
parameter only applies to synchronizations 
using Direct Server Sync.

In milliseconds. The default value, 600000, is 
10 minutes.

InternetOptionDataExtractionTi
meout

900000 Length of time to extract data from the 
server to the handheld device the handheld 
client times out. This parameter only applies 
to synchronizations using Direct Server Sync.

[Logging] Section

TXNErrorLevel 1 This level controls the extent of transaction 
error information received from the server. 
The default value is 1. Valid values are 0 = no 
log information, 1 = report txn errors in the 
client log, txnerror.hh. A “Transaction Errors 
Reported” message appears during sync 
when txn errors occur. To view errors, double 
click the message.

Table 27. Siebel Handheld setup.ini Parameters

Parameter Default Value Description
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Enabling Handheld User Database Backup 
Siebel Handheld infrastructure provides a way to automatically back up a snapshot of the user’s 
database and current settings, and to restore those settings in the event of a total device failure. 
The backup functionality automatically copies all the necessary files to a single compressed file. Each 
time the user backs up, the backup process creates a new copy of the file and deletes older backups. 
The backup process must close the application in order to copy the RDBMS and handheld 
configuration files. After the files are copied, it automatically restarts the application.

DefaultLogLevel 2 The default value is 2. You can set the value 
to any of the following:

-1 = NO LOGGING

0 = LOG_SYSTEM

1 = LOG_ERROR

2 = LOG_WARNING

3 = LOG_INFO, INCLUDING SQL TRACING

4 = LOG_DEBUG

The log messages with level equal to or lower 
than the set value will be logged. For 
example, if the default log level is set to 2, 
the messages belonging to System, Error, 
and Warning log levels will be logged. If the 
DefaultLogLevel is -1, no logging will be 
provided.

MaxLogFileSize 2000 This is the maximum log file size in KB. If the 
program finds the size of the latest log file is 
greater than this value, a new log file should 
be used for logging.

MaxSavedLogFiles 3 Determines the number of log files to save on 
the device. It does not include the one 
currently used by the program. If the value is 
set to 2, then the valid log file names are 
siebel_log.txt, Siebel_log1.txt, and 
siebel_log2.txt. Siebel_log.txt is the current 
log file. Siebel_log1 is an older one and 
Siebel_log2 is the oldest.

PressureThreshold 29 Prompts user to restart application after 30 
visits, thereby freeing application memory.

Table 27. Siebel Handheld setup.ini Parameters

Parameter Default Value Description
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The backup feature must be enabled in the application. If the backup feature is enabled, a backup 
is created during every synchronization. This way, the user retains an up-to-date snapshot of the 
database, and older backup versions are removed.

When the database backup feature is enabled, a database backup occurs automatically at the end of 
each synchronization. This makes the overall time to synchronize somewhat longer. The size of the 
database and the speed of the CompactFlash card also affect the time it takes to complete 
synchronization.

NOTE: Backups should not be used as a replacement for synchronization.

Setting Up Database Backups
In order to back up the database you must do the following:

■ Provide users with an external memory card.

■ Install the Siebel Handheld application with the backup functionality enabled. See, “Enabling 
Database Backup” on page 106.

■ Instruct users to back up their database on a regular basis.

Backing Up to External Media
It is recommended that you back up to external media—for example, a CompactFlash card or the 
embedded backup storage that is included in many devices.

Enabling Database Backup 
Before users can back up the database on their handheld devices, you must first enable the Backup 
menu item on the Siebel Handheld application. This requires editing the setup.ini file to enable 
backup.

NOTE: Backup should be kept on external media or built-in storage. Trying to set the location to the 
main memory, such as \My Documents, will not work.

The following is an example of the default settings for the backup parameters:

[Backup]
BackupLocation = \Storage Card\Siebel Backup
BackupEnabled = N

■ BackupEnabled = [Y/N] The default is N (No). Change this setting to Y (Yes) to enable the Backup 
menu item and to trigger a backup to occur automatically after each synchronization.

If the product is installed with Backup = N, the backup menu item is disabled. You need to change 
the parameter, then reinstall the product in order to enable the menu item.

■ BackupLocation = [Backup location] The default is an external storage card. Specify the location 
where you want the data backed up.

For more information on the setup.ini file, see Chapter 8, “Installing the Handheld Application.”
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Restoring from a Backup
For information on restoring a database from a backup, see “Backing Up and Restoring Data with the 
Siebel Handheld Client” on page 133.

Installing Print Templates in the Siebel 
Handheld Install Directory
If your application allows printing, you must include all print templates in the template subdirectory 
of the Siebel Handheld Install directory. The print templates are language-specific, so copy the 
templates to the template subdirectory within the language directory of the language you are 
deploying (for example, ...\ENU\Template). If the template includes double byte characters, such as 
Japanese string, you must save the template files as Unicode (UTF16) files. For supported language 
codes, see System Requirements and Supported Platforms on Siebel SupportWeb. 

See Appendix F, “Print Configuration Settings” for more information about Printing.

Setting Up Siebel Handheld Application 
Installation on a CompactFlash Card
The default, when installing Siebel Handheld applications, is to install both the application and the 
database into RAM on the device. In most instances, there is sufficient available memory, and end 
users are satisfied with the application performance. There are situations, however, where you may 
need to optimize storage on the device.

If you need to maximize main memory availability, you can install the application binary files on an 
external location such as a CompactFlash card. Installing the data on the CompactFlash card is not 
recommended because performance likely degrades.

You can specify, in the application’s setup.ini file, where the application files and database files are 
to be installed. By default, this is set to the handheld device. In the ApplicationLocation section of 
the setup.ini file, there are two parameters. The following shows the default settings for these 
parameters:

[ApplicationLocation]
ApplicationBinariesLocation = Device
ApplicationDataLocation = Device

■ ApplicationBinariesLocation = Device. The default is Device. The other value is CF 
(CompactFlash).

■ ApplicationDataLocation = Device. The default is Device. It is recommended that you always 
install the data files on the device.

After you have edited the setup.ini file, follow the instructions for installing the Siebel Handheld 
application on the client.
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Changing the SyncURL on Siebel 
Handheld Devices
For Direct Server Sync (DSS), SyncURL is used to locate the Web Server and the virtual directory so 
that the handheld synchronization client can communicate with the handheld synchronization server. 
For example:

SyncURL = http://web server name or IP address/virtual directory name

You can reset the SyncURL by re-installing the application with the updated setup.ini file.

For Companion Sync set up, the SyncURL parameter identifies the configuration file that will be 
accessed on the handheld client for synchronization. 

For example, the default configuration file for Pharma Handheld is named phce.cfg. For companion 
sync set up, the SyncURL value should be http://xxxx/phce where xxxx could be any text string.

Installing the Siebel Handheld 
Application from External Media
Users who synchronize in DSS mode may not have a PC, and so may not be able to create a 
partnership and synchronize using Microsoft ActiveSync. You can install the application for each user 
through a standard partnership, or you can configure a stand-alone installer.

During the installation, the InstallShield Wizard screen prompts you by asking, 

Would you like to deploy a CAB file to enable rapid installation for additional 
devices? 

You can configure a stand-alone installer by selecting Yes.

You are prompted to select a language for the application and to specify a location for the CAB file. 
The installer creates the CAB file in the location you specify.

The CAB file is a self-extracting file that includes all the files needed to install the Siebel Handheld 
application on the handheld device. When you single-click the file, the CAB file installs the 
application.

You may create an image of the Handheld Installer that can be loaded onto external media such as 
a CompactFlash card. When you create a stand-alone installer platform, a Cabinet file (CAB) is 
created in a location that you specify. The CAB file name should be siebel.pocketpc_arm.CAB. You 
can copy the CAB file to a CompactFlash card, insert the card into the handheld device, and single-
click on the file to install the Siebel Handheld application on the device.

NOTE: When installing the application on the device, the end user is asked if he or she wants to 
install the application in the default directory. Regardless of the user's answer, the application is 
always installed in the directory specified by the setup.ini file. Therefore, the only way to change the 
directory the application is installed in is to modify the parameters in the ApplicationLocation section 
of the setup.ini file.
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Distributing Siebel Handheld Application 
Patches
The Siebel Handheld patch delivery mechanism, PatchAgent, is a tool that automates the deployment 
of patches to handheld devices as part of the synchronization process. It allows administrators to 
distribute patches to end users with minimal involvement by the users.

During synchronization the PatchAgent executable is called, and if it detects a handheld patch, it 
automatically installs the patch on the handheld device. In order for PatchAgent to detect and deploy 
the patch, the patch files must be created and placed in the directory where PatchAgent expects to 
find the files.

Deploying Patches to the Handheld Application with 
Direct Server Sync
In order to set up patch deployment for Direct Server Sync users, you need to patch the Siebel server 
and patch one handheld client which serves as the “model” from which patch files are pulled. Then 
the patch files are then packaged and placed in the location on the server where PatchAgent expects 
to find the files. The next time the end user synchronizes with Siebel server, the patch is installed 
onto his or her device. 

For more information on how the patch process works with synchronization, see “Downloading 
Patches to the Handheld Device” on page 112.

To set up patch deployment

1 On Siebel server, verify that the following directories exist. If they do not, create the directories.

■ C:\patch\AppBinDir

■ C:\patch\WinDir

NOTE: You may specify a drive other than C:. However, the directory names must be specified 
as shown above.

2 Apply the patch to Siebel server.

3 Apply the patch to one handheld client.

4 Examine the handheld directory (My Device\Program Files\Siebel Handheld) and copy the files 
with the latest date to the Siebel Server directory (C:\patch\AppBinDir).

5 Examine the handheld directory (My Device\Windows) and copy the files with the latest 
timestamp to the Siebel Server directory (C:\patch\WinDir). 

6 From the DOS prompt, change directory to Siebel Root\SWEApp\BIN.

7 Execute the following command to stage the patch files and the patchlist.txt in the correct 
location on the server:
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C:\Siebel Root\SWEApp\BIN>createpatchlist /s c:\patch /t c:\Siebel 
Root\sweapp\cepatch

/s – source directory. The directory where the patch files were moved.

/t – target directory. The directory where PatchAgent checks for the patch files.

NOTE: You may specify a drive other than C:. However, the location of the source and target 
directories must be specified exactly as shown.

After the patch files have been moved and the patch list created, the following message appears: 
“Patch List has been successfully created in Siebel Root\SWEApp\cepatch files transferred 
successfully.”

The patch files are now ready to be deployed to Direct Server Sync end users. 

Deploying Handheld Application Patches with 
Companion Sync
In order to set up patch deployment for Companion Sync users, you need to create a “model” of a 
patched Siebel Mobile Web Client and a patched handheld client. Then you pull the designated patch 
files and place them in the correct directory on the end user’s Mobile Web Client. You may use Siebel 
Anywhere to create upgrade kits to automate this process of distributing patch files to your end 
user's Mobile Web Client. The next time the end user uses Companion Sync to synchronize their 
handheld device with the Siebel Mobile Web Client, the patch is installed on the device. 

For more information on how the patch process works with synchronization, see “Downloading 
Patches to the Handheld Device” on page 112.

To set up patch deployment

1 On Siebel server, verify that the following directories exist. If they do not, create the directories.

■ C:\patch\AppBinDir

■ C:\patch\WinDir

2 Apply the patch to Siebel server.

3 Apply the patch to Siebel Mobile Web Client.

This Mobile Web Client serves as the model from which the patch files can be pulled.

4 Apply the patch to one handheld client.

This handheld client serves as the model from which the patch files can be pulled.

5 Examine the handheld directory (My Device\Program Files\Siebel Handheld) and copy the files 
with the latest date to the Siebel Server directory (C:\patch\AppBinDir).

6 Examine the handheld directory (My Device\Windows) and copy the files with the latest 
timestamp to the Siebel Server directory (C:\patch\WinDir).

7 From the DOS prompt, change directory to C:\Siebel Root\SWEApp\BIN.
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8 Execute the following command to move the patch files to the correct location and generate a 
patchlist.txt file:

C:\Siebel Root\SWEApp\BIN>createpatchlist /s c:\patch /t c:\Siebel 
Root\sweapp\cepatch_xxx (where xxx is the language [enu, esn, and so on])

/s – source directory. The directory where the patch files were moved.

/t – target directory. The directory where PatchAgent checks for the patch files.

NOTE: You may specify a drive other than C:. However, the location of the source and target 
directories must be specified exactly as shown.

After the patch files have been moved and the patch list created, the following message appears: 
“Patch List has been successfully created in Siebel Root\SWEApp\cepatch_xxx files transferred 
successfully.”

9 Create the following directory on the end user’s Mobile Web Client: Siebel 
Root\client\cepatch_xxx (where xxx is the language [enu, esn, and so on]), and push the files 
from the \Siebel Root\SWEApp\cepatch_xxx directory on Siebel server to the Siebel 
Root\client\cepatch_xxx on the Mobile Web Client.

NOTE: Siebel Anywhere upgrade kits can be used to carry out this step.

Creating Handheld Application Upgrade Kits for 
Companion Sync PDA
NOTE: This step is optional. Additionally, you must have a license for Siebel Anywhere to distribute 
patches to end users.

You may use Siebel Anywhere upgrade kits to remotely distribute self-extracting zip files to your end 
users’ PCs. You can use self-extracting zip files to create new directories and immediately extract 
files into the directories. Create one upgrade kit for each of the following:

■ Create the Siebel Mobile Web Client upgrade kit (Siebel Client Revisions). 

Navigate to the Siebel image location for the current software version such as D:/
Siebel_Install_Image/7.8.1.0, and then navigate to the patch directory. Configure the zip file to 
self-extract in the Siebel Root\client\BIN directory on the end user’s Mobile Web Client.

■ Create the Siebel Handheld upgrade kit (Siebel Client Revisions).

Create a self-extracting zip file that includes the files in the Siebel Root\SWEApp\cepatch 
directory on the server. Configure the zip file to self-extract in the \client\cepatch directory on 
the end user’s Mobile Web Client.

■ Create any other upgrade kits as needed (for example, the Siebel Customer Repository File).

See Siebel Anywhere Administration Guide for detailed information on creating upgrade kits.

NOTE: If there are read-only files on the Mobile Web Client, the end user may need to change the 
file attributes to read-write before receiving and installing the upgrade kits. Contact Siebel Technical 
Support for the list of files whose attributes need to be changed. You may use Siebel Anywhere to 
distribute a batch script that makes this change.
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Downloading Patches to the Handheld Device
Patches are downloaded as part of the synchronization process. Once the patch is staged, the patch 
is downloaded the next time the end user synchronizes the handheld with Siebel server. The end user 
synchronizes as he normally would using Direct Server Sync or Companion Sync. First, any 
transactions are uploaded from the handheld device. Then:

■ If a patch needs to be applied to the handheld, the synchronization process terminates, and the 
patch process is started, which downloads the patch.

■ If no patch needs to be applied, the synchronization process continues until the process is 
complete.

After a successful patch installation, Siebel Handheld Sync will launch automatically and continue the 
extraction. 

If the patch files are not successfully downloaded, the end user is prompted to restart the patch 
process. The end user must locate and launch patchagent.exe manually. Then, once the patch is 
successfully installed, the end user is prompted to complete the synchronization.
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7 Synchronization Conflict 
Handling and Recovery with 
Handheld
This chapter includes the following topics:

■ “Preventing Synchronization Transaction Conflicts with Siebel Handheld” on page 113

■ “Recovering Error Data in Siebel Handheld” on page 119

Preventing Synchronization Transaction 
Conflicts with Siebel Handheld
When multiple end users synchronize with a remote database, transaction conflicts may occur which 
can result in data loss. The Extended Pick and Insert Failure functionality minimizes synchronization 
conflicts. If transaction conflicts are unavoidable, then Siebel Handheld Sync Service captures the 
transaction information so that the data can be recovered. The combination of these features 
eliminates the potential for data loss.

There are two features that minimize synchronization transaction conflicts.

■ Extended Pick processing

■ Insert Failure processing

The next several sections describe these features in detail.

Extended Pick Processing in Siebel Handheld
The handheld is used to capture and record transactions entered by the handheld user. During 
synchronization, these transactions are processed on the server. A situation may arise in which a 
transaction fails when it is applied to the Siebel server (through Direct Server Sync) or Siebel Mobile 
Web Client (through Companion Sync)—both of which are referred to as server. For example, a Siebel 
Pharma Handheld user creates a professional call activity for one of his contacts. However, since he 
last synchronized with the server, the contact involved in this transaction was deleted from the server 
database. When he tries to synchronize his handheld, the server does not find his contact, and the 
call activity for the contact cannot be inserted into the server database. To generalize this example, 
any transaction that involves data selected through picklists or pick applets fails on the server if that 
pick data is not present at the time of synchronization.

With many handheld users synchronizing with Siebel server and modifying data at different times, 
this scenario is not uncommon.
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The following describes how a pick transaction is recorded on the handheld device and processed on 
the server during synchronization. Assume that the handheld user wants to create a new call activity 
for the contact. In order to do this, the user inserts a new record in the Professional Call screen and 
“picks” the desired contact. When the contact is selected on the handheld, the Row Id of the contact 
(Contact Id) is recorded. However, on the handheld, the application does not record any of the pick 
map fields associated with the contact; only the Contact Id is recorded. When the user synchronizes 
his handheld, that Contact Id is used to locate the contact record in the server database. The Contact 
Id is then used to retrieve all of the fields used in the pick map for the Contact Id (Last Name, First 
Name, Middle Initial, Address, City, State, Zip Code, and so on).

In order to minimize pick processing failures, the handheld must record the pick row Id and all of 
the pick map data that is required for a successful transaction. This data must be recorded at the 
time of the pick, so that it can be passed to the server for processing. This enhanced functionality is 
called Extended Pick processing. Now, when the user synchronizes, the transaction is processed on 
the server as follows:

■ The synchronization process first looks for the pick record on the server database. For example, 
to add an activity it looks for the contact and, if it finds the contact, it retrieves the necessary 
data and adds the activity. This is the default behavior. 

■ If the server does not find the pick map record in the database and extended pick processing is 
enabled, it retrieves the pick record Id and pick map data from the handheld transaction and 
applies the data directly to the server.

Enabling Extended Pick Processing in Siebel Handheld
You can enable Extended Pick processing globally or at the business component level when 
configuring the Siebel Handheld application. When the DefaultHandheldSyncPickMode parameter is 
enabled every handheld pick transaction is subject to pick processing.

To enable extended pick processing globally

1 From the application-level menu, choose Navigate > Site Map > Administration-Mobile > 
Application Administration.
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2 Click the Settings view tab, then Query on the following value:

DefaultHandheldSyncPickMode

If there is no such record, a new record with that value should be created. See Table 28 for the 
values to enter. 

To enable extended pick processing at the business component level
■ When enabling extended pick processing at the business component level, the user property is 

defined on specific business components. The syntax for setting Extended Pick on a business 
component and the parameter values (Table 29) follow:

HandheldSyncPickMode=Fieldname|Mode

You may apply Extended Pick processing to multiple fields in a single business component, using 
the following syntax:

HandheldSyncPickMode=Fieldname1|Mode1, Fieldname2|Mode2

The setting on the business component takes precedence over the setting defined in the Settings 
view. For example, you can use the business component setting to nullify the global application 
of Extended Pick. Conversely, you can enable Extended Pick processing on specific business 
components if the setting in the Settings view has disabled the functionality.

For more information, see Using Siebel Tools.

Table 30 shows the combined effect of the settings in the Application-Mobile > Settings View and on 
a business component.

■ The DefaultHandheldSyncPickMode setting is omitted from application settings. 

Table 28. Application Settings

Setting Name Value Description

DefaultHandheldSyncPickMode NoFail Turns Extended Pick processing ON.

FailOnError Turns Extended Pick processing OFF 
This is the default behavior if the 
parameter is not specified in the 
Settings view.

Table 29. Business Component User Property Parameters

Business Component 
User Property Parameter Value Description

HandheldSyncPickMode Fieldname — Specify the field name as defined in 
Siebel Tools.

Mode NoFail Turns Extended Pick processing ON.

FailOnError Turns Extended Pick processing OFF.
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■ If there is no setting on a particular business component, the setting defined in the Settings view 
applies.

■ If there is no setting defined in the Settings view, or on the business component, the default 
behavior is for Extended Pick to be turned OFF.

In Table 30, read down the Tools configuration column and across to the Mobile Administration View 
Setting to see the combined result. For example, a NoFail configuration in Tools combined with a 
FailOnError setting in the Mobile Administration View results in the combined effect NoFail.

Recommended Extended Pick Processing Settings
It is recommended that you use the Extended Pick processing settings in the following way:

■ Pharma Professional Call - CE. Last Name|NoFail, Address|NoFail, Contact Id|NoFail, 
Contact Address Id|NoFail

■ Pharma Call Products Detailed - CE. Name|NoFail

■ Pharma Call Sample Dropped - CE. Name|NoFail, Lot Name|NoFail

■ Pharma Account Call - CE. Account Name|NoFail, Address|NoFail, Account Id|NoFail, 
Account Address Id|NoFail

■ Pharma Promotional Items Dropped - CE (Name). Name|NoFail

The Pharma Handheld application is shipped with these recommended settings.

Insert Failure Processing in Siebel Handheld
When the server executes an insert transaction and the insert fails, there are two ways the insert 
failure can be handled:

■ A record is logged that indicates the insert failed, and synchronization continues. This is the 
default insert behavior. The Conflict Administration screen can be used to recover the data.

Table 30. Combined Effect of Extended Pick Settings for Business Components

Tools Configuration (User 
Property)

HandheldSyncPickMode=

Mobile Administration View Settings

DefaultHandheldSyncPickMode=

NoFail FailOnError Omitted 

NoFail NoFail NoFail NoFail

FailOnError FailOnError FailOnError FailOnError

Omitted NoFail FailOnError FailOnError
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■ The insert failure is logged, including details of the failure, and synchronization is interrupted. 
This is the FailOnError behavior. FailOnErrore behavior guarantees that, should an insert fail, data 
loss does not occur since synchronization is stopped until the circumstances causing the failure 
are resolved.

NOTE: If FailOnError processing takes place, synchronization is interrupted. The synchronization 
process continues to fail until the problem is resolved. End users must contact their system 
administrators to recover from the failure. The recovery effort may involve modifying transactions 
queued for processing, modifying data on the server, or reentering transactions through the Siebel 
Handheld application.

Handling Insert Failures
You can enable Extended Pick processing globally or at the business component level when 
configuring the Siebel Handheld application. The following setting applies globally throughout the 
application. When FailOnError is specified, every failed insert interrupts synchronization.

DefaultHandheldInsertMode.

You can specify the value for this setting through the Settings view in the Administration-Mobile 
screen.

Table 31 shows the settings for this parameter.

Optionally, you can enable Extended Pick processing at the business component level.

HandheldInsertFailMode=Mode

Table 31.  Insert Failure Processing Parameter Setting

 Parameter
Mode 
Value Description

DefaultHandheldInsertMode NoFail Insert failures are logged and synchronization 
continues. This is the default behavior.

FailOnError Insert failures are logged and synchronization 
terminates. The system administrator must 
intercede to recover from this failure.
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The user property is defined on specific business components. The setting in the business component 
takes precedence over the setting defined in the Settings view. Table 32 shows the syntax for setting 
the Insert Fail Mode on a business component and the parameter values. These settings are made 
in Siebel Tools. 

Table 33 shows the combined effect of the setting in the Settings view and the setting on a business 
component.

■ The business component setting always takes precedence over the settings defined in the 
Administration-Mobile > Settings view. 

■ If there is no setting on a particular business component, the Applications Settings value applies.

■ If there is no setting in either the Settings view or on the business component, the default 
behavior is the same as NoFail. Insert failures are logged and synchronization continues.

In Table 33, read down the Tools Configuration column and across to the application settings value 
to see the combined result. For example, a NoFail BC setting combined with a FailOnError application 
setting results in the combined effect NoFail.

Table 32. Business Component User Property Parameter

Business Component 
User Property Parameter Value Description

HandheldInsertFailMode Mode NoFail Insert failures are logged and 
synchronization continues. This is the 
default behavior.

FailOnErr
or

Insert failures are logged and 
synchronization terminates. The system 
administrator must intercede to recover 
from this failure.

Table 33. Combined Effect of Insert Failure Settings

Tools Configuration (User 
Property)

HandheldInsertFailMode=

Application Settings Value

DefaultHandheldInsertMode=

NoFail FailOnError Omitted

NoFail NoFail NoFail NoFail

FailOnError FailOnError FailOnError FailOnError

No Setting on Business 
Component

NoFail FailOnError NoFail
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Recommended Insert Failure Processing Settings
It is recommended that you use the insert failure processing settings in the following way:

Recovering Error Data in Siebel 
Handheld 
Selected synchronization and conflict errors are captured to the database, and can be accessed 
through the Conflict Administration screens. This mechanism is always enabled. For more 
information on recovering error data, see “Obtaining Error Details from Siebel Handheld 
Synchronization Sessions” on page 67.
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8 Installing the Handheld 
Application
This chapter includes the following topics:

■ “Preparing to Upgrade from a Previous Siebel Handheld Release” on page 121

■ “Installing the Siebel Handheld Application” on page 121

■ “Reinstalling the Siebel Handheld Application” on page 124

■ “Uninstalling the Siebel Handheld Application” on page 124

Preparing to Upgrade from a Previous 
Siebel Handheld Release
The Siebel Handheld application cannot be upgraded directly on the device. To upgrade your existing 
application and to migrate your data and settings to Siebel 7.8 use the following process:

■ Back up the handheld device by synchronizing to your database. See, “Synchronizing Data on the 
Siebel Handheld Device” on page 135.

■ Uninstall your Siebel Handheld application. See, “Uninstalling the Siebel Handheld Application” on 
page 124.

■ Then install the new version of your Siebel Handheld application. See “Installing the Siebel 
Handheld Application” on page 121.

Installing the Siebel Handheld 
Application
There are two ways to install software onto any Windows-powered handheld device. The first is to 
create a partnership between a desktop or laptop PC and the handheld device using Microsoft 
ActiveSync. The second is to install the application from type of external media.

NOTE: It is important to remember that end users must synchronize their handheld devices to 
download the application configuration and populate the database before they can use the 
application. Therefore, an administrator may install the application for an end user, but the 
synchronization must occur using the end user’s name and password.

Installing Handheld for Companion Sync Users
The following procedure lists the Handheld installation steps for Companion Sync users:
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To install the Siebel Handheld application using Companion Sync

1 Using Microsoft ActiveSync, establish a partnership between the handheld device and the PC.

2 On the PC network or DVD-ROM, locate the folder where the Siebel Handheld Application folder 
is installed, then double-click setup.exe.

The installation process begins.

3 From the Choose Setup Language window, choose the language you want to use for the 
installation and click OK.

4 At the Synchronization Options screen, choose the Companion Sync option and then click Next.

The next screen displays and asks, “Would you like to deploy a CAB file to enable rapid 
installation for additional devices?”

NOTE: If you want to create a stand-alone installer, choose Yes, and then click Next. 

5 To install the application on the device, click Next.

6 Select the desired language of the Siebel Handheld Application, and click Next.

A window appears showing the setup status, followed by several DOS windows.

7 The Add/Remove Programs dialog appears. This is followed by the Installing Applications dialog 
that asks if you want to install in the default directory. Click Yes to install the Siebel Handheld 
application on the handheld device.

NOTE: The default directory in the Applications dialog is the directory specified by the system 
administrator in a setup file. So that the application works correctly, the Siebel Installer installs 
the application in the default directory. Therefore, even if you specify a different location for the 
application, the application is installed in the default location.

During the installation, the Installing Applications dialog box displays a progress bar. It may take 
several minutes to install on the handheld device. When the application has been downloaded to 
the handheld device, the Application Downloading Complete dialog box displays on the PC.

8 Click OK.

A window appears informing you that setup has finished installing the Siebel Handheld 
application on your computer.

9 Click Finish.

After installing the Siebel Handheld application and Siebel Handheld Sync, you must perform an 
initial synchronization before the application can be used. Refer to “Synchronizing Data on the Siebel 
Handheld Device” on page 135 for the procedure for synchronizing your data.

See Chapter 5, “Data Filtering,” for more information on using Direct Server Sync and setting filters.
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Installing Handheld for Direct Server Sync Users
Most DSS users do not have access to a PC for creating a partnership with their handheld device. In 
this case, the administrator has to create a temporary partnership with each user's device and install 
the application. Siebel Handheld applications can be installed in DSS mode using the Siebel Installer 
as described in this section.

To install the Siebel Handheld application using DSS

1 Using Microsoft ActiveSync, establish a partnership between the handheld device and the PC.

2 On the PC network or DVD-ROM, locate the folder where the Siebel Handheld Application folder 
is installed, then double-click setup.exe.

The installation process begins.

3 From the Choose Setup Language window, choose the language you want to use for the 
installation and click OK.

4 At the Synchronization Options screen, choose the Direct Server Sync option and then click Next.

The next screen displays and asks, “Would you like to deploy a CAB file to enable rapid 
installation for additional devices?”

NOTE: If you want to create a stand-alone installer, choose Yes, and then click Next.

5 To install the application on the device, click Next.

6 Select the desired language of the Siebel Handheld Application, and click Next.

A window appears showing the setup status, followed by several DOS windows.

7 The Add/Remove Programs dialog appears. This is followed by the Installing Applications dialog 
that asks if you want to install in the default directory. Click Yes to install the Siebel Handheld 
application on the handheld device.

NOTE: The default directory in the Applications dialog is the directory specified by the system 
administrator in a setup file. So that the application works correctly, the Siebel Installer installs 
the application in the default directory. Therefore, even if you specify a different location for the 
application, the application is installed in the default location.

The Siebel Handheld installation automatically installs SSCE Service Pack 1 and overwrites 
existing files on your system. A message may appear asking if you want to replace existing files. 
Respond by tapping “Yes to All.”

During the installation, the Installing Applications dialog box displays a progress bar. It may take 
several minutes to install on the handheld device. When the application has been downloaded to 
the handheld device, the Application Downloading Complete dialog box displays on the PC.

8 Click OK.

A window appears informing you that setup has finished installing the Siebel Handheld 
application on your computer.

9 Click Finish.
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After installing the Siebel Handheld application and Siebel Handheld Sync, you must perform an 
initial synchronization before the application can be used. Refer to “Synchronizing Data on the Siebel 
Handheld Device” on page 135 for the procedure for synchronizing your data.

See Chapter 5, “Data Filtering,” for more information on using Direct Server Sync and setting filters.

Reinstalling the Siebel Handheld 
Application
Follow the steps below to reinstall your Siebel Handheld application.

To reinstall the Siebel Handheld application

1 Before you reinstall the current application, you must first uninstall the current application on 
your device. See “Uninstalling the Siebel Handheld Application” on page 124 for more information.

2 Once you have uninstalled the application, you may then reinstall the application or install the 
newer version. See “Installing the Siebel Handheld Application” on page 121, and follow the 
instructions for installing the Siebel Handheld application.

3 Synchronize your Siebel Handheld application. See “Synchronizing Data on the Siebel Handheld 
Device” on page 135 and follow the instructions for synchronizing your data.

NOTE: If you are using Companion Sync to synchronize your data, synchronize the Siebel 
Handheld database with the Siebel Remote database.

Uninstalling the Siebel Handheld 
Application
Uninstalling the application deletes the database files as well as the application files.

CAUTION: Before you uninstall your application, you must synchronize your database to save any 
changes to your data since the last synchronization. If you do not synchronize before uninstalling, 
these changes will be lost. See “Synchronizing Data on the Siebel Handheld Device” on page 135 and 
follow the instructions for synchronizing your data.

To uninstall the Siebel Handheld application

1 Select Start > Settings.

2 Select the System tab and tap Remove Programs.

3 From Remove Programs, select the Siebel Handheld application and tap Remove.

NOTE: A dialog box appears saying that a file cannot be deleted. This occurs because a file may 
still reside in memory. Ignore this message and tap OK to delete all application and database 
files. No additional steps are required to remove the application and database files.
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9 Working with Siebel Handheld 
Applications
This chapter includes the following topics:

■ “Components of the Siebel Handheld Interface” on page 125

■ “Navigating the Siebel Handheld Interface” on page 128

■ “Navigating a List of Records in the Siebel Handheld Application” on page 128

■ “Entering Data with the Siebel Handheld Application” on page 130

■ “Finding and Querying Data in the Siebel Handheld Application” on page 130

■ “Printing with the Siebel Handheld Application” on page 132

■ “Exporting Data with the Siebel Handheld Application” on page 132

■ “Setting User Preferences in the Siebel Handheld Application” on page 133

■ “Backing Up and Restoring Data with the Siebel Handheld Client” on page 133

■ “Synchronizing Data on the Siebel Handheld Device” on page 135

■ “Synchronization Troubleshooting with the Siebel Handheld Client” on page 138

■ “Improving Siebel Handheld Application Performance” on page 139

Components of the Siebel Handheld 
Interface
The components of the handheld interface include the Screens menu, Show drop-down list, 
application-level menu, Queries drop-down list, toolbar, and status bar.
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Figure 5 shows the components of the Siebel Handheld application. 

Screens Menu
The screens menu is the first level of navigation in the Siebel Handheld application. When you launch 
the Siebel Handheld application for the first time, this tab is labeled Screens unless you have 
configured a start up view to appear. When you tap the screens menu, a drop-down list of all 
available screens appears. Tap the desired screen in the list to navigate to it. 

For information about configuring a start up view, see “Setting User Preferences in the Siebel Handheld 
Application” on page 133. 

Show Drop-Down List
The Show drop-down list is the second level of navigation in the Siebel Handheld application. This is 
where you choose views for the selected screen.

Application-Level Menu
The application–level menu consists of the File, Edit, View, and Help menus. Tap a menu to select a 
menu option. The options that are available in each menu vary depending on the task you are 
performing.

Figure 5. Siebel Handheld Screen Components

Screens menu

Application-
level menu

Show drop-down list

Toolbar

Queries drop-down list

New Record 
Button

Minimize button

Maximize Minimize Applet 
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Queries Drop-Down List
Up to two predefined queries, or business object filters are displayed in the Queries drop-down list. 
The list displays the query chosen when you synchronized (or the default filter if you did not change 
the Set Filters selection) and the All Records query, if it is defined. For more information, see 
Chapter 5, “Data Filtering.”

Siebel Toolbar
The Siebel toolbar has buttons for frequently used functionality like record navigation and querying. 
You can configure your toolbar and specify which buttons are displayed. See “Configuring User 
Interface Elements in Siebel Handheld” on page 25. 

■ Tap the New Record button to add a new record to the active list or form.

■ Tap the Back button to navigate to the previous view.

■ Tap the Forward button to navigate to the view you were in before you selected the Back button.

■ Tap the Record Navigation buttons to move through records in a form or a list.

■ Tap the New Query button to begin a new query in a form or a list.

■ Tap the Execute Query button to run the query you just created.

■ Tap the Maximize Minimize Applet button to expand the active applet so that it is the only applet 
displayed and takes up the entire screen display. This allows you to see more columns or more 
rows of data at one time. Tap again and the screen displays two applets.

Customizing the Toolbar
You can customize which buttons appear on your toolbar by selecting View > Customize Toolbar from 
the application menu.

To add and remove buttons from the toolbar, drag and drop the desired buttons between the Choose 
Toolbar Buttons dialog box and the toolbar.

Minimize Button
The Minimize button appears in the upper-right corner of your window. When you tap the Minimize 
button, the application minimizes, but does not close. To reopen the minimized application, from the 
Start menu, tap the Siebel Handheld icon. To close (exit) the application, choose File > Exit.

Do not confuse the Minimize button that appears in the upper right corner with the Maximize 
Minimize Applet button that appears on the Toolbar.

Status Bar
The status bar appears at the bottom of the application window. It provides information about the 
current view. 
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Navigating the Siebel Handheld 
Interface
Navigating the Siebel Handheld application is achieved through the screens menu, the Show drop-
down list, drilling down, drilling across, toolbar buttons, and toggling.

Screens Menu
The screens menu provides the first level of navigation. Here you select the screen you want to work 
in. For more information about the screens menu, see “Components of the Siebel Handheld Interface” 
on page 125.

Show Drop-Down List
The Show drop-down list is the second level of navigation. After you have selected a screen from the 
screens menu, select a view from the Show drop-down list. Views in the Show drop-down list are 
specific to each screen.

For example, in the Activities screen you can pick the My Activities view from the Show drop-down 
list.

Expandable Fields
Due to the limited screen size on the handheld, it is not always easy to view the data in a field without 
scrolling or resizing the field width. Therefore, some fields that could contain large amounts of text 
are expandable—that is, the data can be viewed in a text box. An ellipsis (...) appears in the field to 
indicate that the field is expandable. When you tap the ellipsis, a text box opens showing the data 
in that field. When you step off the field, the text box closes.

In form applets, an ellipsis is always visible in those fields that are expandable. However, in list 
applets, due to space constraints, the ellipsis is not always visible in expandable fields. When you 
tap on an expandable field in a list applet, the ellipsis appears. Once the ellipsis appears, you tap 
the ellipsis to open the text box.

URLs in Applet Fields
Tapping on a field that contains a URL value launches the URL in PocketIE.

Navigating a List of Records in the Siebel 
Handheld Application
Within the view you select from the Show drop-down list, you can view detailed information on a 
record. When records are displayed in a list, you can drill down or drill across the record to get 
additional details.
Siebel Pharma Handheld Guide Version 7.8128 



Working with Siebel Handheld Applications ■ Navigating a List of Records in the Siebel
Handheld Application
Drilling down occurs when you tap a hyperlink in a record and are taken to another view within the 
current screen. For example, if you are in the Accounts screen, and tap the Account Name hyperlink, 
you navigate to the details for that account. You do not leave the Accounts screen; you just move 
deeper into it.

NOTE: Hyperlinks are indicated by blue underlined text as long as they are set up this way in User 
Preferences. For more information see “Setting User Preferences in the Siebel Handheld Application” 
on page 133.

Drilling across a record occurs when you tap a hyperlink in a record and are taken to another view 
in a different screen. For example, tapping a hyperlink in the Accounts column of a contact record in 
the Contacts screen takes you to the record for that account in the Accounts screen.

Dynamic drilldown occurs when you tap a hyperlink in a record and are taken to another screen or 
just another view. Where you navigate to depends on the content in the drilldown field. For example, 
tapping a hyperlink in the Activity field in the Activities screen can take you to different places. If 
you tap an Account Call activity, you navigate to the Account Call screen. If you tap a Visit activity, 
you navigate to the Activities More Info view. 

History Arrows
To navigate back to views you have recently displayed, tap the Back button. After you have used the 
Back button, you can use the Forward button to navigate back to your original screen and view.

NOTE: The History arrows only allow you to navigate between views. These arrows do not allow you 
to recover data that may have been entered or deleted in another view.

Record Navigation Buttons
Use the Record Navigation buttons to move back and forth though a set of records. The navigation 
buttons are described in Table 34. 

Table 34. Record Navigation Buttons

Button Description

Navigates back to the previous record in the list or form.

Navigates forward to the next record in the list or form.

Navigates back a view based on the navigation history. You can define 
which views are part of the history. If a view is set to not be recorded 
as part of the history, the back button won't go back to that view.
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Entering Data with the Siebel Handheld 
Application
There are several different methods for entering data in the Siebel Handheld application. Tap the up 
arrow next to the Input Panel button to select a method. See the user guide for your device for 
information on using the different input methods.

Working with Columns in the Handheld Client
Data is displayed in lists and forms in your Siebel Handheld application. You can organize and work 
within it in a number of ways to better suit your needs.

There are several ways in which to organize columns in a list. You can:

■ Sort data by up to three columns

■ Resize columns

■ Change the order in which the columns appear

■ Show and hide columns

■ Lock columns for horizontal scrolling

You can sort records in a list by tapping in the column header of the column in which you want to 
sort the records. If the green column sort indicator points up, the column is sorted in ascending 
order. If it points down, the column is sorted in descending order.

If you need to sort by more than one column, you can open the Sort Order dialog box to sort up to 
three columns at one time. Open the Sort Order dialog box by choosing View > Advanced Sort from 
the application-level menu.

Resize columns by tapping and dragging the divider between the column headings until the column 
is the desired size.

You can change the order of columns using the Columns Displayed dialog box. Open the Columns 
Displayed dialog box by choosing View > Columns Displayed.

Show and hide columns using the Columns Displayed dialog box. In the Available columns list, select 
the items you want to show and tap the arrow to move the selected items to the Selected columns 
list. To hide columns, select the items and tap the arrow to move the selected items to the Available 
columns list.

Lock or unlock columns by tapping and holding the column header.

Finding and Querying Data in the Siebel 
Handheld Application
You can search for data using the Find or Query functionality in your Siebel Handheld application.
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About Find in Handheld
Use Find to do a simple search for a record. You can access Find by choosing Edit > Find View > Find 
from the application-level menu. This launches the Find dialog box, in which you can enter your 
search criteria. The asterisk wildcard function (*) can be used in the search criteria. Figure 6 shows 
an example of the Find dialog window with the following fields: Look In, Last Name, Type, Last Call 
Date, Primary Specialty, and Rep Specialty.

NOTE: There may be a slight variation in your version of Siebel software, and the Find dialog box 
may not look exactly as shown here. 

About Queries in Handheld
Use Query to locate a number of records containing a specific set of criteria. There are a number of 
ways in which to perform query tasks in your Siebel Handheld application.

Creating a Query
To begin a query, you can choose Edit > Query > Newfrom the application-level menu, or you can 
tap the New Query button on the toolbar. Both provide you with a blank form or list where you can 
enter your query criteria, depending on where you are in the application when you invoke the 
command. The asterisk wild card function (*) can be used in the search criteria.

Executing a Query
After you have created the query, you can execute it by choosing Edit > Query > Runfrom the 
application-level menu or by tapping the Execute Query button in the toolbar.

Refining a Query
You can refine your current query by choosing Edit > Query > Refine from the application-level menu.

Figure 6. Find Dialog Box
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Printing with the Siebel Handheld 
Application
You may print from any view in the Siebel Handheld application that has been configured to support 
printing. When you print from the handheld, a document that has been configured for the view is 
printed. You can print directly to a printer, or, if you are not connected to a printer at the time, you 
can queue your print jobs and wait until you have access to a printer to print your documents.

NOTE: When you print from a view, you are not necessarily printing what is visible on the screen at 
the time. Every field on the screen may not be relevant for the document. The document may contain 
only a portion of what is in the view, and it may also contain data that is not viewable at the time. 
A separate applet, which often cannot be viewed in the user interface, is configured specifically for 
printing.

The print templates used to generate the printed are installed during the time of setup.

For a list of supported printers, see System Requirements and Supported Platforms on Siebel 
SupportWeb.

Print from the Siebel Handheld application by choosing File > Print. If you are connected to a printer, 
the print job runs. If you are not connected to a printer, the print job is sent to a print queue. View 
the print queue by choosing File > Print Queue.

Exporting Data with the Siebel Handheld 
Application
You may export data from any view in your application in HTML format or as tab delimited text and 
save it to a file. This file can be viewed in applications such as Microsoft Pocket Word, Microsoft 
Pocket Excel, and Internet Explorer.

To export data, select File > Export to open the Export dialog box.

In the Export dialog box, you may specify the following:

■ Format. Specify either HTML or Tab delimited text file. 

■ Export. Select Only active applet to export only the data in the active applet. Select All applets 
in view to export the data in all visible applets. 

■ Output file name. By default, the file is saved in the temp directory with the filename “output.” 
You may tap Browse to specify a different location or filename.

■ Paste Output to Clipboard. Select the checkbox to save the data to the clipboard.
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■ Open file. Select the checkbox to automatically open the file. When you tap OK in the Export 
dialog box, the data is exported to the specified file, and the file is automatically opened.

NOTE: You must specify a valid output format for the application. See Table 35 for the correct 
formats to specify for the supported applications.

Setting User Preferences in the Siebel 
Handheld Application
You can customize aspects of your Siebel Handheld application from the User Preferences dialog box. 
Access the User Preferences dialog box by choosing View > User Preferences from the application-
level menu.

In the User Preferences dialog box you can:

■ Set a default startup screen.

■ Set number of maximum history threads to be saved.

■ Set the maximum percentage of the display area that the parent applet can take up.

■ Change font size.

■ Customize list spacing, column width settings, and grid lines.

■ Customize your calendar’s default view, start time, time slot interval, and default appointment 
duration.

Backing Up and Restoring Data with the 
Siebel Handheld Client
It is recommended that you back up your data to an external device—for example, a CompactFlash 
card or a Secure ID card. If the handheld device is damaged, the backup may not be retrievable. If 
you store your backups in RAM, depending on the size of your application and data extract, you may 
decrease the amount of memory available for the application, and your application performance may 
suffer.

Table 35. Export Data Options

To export data to Do the following

Microsoft Word Set Format to “Tab delimited text file.”

Microsoft Excel Select the “And paste output to clipboard” check box. 
The Output format may be set either to HTML or “Tab 
delimited text file.” Paste the data from the clipboard 
into an Excel spreadsheet.

Microsoft Internet 
Explorer

Set Format to HTML.
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Automatic Backup After Synchronization
The automatic backup feature must be enabled in the application by your System Administrator. If 
the backup feature is enabled, a backup is automatically created at the end of every synchronization. 
This way, you have an up-to-date snapshot of the database. 

CAUTION: You must never synchronize your data to the handheld device and then restore the 
database using an older copy of the database. If you do, the next time you synchronize, the 
application tries to rewrite changed transactions. This can cause data integrity problems. Therefore, 
when the database backup feature is enabled, a database backup occurs automatically at the end of 
each synchronization. 

Keep in mind that enabling automatic backup makes the overall time to synchronize somewhat 
longer. The size of the database and the speed of the CompactFlash card also affect the time it takes 
to complete synchronization.

For more information, see “Enabling Handheld User Database Backup” on page 105.

Backing Up Data
The following procedure describes how to back up the database on the handheld device.

To back up the database

1 From the application-level menu, choose File > Backup.

NOTE: If the Backup menu item is disabled, contact your system administrator to have backup 
enabled in your application.

A dialog box appears, telling you that backing up the data will restart the application and prompts 
you to confirm that you want to continue.

2 Tap Yes to start the backup.

A status dialog box appears indicating that the backup is in progress and may take a few minutes. 
The Handheld configuration files and data is copied to the backup location specified in the 
setup.ini file. Typically, the backup location is a CF or SD card.

A dialog box appears telling you whether the backup succeeded and asks if you want to return 
to the application.

3 Tap Yes to return to the application.

NOTE: If the backup fails, consult your system administrator.

Restoring Data from a Backup
In order to restore the application to its previous state, the user should contact the system 
administrator. Any work performed on the handheld device since the last backup will be lost.
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To restore the database

1 Remove the external flash card from the damaged device and place it in a new handheld device 
where the application has been installed.

2 Navigate to the \Program Files\Siebel Handheld folder.

3 Start the restore by tapping the BackupUtility file twice.

A dialog box appears, asking you to confirm that you want to restore the device from a previous 
backup.

4 Tap Yes.

A status dialog box appears, indicating that the restore is in progress. The backup utility restores 
the files to the state when the backup was performed. A dialog box appears telling you if the 
restore was successful. If successful, it asks you to confirm that you want to restart the Siebel 
Handheld application.

5 Tap Yes to start using the application.

Synchronizing Data on the Siebel 
Handheld Device
You must synchronize the data on your handheld device:

■ After you install or upgrade the Siebel Handheld application.

■ Before uninstalling the Siebel Handheld application.

■ On a regular basis to keep your data synchronized with Siebel Server and Siebel Mobile Web 
Client.

The sections that follow describe how to synchronize using Companion Sync (CS), Direct Server Sync 
(DSS) and Direct Server Sync via Proxy (DSSvP), and provide some troubleshooting tips.

Using Siebel Handheld Synchronization with the 
Handheld Client
Siebel Handheld Synchronization differs depending on whether users synchronize through 
Companion Sync or Direct Server Sync. The following topics show you how to launch and use 
Handheld Synchronization for each method.

NOTE: A given user can only synchronize using one method. For example, it is not possible to install 
a Siebel Handheld application that a particular user will synchronize both to the Siebel Mobile Web 
client database through Companion Sync and also to the Siebel Server database directly through 
Direct Server Sync.
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Using Companion Synchronization with the Handheld 
Client
If you are using Companion Sync, you must follow a three-step process to synchronize handheld, 
remote, and server databases. Immediately before and after every Siebel Remote sync, you must 
perform a Companion Sync. This process can be time consuming for the end user and difficult for the 
administrator to enforce.

Integrated Sync eliminates the need for you to initiate three separate sync sessions for each Siebel 
Remote sync.

Before using Integrated Sync, you must specify or add the parameter RemoteCfgName in the [pda] 
section of phce.cfg for the CFG file that will be used to invoke Siebel Remote Sync. For example, 
RemoteCfgName=epharma.cfg. If you do not specify this parameter it will default to siebel.cfg. This 
parameter is used by Siebel Handheld Sync to invoke Siebel Remote. It applies only when 
synchronizing using the Integrated Sync option.

Integrated Sync automatically initiates each of the following synchronization steps:

1 Handheld Upload and Processing - Handheld transactions are uploaded to the companion PC and 
processed.

2 Siebel Remote Synchronization - The Siebel Mobile Client is synchronized with the Siebel server. 
Transactions on the mobile client database are uploaded to the Siebel server, and changes to the 
Siebel server are downloaded to the mobile client database.

CAUTION: If there is a handheld patch staged on the server, synchronization terminates and the 
patch is installed. After the patch installation is completed, you are prompted to synchronize 
again (using either Integrated Sync or Companion Sync) to complete the data extraction and 
download (that is, move to Step 3). It is critical that you synchronize a second time after the 
patch installation is completed. If you fail to do so, you will not be able to start the Siebel 
Handheld application.

3 Handheld Data Extract and Download - Data is extracted from the mobile client database to the 
handheld device database.

You may use Companion Sync to synchronize your handheld with Siebel Mobile Client as many times 
as you wish between Integrated Sync sessions. However, it is recommended that you conduct 
Integrated Sync sessions frequently so that the Siebel Remote synchronization process does not take 
long periods of time to complete and update conflicts are minimized.

To perform Companion Sync from the PC

1 From the companion PC, establish a Microsoft ActiveSync connection to the handheld device.

2 From the companion PC, choose Start > Programs > Siebel Handheld Sync.

The Siebel Handheld Sync dialog box appears.

a Enter your name and password.
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b Select the Perform Remote Sync check box to perform an Integrated Sync.

If you want to do Companion Sync only, then unselect the Perform Remote Sync check box.

Selected Bypass Set Filters skips the step of selecting the filters and immediately starts the 
synchronization process. If you select Bypass Set Filters, then the filters that you selected 
the last time you synchronized are used. If this is the first time you are synchronize, then 
the default filters are used.

3 Tap Start.

NOTE: Tap Default Filters to restore the filter selection to the default setting.

4 Tap OK and tap Start to begin synchronization.

a The Siebel Handheld Sync dialog box appears. If “Perform Remote Sync” was selected, this is 
followed by the Siebel Remote dialog box. When synchronization has successfully completed, the 
Finished dialog box appears.

b If a handheld patch needs to be installed, the synchronization process is interrupted and the 
patch is installed. After the patch is installed, you must restart Siebel Handheld Sync to complete 
the data extract process. If you fail to do so, you cannot start your application.

c The Finished dialog box appears indicated that the synchronization has successfully completed.

5 Tap OK to exit Siebel Handheld Sync.

NOTE: If synchronization errors occur, an error dialog box appears.

Companion Sync can also be performed in the method described for Direct Server Sync via Proxy in 
“Using Direct Server Synchronization with the Handheld Client” on page 137.

To perform Companion Sync from the handheld device

1 From the application-level menu, choose File->Synchronization.

2 In the Sync window select the "Enable Remote Sync" checkbox. It is disabled by default.

For information on changing the parameter value for EnableRemote in the setup.ini file, see 
“Siebel Handheld setup.ini Parameters” on page 103.

3 See the steps for synchronizing using DSSvP in the procedure “To synchronize with the Siebel 
application server” on page 138. 

Using Direct Server Synchronization with the Handheld 
Client
There are two methods for synchronizing between the handheld device and the Siebel application 
server:

■ Direct Server Sync (DSS) provides synchronization between the Siebel Handheld application and 
the Siebel application server.
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■ Direct Server Sync via Proxy (DSSvP) provides synchronization between the Siebel Handheld 
application and the Siebel application server, using the desktop or companion PC to provide the 
network connection between the handheld device and the server.

To synchronize with the Siebel application server

1 If you are synchronizing using DSS, create a direct network connection through a modem or a 
direct LAN connection.

If you are synchronizing using DSSvP, establish an ActiveSync connection between the handheld 
device and the PC.

2 From the application tap File > Synchronize.

The Siebel Handheld Sync dialog box appears.

3 Enter your user name and password.

4 Tap Start.

The Siebel Handheld Sync dialog box appears.

5 Tap OK to exit Siebel Handheld Sync, and the application will launch automatically.

NOTE: If synchronization errors occur, an error dialog box appears.

Synchronization Troubleshooting with 
the Siebel Handheld Client
This section lists potential error messages that are associated with synchronization. In addition, this 
section helps to understand transaction errors.

General Synchronization Errors
There are a number of different errors that can occur when synchronization does not complete 
successfully, for example: 

■ Faulty wire connection

■ Server crash

■ Insufficient memory

■ Login error

When these errors occur, the user should exit Siebel Handheld Sync and launch the application again.

NOTE: When you restart Siebel Handheld Sync, you may see an error message that says that 
another instance of syncmanager.exe is running. You are asked whether you want to terminate the 
first instance or not, and you should choose Yes.
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Transaction Conflicts
Transaction conflicts are minimized when customers adhere to the standard configuration practices 
outlined in this document. However, even when proper configuration practices are followed, conflicts 
can occur for a variety of reasons. For example, if a field value is updated on both the handheld client 
and the server between synchronization events, a transaction update conflict occurs. In this 
instance, the user is presented with an error dialog after synchronization has completed.

A transaction consists of one or more smaller transactions called mini-transactions. For example, if 
you update several fields in a record, the update to the record counts as a single transaction, and 
each update to a field is a mini-transaction. Individual fields are skipped when update conflicts occur.  
Changes to any field that has been updated on the server since the last sync (perhaps by another 
Handheld user) are discarded (but logged and returned as errors to the user). All non-conflicting 
fields normally are updated. Except for field-level conflicts, which are skipped when they occur, a 
transaction is applied in its entirety, and at this point will either succeed or fail in its entirety.

Improving Siebel Handheld Application 
Performance
If you find that the performance of the Siebel Handheld application is very slow or begins to degrade, 
the following can help to improve the application performance:

■ Verify that you are using a Siebel supported device for your application. See System 
Requirements and Supported Platforms on Siebel SupportWeb.

■ When you run the Siebel Handheld application, it is recommended that you do not run any other 
applications. By doing so, you maximize the amount of memory that is available to run the 
application.

■ Increase the amount of memory that is allocated for running applications.

■ Installing the binaries to a CompactFlash card. For more information, see “Setting Up Siebel 
Handheld Application Installation on a CompactFlash Card” on page 107.

To increase application memory

1 From the Start menu, select Settings.

2 Select the System tab and tap Memory.

3 Move the slider bar so that more memory is allocated to Program Memory, then tap OK.
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10 Using Pharma Handheld
This chapter includes the following topics:

■ “Managing Contacts with Siebel Pharma Handheld” on page 141

■ “Managing Accounts with Siebel Pharma Handheld” on page 146

■ “Planning and Recording Calls in Siebel Pharma Handheld” on page 151

■ “Creating General Activities in Siebel Pharma Handheld” on page 166

■ “Managing Samples in Siebel Pharma Handheld” on page 169

■ “Setting Up MedEd Events in Siebel Pharma Handheld” on page 180

■ “Creating Expense Reports in Siebel Pharma Handheld” on page 182

Managing Contacts with Siebel Pharma 
Handheld
A contact is typically a physician, nurse, pharmacist or other medical professional. In a more general 
sense, a contact is any individual a pharmaceutical company deems significant to their business 
process, such as a formulary director, contracts administrator, or medical education event speaker.

Sales representatives use Pharma Handheld to add and update contact profile information which may 
include adding new contacts, creating new contact addresses, tracking affiliations between contacts 
and accounts, recording the best times to call on a contact, transcribing relevant notes, and viewing 
prescription data.

This section describes how to manage contact information using all of the views accessible from the 
Contacts screen’s Show drop-down list, except for Calls and Activities. The following contact 
management procedures are included in this section:

■ “Adding Contacts in Pharma Handheld” on page 142

■ “Adding Contact Addresses in Pharma Handheld” on page 143

■ “Adding and Editing License Information in Pharma Handheld” on page 143

■ “Specifying the Best Time to Call on a Contact in Pharma Handheld” on page 144

■ “Adding Private or Shared Notes About a Contact in Pharma Handheld” on page 145

■ “Indicating Affiliations Between Contacts and Accounts in Pharma Handheld” on page 145

■ “Viewing Prescription Data in Pharma Handheld” on page 146

For information on the Calls and Activities views, see “Creating Contact Calls in Pharma Handheld” on 
page 155 or “Creating General Activities in Siebel Pharma Handheld” on page 166.
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Adding Contacts in Pharma Handheld
Using the Contacts screen and the My Contacts view, you can add contacts and update contact 
information directly in Pharma Handheld. 

To add contacts

1 Navigate to the Contacts screen.

The My Contacts list appears.

2 On the toolbar, tap the New Record icon.

3 Complete the Last Name, First Name, Main Phone, Type, and Title fields for the new record.

To add additional contact information

1 Navigate to the Contacts screen

The My Contacts list appears. 

2 Select a record, and from the Show drop-down list, choose More Info.

3 Add or edit information in the available fields. 

The fields are described in the following table.

Field Comments

Address Read only. A contact can have more than one address. One address 
must be specified as primary. Addresses are entered using the 
Addresses view. For more information on adding addresses, see “Adding 
Contact Addresses in Pharma Handheld” on page 143.

Last Call Date Read only. The date of the most recent call that has been submitted. 

OK to Sample Checking this box indicates that it is permissible to drop samples off with 
this contact.

Primary Specialty Read-only. Siebel administrators define this value.

Rep Specialty The specialty or area of expertise associated with this contact within the 
contact’s organization.

Route Allows users to select when to visit an account from a predefined route 
schedule.

Title Must be filled in before a contact can sign for receipt of samples.

Type Indicates the type of contact. 
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Adding Contact Addresses in Pharma Handheld
Contact addresses are entered in the Addresses view. Since a contact can have multiple addresses, 
and multiple contacts may share an address, take care when editing an address as the changes may 
affect more than one contact.

When entering addresses, specify one address as the primary. Each sales representative can specify 
a different primary address for an assigned contact. For example, one representative might specify 
a private office as the primary address, while another representative might designate a hospital 
department as the primary address.

The More Info form only displays the primary address, not all the addresses associated with the 
contact.

To add contact addresses

1 Navigate to the Contacts screen

The My Contacts list appears.

2 Select a record, and from the Show drop-down list, select Addresses.

3 Tap the list of addresses to select it.

4 On the toolbar tap the New Record icon.

5 In the Addresses list, do one of the following:

■ Tap New to add a record, and then complete the necessary fields.

■ Tap an existing address in the list, and then tap OK.

6 In the Address list, tap the check box in the record’s Primary field to designate the record as the 
contact’s primary address.

A check mark appears in the box to designate the primary address.

Adding and Editing License Information in Pharma 
Handheld
Using the License Numbers view, you can add the contact’s professional license number, such as a 
state medical license number or a physician investigator’s AMA number. 

Before a physician can sign for samples dropped, you must enter the physician’s license numbers 
and additional license information. The contact must have a valid license number for the state 
corresponding to the address where samples are disbursed.

To add and edit license information

1 Navigate to the Contacts screen 

The My Contacts list appears.
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2 Select a contact, and from the Show drop-down list, select License Numbers.

The License Numbers view appears.

3 Tap the License Numbers list to select it, and then do one of the following:

■ On the toolbar, tap the New Record button, and then complete the fields for State, License 
number, License Expiration Date, and license Status.

■ Tap a License Number record to select it, and then edit the information in the fields.

Specifying the Best Time to Call on a Contact in Pharma 
Handheld
Using the Best Time to Call view, you can enter the best times to call on a contact based on a selected 
address. You can then query for contacts available during a specific time period.

To specify the best times to call on contacts

1 Navigate to the Contacts screen. 

The My Contacts list appears.

2 Select a contact, and from the Show drop-down list, select Best Times to Call.

3 Tap the Best Times to Call list to select it.

4 On the toolbar, tap the New Record button.

5 Complete the fields for the new record, as described in the following table.

 

Field Comments

Address Indicates which contact address pertains to this best time to call information. 
Select the address from the Pick Location dialog box, and tap OK. The Pick 
Location dialog box displays all addresses associated with that contact.

Start Day Indicates the day that the contact is available for a call at that address.

Start Time Indicates the start time for the selected day that the contact is available for 
a call.

End Time Indicates the end time for contact availability.

Comments Text field for information about time period constraints and other relevant 
notes.
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Adding Private or Shared Notes About a Contact in 
Pharma Handheld
Using the Private Notes and Shared Notes views you can create and update notes on contacts. Private 
notes are visible only to the creator of the note; shared notes are available to other sales 
representatives calling on the contact.

To add notes about contacts

1 Navigate to the Contacts screen, and select a contact from the My Contacts list.

2 From the Show drop-down list, select one of the following:

■ Private Notes. Limits access to the note to the person creating it.

■ Shared Notes. Allows all account team members to access the note.

3 Tap the Private Notes or Shared Notes list to select it.

4 On the toolbar, tap the New Record button.

A new row appears in the list.

5 Complete the necessary fields for the record.

Tap in the Note field, and then tap the ellipsis (...) to view the entire note while you are entering 
text.

Indicating Affiliations Between Contacts and Accounts 
in Pharma Handheld
Using the Affiliations view, you can associate a contact with an account. One reason to establish 
these affiliations is for call reporting purposes. Affiliations between accounts and contacts also can 
be established using the Accounts screen.

To specify affiliations between contacts and accounts

1 Navigate to the Contacts screen, and select a contact from the My Contacts list.

2 From the Show drop-down list, select Affiliations.

The Account Affiliations view appears.

3 Tap the Account Affiliations list to select it, and then tap the New Record button.
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4 Complete the necessary fields for the new record.

Some of the fields are automatically populated based on the chosen Account. Other fields are 
described in the following table.

Viewing Prescription Data in Pharma Handheld
Using the Rx Data view, you can view prescription data to better target medical professionals. Data 
about physicians and prescribed drugs helps pharmaceutical companies define their market for 
better strategic business planning and national account management. Prescription data can be 
analyzed to measure market potential, target customers, align sales territories, and track market 
shifts.

To view prescription data

1 Navigate to the Contacts screen, and select a contact from the My Contacts list.

2 From the Show drop-down list, select Rx Data.

The Rx data associated with the contact appears in the RX Data list.

3 In the list, review the prescription data on a market-by-market basis.

Managing Accounts with Siebel Pharma 
Handheld
An account is any health care business that generates sales for your company or that could 
potentially generate business. Typical examples of accounts include hospitals, clinics, HMOs, 
wholesalers, group purchasing organizations (GPOs), and pharmacies. An account can also be any 
organization with which multiple contacts are associated, such as a group practice or an assisted-
living facility. 

Field Comments

Account The account to be affiliated with the selected contact. Select a predefined 
account from the Pick Account list, and then tap OK.

Comments Text field for user comments.

Direct If a check mark appears in this field, profile data for the contact is routed to 
members of the team assigned to the affiliated account.

If no check mark appears in this field, the profile data is routed only to the 
members of the team assigned to the contact. Tap the check box to specify a 
direct affiliation between a contact and an account.

Primary If a check mark appears in this field, the account is the primary affiliation for 
the contact. Tap the check box to display a check mark.

Start Date The beginning date on which the contact became affiliated with this account.
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Sales representatives in the field use Pharma Handheld to add and update account profile 
information. Representatives use Pharma Handheld to add new accounts, create new account 
addresses, record the best times to call on an account, and record relevant notes. Sales 
representatives can also view sales data on Pharma Handheld to help them evaluate the business 
potential of accounts.

This section describes how to manage account information using all of the Accounts views accessible 
from the Show drop-down list, except the Calls and Activities views. For information on those views, 
see “Creating Account Calls in Pharma Handheld” on page 162 or “Creating General Activities in Siebel 
Pharma Handheld” on page 166.

The following account management procedures are included in this section:

■ Adding Accounts in Pharma Handheld on page 147

■ Adding Account Addresses in Pharma Handheld on page 148

■ Specifying Best Times to Call Accounts in Pharma Handheld on page 148

■ Adding Notes About Accounts on page 149

■ Indicating Affiliations Between Accounts and Professionals in Pharma Handheld on page 149

■ Viewing Sales Data in Pharma Handheld on page 150

Adding Accounts in Pharma Handheld
Accounts are businesses and organizations that either currently generate sales for your company or 
have the potential to do so. You can add or edit accounts using the My Accounts view.

NOTE: Only a Siebel administrator can delete an account. 

To add an account

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 On the toolbar, tap the New Record button, then complete the necessary fields for the new 
record.

3 To enter information in additional fields, select More Info from the Show drop-down list.

Some of the fields are described in the following table. 

Field Comments

Account Account name. Tapping the account name hyperlink opens the Call Activities 
view.

Address The account can have more than one address. One address must be specified 
as primary. Account addresses must be entered in the Addresses view. For 
more information on adding addresses, see “Adding Account Addresses in 
Pharma Handheld” on page 148.
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Adding Account Addresses in Pharma Handheld
Addresses for accounts are entered in the Addresses view. Since an account can have multiple 
addresses, care should be taken when editing an account address, as changes affect all accounts 
associated with the address.

When entering account addresses, designate one address as the primary. Each sales representative 
assigned to an account can specify a different primary address. For example, one representative 
might specify a private office as the primary address, while another representative might specify a 
hospital department as the primary address.

The More Info form displays the primary address, not all the addresses for the contact.

To add account addresses

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 Select a record, and from the Show drop-down list, select Addresses

3 Tap the Addresses list to select it, then on the toolbar, tap the New Record button.

4 In the Add Address dialog box, do one of the following:

■ Tap New to create a new address record, and then complete the fields.

■ Select an existing address from the list, and then tap OK.

5 In the Primary field, tap the check box to display a check mark if this is the account’s primary 
address.

Specifying Best Times to Call Accounts in Pharma 
Handheld
Use the Best Times to Call view to specify appropriate time periods for account calls. 

To specify best times to call accounts

1 Navigate to the Accounts screen.

The My Accounts list appears. 

Site A unique location identifier that distinguishes this account from any other 
accounts with the same name.

Mkt Potential Used to evaluate the business potential of the account.

Field Comments
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2 Select an account, then from the Show drop-down list, select Best Times to Call.

3 On the toolbar, tap the New Record button.

4 Complete the necessary fields for the new record. 

The fields are described in the following table.

Adding Notes About Accounts
Using the Private Notes and Shared Notes views, you can create and update private and shared 
account notes. Private notes are visible only to the note creator; shared notes are available to other 
sales representatives calling on the account.

To add account notes

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 Select an account from the My Accounts list.

3 From the Show drop-down list, select one of the following:

■ Private Notes. Limits access to the note to the person creating it.

■ Shared Notes. Allows all account team members to access the note.

4 Tap the Notes list to select it.

5 On the toolbar, tap the New Record button, then complete the fields for the new record.

Tap in the Note field, and then tap the ellipsis (...) to view the entire note while you are entering 
text.

Indicating Affiliations Between Accounts and 
Professionals in Pharma Handheld
For accounts where you have contact with multiple professionals, you can indicate the affiliation of 
those professionals with the account by using the Affiliations view. Creating affiliations between 
accounts and contacts promotes efficiency in call reporting.

Field Comments

Start Day Indicates the days that the contact is available for a call.

Start Time Indicates the time that the contact is available for a call.

End time Indicates end of available time period.

Comments Text field for schedule information.
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To indicate affiliations between accounts and contacts

1 Navigate to the Accounts screen

The My Accounts list appears.

2 Select an account from the My Accounts list, and from the Show drop-down list, select 
Affiliations.

3 Tap the Contact Affiliations list to select it.

4 On the toolbar, tap the New Record button.

5 Complete the necessary fields for the new record.

Some of the fields are described in the following table.

Viewing Sales Data in Pharma Handheld
Sales data can be analyzed to measure market potential, target customers, align sales territories, 
and track market shifts. Sales data is typically syndicated information that is loaded periodically by 
the Siebel administrator. 

You can review this information using the Sales Data view. 

To view sales data

1 Navigate to the Accounts screen.

The My Accounts screen appears.

2 Select an account from the My Accounts list, and from the Show drop-down list, select Sales 
Data.

3 Review the data in the list on a product-by-product basis.

Field Comments

Last Name The contact affiliated with this account. Tap the field, select the contact from 
the Pick Contact list, and then tap OK.

Start Date The beginning date on which the account became affiliated with this contact.

Direct Tap the check box to display a check mark. 

If a check mark appears in this field, profile data for that person is routed to 
all members of the team assigned to the affiliated account.

If no check mark appears in this field, the profile data is routed only to 
members of the team assigned to the person.
Siebel Pharma Handheld Guide Version 7.8150 ■



Using Pharma Handheld ■ Planning and Recording Calls in Siebel Pharma Handheld
Planning and Recording Calls in Siebel 
Pharma Handheld
Planning calls in Pharma Handheld consists of configuring personal lists and creating account and 
contact calls. Recording calls involves entering information on products detailed, samples and 
promotional items dropped, and decision issues that occurred during the call.

About Personal Lists
Personal lists allow for faster call reporting by limiting the number of products that appear in drop-
down lists in the Call Products Detailed, Samples Dropped, and Promotional Items Dropped views.

About Contact and Account Calls
Contact and account calls are types of activity records, although contact and account calls cannot be 
created from the Activities view. 

Contact calls can be created by tapping the New Call or Auto Call button from the My Contacts view, 
by creating a new record from the Contacts screen’s Calls view, or by creating a new record from the 
Contact Calls screen.

Account calls can be created by tapping the New Call or Auto Call button from the Accounts screen, 
by creating a new record from the Accounts screen’s Calls view, or by creating a new record from 
the Account Call screen.

■ Contact call. Used to track a planned or past call activity with a contact. You can record details 
about contact calls such as the products detailed, the samples and promotional items dropped, 
and decision issues discussed. Before you can record details about a contact call, you must set 
up personal lists.

■ Account call. Used to track a planned or past call activity at an account. You can record products 
detailed, attendees, promotional items dropped, and decision issues discussed.

About Auto Call, Smart Call, and Auto Update
Pharma Handheld provides several features to manage contact and account call records:

■ Smart Call. Specifying a Smart Call template for the call record associates a prepopulated call 
template with this call. 

A Smart Call is a template that you can apply to contact calls and account calls to simplify and 
speed up the call-reporting process. A Smart Call defines a set of information about the products 
detailed, the samples distributed, and the issues discussed on a call. Smart Call templates are 
created in Siebel Pharma, not in the handheld application.

Smart Calls can be also used for calls related to a particular campaign or promotional effort, or 
for everyday call reporting. They are intended for situations where sales representatives report 
details about a number of calls that are identical in content (the same products are detailed in 
the same order, the same samples are dropped, and so on). After you apply a Smart Call template 
to a call, you can make additional edits in any fields in the Contact Call screen’s Details view.
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■ Auto Call. Selecting the Auto Call button creates a new call and populates the record with items 
from the personal lists.

Auto Call is designed to help minimize the time in front of a physician by pre-populating the call 
with products from your personal list. Apply Auto Call as a part of the call planning process. Once 
the call has been created, you can access auto-created calls to record call information directly 
on the handheld in front of a physician.

Auto Call speeds up call reporting because you do not have to individually select the products 
and samples while recording the call. After selecting Auto Call, the Status field in the Contacts 
view displays Auto-Created.

■ Auto Update. Selecting Auto Update deletes from the database unused auto-created call 
records.

Business Scenarios for Calls and Lists in Pharma 
Handheld
The following scenarios depict typical work sequences followed by sales managers and 
representatives using Siebel Pharma and Pharma Handheld. Your company may follow a different 
sequence according to its business requirements. 

Scenario for Setting Up Personal Lists
A sales representative has recently joined a pharmaceutical company that uses Pharma Handheld in 
the field. During her sales training, the representative’s sales manager tells her that before she can 
record calls within the system, she must first set up her personal lists. The sales manager explains 
that personal lists allow faster call reporting by limiting the number of products that appear in the 
application’s drop-down lists. The sales manager then demonstrates how to add products to the sales 
representative’s Details, Samples Dropped, and Promotional Items views. Following her manager’s 
instruction, the sales representative updates her personal lists and is ready to record call details.

Scenario for Planning Calls in Siebel Pharma and Recording Calls in 
Siebel Pharma Handheld
A sales representative for a pharmaceutical company wants to set up visits to her customers over 
the next few days. To do so, she first uses Siebel Pharma on her laptop to plan contact calls. Then 
she synchronizes the data with Siebel Pharma Handheld on her handheld device, which she carries 
with her to record call details. 

To plan her calls, she begins by analyzing the physicians’ prescribing habits. She then queries on 
geographical location, specialties, and time lapse since she last called on them to determine which 
physicians she should call on.

Using Siebel Pharma, she applies a Smart Call template to those calls so that information about the 
samples products is automatically copied into the call records. She has now prepopulated the calls 
with the details that she wants to speak about with each physician as well as the samples she wants 
to drop off.
Siebel Pharma Handheld Guide Version 7.8152 ■



Using Pharma Handheld ■ Call Management Procedures in Siebel Pharma Handheld
The sales representative synchronizes her handheld so that she can carry these details with her and 
record her progress throughout the day. The information she has available on her handheld includes 
previous calls and other activities, notes, and physician prescription history.

Before meeting with the physician, she goes to the samples closet in his office and drops off the 
samples. She records the lot numbers on her handheld device.

When she meets with the doctor, she describes the samples she has left for him, explains the benefits 
of key products, and discuss the doctor's concerns. He expresses interest in additional product 
samples so she records additional samples to the contact call. She then captures the doctor’s 
signature on the handheld device. 

After the meeting, the sales representative records the information on the products detailed and 
promotional items and issues discussed. After she has reviewed the information and verified that it 
is accurate, she submits the call. 

Scenario for Planning and Recording Calls in Pharma Handheld
That same day, another sales representative sets off to visit several clinics. Unlike the first sales 
representative, this representative does not schedule his calls on his laptop beforehand for two 
reasons. First, he plans to call on group practices with many physicians, and he cannot be sure which 
physician will be signing for the samples. Secondly, he prefers to enter sample information manually 
rather than using a Smart Call template.

Before he enters the first clinic, he queries for physicians associated with that address. Seven names 
appear. When he walks in, he encounters one of the doctors so he selects that physician’s record and 
adds a new call. While speaking with the doctor about the benefits of the product, the sales 
representative hands him some samples and records the samples dropped information. He then 
obtains the doctor’s signature on the handheld device. After adding a comment about the call and 
recording products detailed, the sales representative submits the call.

Call Management Procedures in Siebel 
Pharma Handheld
This section provides the following procedures related to planning, recording, and submitting calls.

■ Updating personal lists:

■ To create personal lists on page 154

■ Creating, recording, and submitting contact calls:

■ To add a contact call from the Contacts view on page 155

■ To add a contact call from the Contact Calls view on page 157

■ To apply a Smart Call template on page 157

■ To delete unused records created from the Auto Call button on page 158

■ To record information about products detailed on page 158

■ To record information about samples dropped on page 159
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■ To record information about promotional items dropped on page 160

■ To record information about decision issues discussed during the call on page 160

■ To capture a signature on page 160

■ To submit a completed contact call on page 161

■ Creating, recording, and submitting account calls:

■ To add an account call from the Accounts view on page 162

■ To add an account call from the Account Call view on page 163

■ To delete unused account call records created with the Auto Call button on page 164

■ To enter products detailed information for an account call on page 164

■ To enter attendee information for an account call on page 165

■ To submit a completed account call on page 165

Creating Personal Lists in Pharma Handheld
Personal lists determine which products appear in the drop-down lists of the Call Products Detailed, 
Samples Dropped, and Promotional Items Dropped views. Limiting the number of products in the 
lists allows for faster call reporting.

Before you can record call details, you must configure personal lists of the products you promote, 
the products you distribute as samples, and the products you provide as promotional items. In 
addition, you must specify at least one product in a personal list or the corresponding drop-down list 
will be empty when you try to enter call details.

Setting up personal lists is a one-time setup procedure. After you have completed this task, you do 
not need to repeat it. You can revise personal lists at any time to delete or add products as necessary.

To create personal lists

1 Navigate to the Personal Lists screen.

2 From the Show drop-down list, select Details, Promotional Items, or Samples to include that item 
on this personal list.

3 On the toolbar, tap the New Record button.
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4 In the new row, complete the necessary fields. 

Some of the fields are described in the following table.

Creating Contact Calls in Pharma Handheld
You can create contact calls and update contact call details using Pharma Handheld. Because contact 
calls are a type of activity, they also appear in the Calendar view.

As a shortcut for creating contact calls, you optionally may apply a Smart Call to the new record or 
auto-create a record to populate it with predefined data. For more information, see “About Auto Call, 
Smart Call, and Auto Update” on page 151. Before you can enter information about products detailed, 
samples, and promotional items dropped during a contact call, you must set up personal lists. For 
more information, see “Creating Personal Lists in Pharma Handheld” on page 154.

To add a contact call from the Contacts view

1 Navigate to the Contacts screen.

The My Contacts list appears.

2 Select a contact in the Contacts list.

NOTE: If you are using the Auto Call feature, you can select several contacts from the list. 
Selecting the Auto Call button creates new calls for the selected contacts. Users should be 
advised that selecting more than one contact at a time to generate Auto Calls affects 
performance.

3 In the Contacts list, do one of the following:

Field Comments

Order Enter a number that indicates where this product should appear in the drop-
down list. This field appears in the Details list, Samples list, and Promotional 
Items list.

For example, if you want a product in the Details list to appear first, enter 1. 
If this field is null for all products in the list, the products will appear in 
alphabetical order. If this field is null for some products but not for others, 
records with a null Order field appear at the beginning of the list, in 
alphabetical order. 

Product The products being detailed during contact and account calls. This field 
appears in the Personal Lists, Details view.

Promotional 
Item

The promotional items being dropped during contact and account calls. This 
field appears in the Personal Lists, Promotional Items view.

Sample The products to be dropped as samples during contact and account calls. This 
field appears in the Personal Lists, Samples view.
Siebel Pharma Handheld Guide Version 7.8 ■ 155



Using Pharma Handheld ■ Call Management Procedures in Siebel Pharma Handheld
■ Tap the Auto Call button to populate the new call with items from your Personal List and then 
select Calls from the Show drop-down list. 

After selecting Auto Call, the Status field in the Contacts Calls view displays “Auto-Created.”

■ Tap the New Call button and complete the fields in the new form.

Some of the fields are described in the following table.

4 To specify which products to detail during the call:

a From the Show drop-down list, select Details.

b Tap the Contact Call Details list to select it, add a new record, and complete the necessary fields.

5 To specify which samples to drop off during the call:

a From the Show drop-down list, select Samples Dropped.

b Tap the Samples Dropped list to select it, add a new record, and complete the necessary fields.

6 To specify which products are promotional items:

Field Comments

Last 
Name

The contact to be visited during this call. 

Ref # A reference number for this call. This reference number becomes the 
transaction number (Transaction # field) for a samples transaction 
corresponding to this call. 

Smart 
Call

Smart Call is a prepopulated call template that can be associated with this call. 
Make a selection from the Pick Smart Call dialog box. 

Status The status of this call. The default value is Planned. After synchronization, this 
value changes to Synchronized for calls that have not been submitted. 

You cannot select the value Submitted. To change the status of the call to 
Submitted, you must submit the call.

Paper 
Sign

Indicates that the contact provided a paper signature for a sample 
disbursement.

Remake 
Receipt

Used to create an updated sample receipt and signature in the event that the 
original call information was incorrect.

For example, if Dr. Smith mistakenly signs for the receipt of samples on a 
request form having a different physician's name (such Dr. Jones), then the 
sample form is inaccurate. In this example, the sales representative must 
change the name on the original call to the correct physician (Dr. Smith) and 
have Dr. Smith sign again. 

Using the Remake Receipt check box, the sales representative can capture a 
second signature on the corrected sample form. Pharma Handheld 
automatically tracks the appropriate audit trail information required by the FDA 
in the remake receipt functionality.
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a From the Show drop-down list, select Promotional Items.

b Tap the Promotional Items list to select it, add a new record, and complete the necessary fields.

7 To specify which issues were discussed during a call:

a From the Show drop-down list, select Issues.

NOTE: Decision issues are the objections a contact may raise when evaluating a product 
before making a prescribing decision. 

b Tap the Issues list to select it, add a new record, and complete the necessary fields.

For more information on how to enter information, see “Recording Contact Calls in Siebel Pharma 
Handheld” on page 158.

NOTE: If you applied a Smart Call to the call, you may only need to verify that the information in 
the four lists is accurate.

To add a contact call from the Contact Calls view

1 Navigate to the Contact Call screen, and tap the Contact Call form to select it.

2 On the toolbar, tap the New Record button.

3 Complete the necessary fields.

To add a contact call from the Calendar screen

1 Navigate to Calendar screen.

2 Navigate to the Daily view for the day you want to schedule your call.

3 Highlight time frame for the Contact Call you want to schedule. 

4 Click New Call button.

5 The Contact Call Screen appears with Date/Time field prepopulated with the date/time you 
selected.

6 Complete the necessary fields.

To apply a Smart Call template

1 Navigate to the Contact Call screen, and tap the Contact Call form to select it. 

2 On the toolbar, tap the New Record button.

3 In the new record, complete the necessary fields. 

4 In the Smart Call field, tap the drop-down list arrow.

The Pick Smart Call list appears. 

5 Select a Smart Call template, and tap OK.
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To delete unused records created from the Auto Call button

1 Using the Sign button:

■ From the parent Contact Call form, tap the Sign button. 

Selecting the Sign button deletes all dropped records from unused samples, making sure that 
the physician only signs for samples that he or she was actually given. To delete detailed 
records for unused products, select the Submit button.      

2 Using the Auto Update button:

■ From the My Contacts view, tap the Auto Update button.

For example, suppose you have used the Auto Call button to create three contact calls, but 
were unable to visit one of the physicians. Selecting Auto Update deletes the unused record.

NOTE: Performance is affected if users select Auto Update when they have more than one 
unused auto-created call. It is recommended that users have no more than three unused 
auto-created calls when using the Auto Update feature.

Recording Contact Calls in Siebel 
Pharma Handheld
Contact calls are used to track a planned or past call activity with a contact. You can enter contact 
call details directly in Pharma Handheld. 

To record a contact call, users must complete the following tasks, which are included below:

■ Enter information on products detailed.

■ Enter information about samples dropped.

■ Enter information about promotional items dropped (optional).

■ Record any decision issues (optional).

■ Capture signatures.

■ Submit the call.

The next sections explain how to perform each of these tasks. If you have not yet set up your 
personal lists, you must do so before you can proceed with the next steps. For more information, see 
“Creating Personal Lists in Pharma Handheld” on page 154.

To record information about products detailed

1 Navigate to the Contact Call screen, and select the desired contact call.

NOTE: If you have not yet set up your personal lists, you must do so before you can proceed 
with the next step.

2 From the Show drop-down list, select Details.

The Product Details view appears.
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3 Tap the Product Details list to select it.

4 On the toolbar, tap the New Record button to add a record for each product discussed during the 
call.

5 Complete the fields for each record. 

Some of the fields are described in the following table.

To record information about samples dropped

1 Navigate to the Contact Call screen, and select the desired contact call.

2 In the Contact Call form, enter a reference number (if required) in the Ref # field.

3 From the Show drop-down list, select Samples Dropped.

The Samples Dropped list appears.

4 Tap the Samples Dropped list to select it, and then add a record and complete the fields for each 
product dropped during the call.

Some of the fields are described in the following table.

 

NOTE: If the samples you dropped do not appear in the Name field drop-down list, you may need 
to acknowledge the receipt of the samples within the system. Go to the Samples Receipts screen 
and submit any records with a status of In Progress. For more information, see “Acknowledging 
Receipt of a Samples Transfer in Pharma Handheld” on page 177. If the samples you dropped still 
do not appear, contact your samples administrator.

Field Comments

Indication The purpose or therapeutic area for which a drug is designed.

Priority Priority of this product relative to others discussed during the call.

Name The name of the product detailed during the call. The products appearing in this 
drop-down list are based on the products added to your Personal list. For more 
information on adding products to your personal lists, see “Creating Personal Lists 
in Pharma Handheld” on page 154

Field Comments

Lot # The lot number (if applicable) of the products dropped during the call. If tracking 
samples by lot number, select a lot number in the Pick Lot dialog box.

Name The name of the products dropped during the call. The products appearing in this 
drop-down list are based on the products available in your samples inventory. For 
more information on samples, see “Managing Samples in Siebel Pharma Handheld” 
on page 169.

Quantity The quantity of samples dropped during the call.
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To record information about promotional items dropped

1 Navigate to the Contact Call screen, and select the desired contact call.

2 From the Show drop-down list, select Promotional Items.

The Promotional Items view appears.

3 In the Promotional Items list, add a record for each item dropped during the call, and complete 
the necessary fields.

Some of the fields are described in the following table.

 

To record information about decision issues discussed during the call

1 Navigate to the Contact Call screen, and select the desired contact call.

2 From the Show drop-down list, select Issues.

The Professional Issues view appears.

3 Tap the Issues list to select it.

4 On the toolbar, tap New Record to add a record for each issue discussed during the call.

5 Complete the necessary fields for each new record.

NOTE: Decision issues are the objections a contact may raise when evaluating a product before 
making a prescribing decision. 

You can use Pharma Handheld to electronically capture signatures. For the application to accept a 
signature:

■ Make sure the title field for the contact from Contacts, My Contacts view is populated. 

■ Make sure the contact’s license number appears in the License # field of the Contact view. 
Licenses are associated with the contact's address.

To capture a signature

1 Navigate to the Contact Call screen, and select the desired parent Contact Call form.

Field Comments

Name The promotional item dropped during the call. The items appearing in this 
drop-down list are based on items added to your Personal Promotional Items 
list. For more information, see Creating Personal Lists in Pharma Handheld on 
page 154.

Quantity The quantity of the promotional item dropped during the call.
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2 Tap the Sign button to launch the Signature Capture view.

The Signature Capture view contains the company name, samples recorded when the call gets 
submitted, a disclaimer (as set up by the administrator on the Web client), and contact 
information.

If you want to invert the signature display, tap the Signature Flip button instead of the Sign 
button. Inverting the signature display allows you to extend the handheld device toward the 
contact for a signature without turning the device around.

3 In the Signature Capture view, have the contact sign on the white surface.

4 Perform one of the following actions:

■ Tap OK to submit the record.

■ Tap Cancel to abort the procedure.

■ Tap Clear to erase the signature area.

■ Tap Change Contact to select the correct contact whose signature you are capturing.

NOTE: The application automatically locks the keyboard hot keys when the Signature Capture view 
is displayed.

Changing Contacts While in Signature Capture View

Sales representatives may find themselves in a position where they will need to switch contacts in 
order to get a required signature. You can change a contact within the signature capture screen.

To change contact while in Signature Capture view

1 In signature capture screen, tap the Change button.

2 From the Pick Contact list, select the desired contact.

NOTE: By default only the contacts that are affiliated to the accounts this contact is affiliated to 
will show on the pick applet. Users can select All Contacts button to show all contacts regardless 
of their affiliation

3 Tap Pick and Sign. 

The signature capture view appears with the new contact information just selected.

4 Tap OK to commit the signature.

To submit a completed contact call

1 Navigate to the Contact Call screen, and select the desired contact call.

NOTE: You cannot submit a call with a future date. 

2 Verify that the information for the Contact Call is accurate and complete. For more information, 
see:

■ To record information about products detailed on page 158
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■ To record information about samples dropped on page 159

■ To record information about promotional items dropped on page 160

■ To record information about decision issues discussed during the call on page 160

NOTE: After you submit a call, you cannot modify any fields except the Comment field.

3 If you dropped samples when making the call, verify that you entered a samples reference 
number in the Ref # field in the Contact Call form.

CAUTION: If you are a mobile user, submit your calls before connecting to the server, and then 
synchronize. Mobile users should not submit calls while connected to the server or they run the 
risk of introducing errors into their inventory counts.

4 Contact Call form, tap Submit.

If the call passes all of the validations, the application:

■ Creates a samples disbursement transaction with a line item for each dropped sample 
recorded for the call.

■ Submits a disbursement transaction to update the samples inventory. If the submission of 
the disbursement transaction is successful, the application changes the call's Status field to 
Submitted.

■ Sets appropriate fields in the call record to read-only.

For more information on submitting records, see “How Siebel Samples Management Works with 
Calls” on page 171.

Creating Account Calls in Pharma Handheld
Account Calls are used to track a planned or past call activity at an account. You can enter account 
call details directly in Pharma Handheld. 

For more information on entering call details, see “Recording Account Calls in Siebel Pharma Handheld” 
on page 164.

NOTE: Before users can enter information about products detailed and attendees associated with an 
account call, they must set up their personal lists. For more information, see “Creating Personal Lists 
in Pharma Handheld” on page 154.

To add an account call from the Accounts view

1 Navigate to the Accounts screen.

2 In the Accounts list, do one of the following:
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■ Select the Auto Call button to populate the new call with items from the Personal Lists, and 
then select Calls from the Show drop-down list. 

NOTE: When you select Auto Call in the My Accounts view, the application populates the 
product Details list for all attendees associated with the account call. When you select Auto 
Call in the Account Calls, Attendees view, the application populates the Samples Dropped list 
for the selected attendees.

After selecting Auto Call, the Status field in the Accounts view displays “Auto-Created.”

■ Tap the New Call button and complete the fields in the new form. 

Some of the fields are described in the following table.

3 From the Show drop-down list, select the following and add records, if necessary:

■ Details

■ Attendees

4 From the parent Account Call form, select the Submit button.

For more information entering information in the Details and Attendees lists and submitting a call, 
see “Recording Account Calls in Siebel Pharma Handheld” on page 164.

To add an account call from the Account Call view

1 Navigate to the Account Call screen.

2 On the toolbar, tap the New Record button.

3 In the Account Call form, complete the necessary fields.

Field Comments

Name The account to be visited during this call. Make a selection from the Pick 
Account dialog box.

Site A unique location identifier that distinguishes this account from any other 
accounts with the same name. 

Smart 
Call

The Smart Call template to be associated with this call. Make a selection from 
the Pick Smart Call dialog box. 

A Smart Call is a template that you apply to contact calls that defines 
information about the products detailed, samples and promotional items 
distributed, and issues discussed on a call. After you apply a Smart Call 
template to a call, you can make additional edits. 

Status The status of this call. The default value is Planned. You cannot select the value 
Submitted. To change the status of the call to Submitted, you must submit the 
call. For more information, see “To submit a completed account call” on 
page 165. 
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To delete unused account call records created with the Auto Call button

1 Navigate to the Accounts screen.

The My Accounts screen appears.

2 Tap the Auto Update button.

NOTE: Performance will be affected if you select Auto Update when you have more than one 
unused auto-created call. Users are advised to have no more than three unused auto-created 
calls when using the Auto Update feature. 

To delete unused attendee calls created with the Auto Call button

1 Navigate to the Account Call screen, and from the Show drop-down list, select Attendees.

2 Tap the Auto Update button. 

NOTE: Performance will be affected if you select Auto Update when you have more than one 
unused auto-created call. Users are advised to have no more than three unused auto-created 
calls when using the Auto Update feature. 

Recording Account Calls in Siebel 
Pharma Handheld
Account calls are used to track a planned or past call activity with an account. You can enter account 
call details directly in Pharma Handheld. 

To record an account call, users must complete the following procedures:

■ Enter information on products detailed.

■ Enter attendee information (the names of contacts met and any samples dropped).

■ Enter information about any activities related to the call (optional).

■ Submit the call.

The next sections explain how to perform each of these tasks. You must set up your personal lists 
before you can complete this procedure. For more information, see “Creating Personal Lists in Pharma 
Handheld” on page 154.

To enter products detailed information for an account call

1 Navigate to the Account Call screen, and select the desired account call.

2 From the Show drop-down list, select Details.
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3 In the Details list, add a record for each product detailed during the call, and complete the 
necessary fields.

Some of the fields are described in the following table.

To enter attendee information for an account call

1 Navigate to the Account Call screen, and select the desired account call.

2 From the Show drop-down list, select Attendees.

3 Tap the Attendee list, to select it.

4 On the toolbar, tap the New Record button to add a new record for each attendee.

NOTE: The pick list will, by default, only show contacts that are affiliated to the chosen Account. 
To show all contacts regardless of affiliation, tap the All Contacts button in the Pick Contact list. 

5 Complete the fields for each attendee.

a In the Last Name field, tap the drop-down list arrow. 

b From the Pick Contact dialog box, select those contacts you want to add as attendees.

The application creates an attendee call record (similar to a contact call) for each contact you 
include as an attendee of the account call. These attendee call records are child records of 
the account call and can be accessed by going to the Account Call and finding the associated 
attendee. Drilling down on the attendee last name hyperlink enable you to navigate to and 
access the appropriate attendee call details view. 

6 To create an attendee call, do one of the following:

■ Select the Auto Call button to populate the attendee call with items from the personal lists, 
and then select Calls from the Show drop-down list. 

After selecting Auto Call, the Status field in the Accounts view displays “Auto-Created.”

■ Drill down on the Last Name hyperlink and complete the fields in the Contact Calls details.

NOTE: You must set up your personal lists before you can complete the next step. For more 
information, see “Creating Personal Lists in Pharma Handheld” on page 154.

To submit a completed account call

1 Navigate to the Account Call screen, and select the desired account call.

NOTE: You cannot submit a call with a future date. 

Field Comments

Indication The purpose or therapeutic area for which a drug is designed.

Priority Priority of this product relative to others discussed during the call.

Name The product detailed during the call. The products appearing in this drop-down list 
are based on the products added to your Personal List.
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2 Verify that the information for the Account Call is accurate and complete.

For more information, see:

■ To enter products detailed information for an account call on page 164

■ To enter attendee information for an account call on page 165

CAUTION: If you are a mobile user, submit your calls before connecting to the server, and then 
synchronize. Mobile users should not submit calls while connected to the server or they run the 
risk of introducing errors into their inventory counts.

3 In the Account Call form, select Submit.

If the call passes all of the validations, the application:

■ Creates a samples disbursement transaction with a line item for each dropped sample 
recorded for the call.

■ Submits a disbursement transaction to update the samples inventory. If the submission of 
the disbursement transaction is successful, the application changes the call's Status field to 
Submitted.

■ Sets many fields in the call record to read-only.

NOTE: If attendees are recorded in an account call, an attendee call is created for each attendee, 
and the process described above is performed for each attendee call. Attendee calls are the same 
as contact calls except that they do not appear in the Activities view and they are submitted 
automatically when the account call is submitted. 

Creating General Activities in Siebel 
Pharma Handheld
Sales representatives use general activities to manage time and schedule demands and to keep their 
manager informed of their workload. A general activity in Pharma Handheld is used to track non-call 
tasks such as to-do items, personal events, and correspondence.

In a typical scenario, a sales manager for a pharmaceutical company uses the Activities screen to 
create and track the activities on which she plans to spend her time during the next month. After 
scheduling a contact call with a customer, she uses the Calendar to review scheduled activities for 
the upcoming weeks.

This section provides procedures for adding activities from the Activities and Calendar views.
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Adding General Activities from Activities in Pharma 
Handheld
All activities with valid dates and times appear in the Pharma Handheld Calendar views as well as in 
the Activities views. The Calendar views provide a visual representation of each user’s scheduled 
activities. 

NOTE: The Planned Start and Duration fields in general activities and appointments must contain 
entries in order for the appointments and activities to appear in the correct time period in the Daily 
Calendar view. While the Planned Start field is visible in the Activities screen’s My Activities view, 
this field is not visible in the Contacts screen’s Activities and Accounts > Activities views. The Planned 
Start field can be exposed during application configuration.

To add a general activity from the Activities view

1 Navigate to the Activities screen.

The My Activities list appears.

2 On the toolbar, tap the New Record button.

3 In the new row, complete the necessary fields. 

NOTE: Select More Info from the Show drop-down list to edit additional fields for each record.

Some of the fields are described in the following table.

Field Comments

Activity Activities entered here are set as “General” and are not editable. Calls created 
from the New Call button are set as “Contact Call” or “Account Call” depending 
on whether these calls were created for a contact or an account. Previously 
created Contact Calls and Account Calls are displayed on the Activities view. 

Activity Type The type of activity. The values displayed in this drop-down list depend on the 
value of the Activity field. For example, the activity types that you can select 
for a contact call are different from those that you can select for a general 
activity. 

Assigned To The sales representative responsible for the activity. The Assigned To field in all 
Activities views (Activities, My Activities list; Activities, More Info form; 
Contacts, Activities list; and Accounts, Activities list) is read-only. 

Duration The length of time, in minutes, that you expect the activity to take.

Last Name The last name of the contact associated with the activity. The Last Name field 
on the Activities, My Activities view and the Accounts, Activities view is read-
only. 
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Adding General Activities Using Calendar in Pharma 
Handheld
General activities and appointments must have the Planned Start and Duration fields populated in 
order to be displayed in the correct time slot on the Daily Calendar view.

To add a general activity in the Calendar view

1 Navigate to the Calendar screen.

2 From the Show drop-down list, select Daily, Weekly, or Monthly.

3 For Weekly or Monthly, select the day and time on which you want to schedule a general activity.

4 On the toolbar, tap the New Record button or double-tap on a row. 

5 In the new record, complete the necessary fields.

Some of the fields are described in the following table.

6 To specify contact participants:

a From the Show drop-down list, select Contact Participants.

b Tap the Contacts list to select it.

c On the toolbar, tap the New Record button.

d In the Add Contacts dialog box, select participants and then tap OK.

7 To specify employee participants:

a From the Show drop-down list, select Employee Participants.

b Tap the Employee Participants list to select it.

c On the toolbar, tap the New Record button.

d In the Add Employees dialog box, select participants, and then tap OK.

Field Comments

Account Complete this field if the activity is related to a particular account. 

Planned Start If you started from the Daily Calendar view, this date reflects the time 
selected when you created the new appointment. If you started from the 
Weekly Calendar or Monthly Calendar view, the first time slot of the day is 
supplied.

Type The type of activity. The values displayed in this drop-down depend on the 
kind of activity. 

Repeat Checking this box allows you to set the end date of a repeating 
appointment (Until). If you do not select a value, 12 more appointments 
will be scheduled. 
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Managing Samples in Siebel Pharma 
Handheld
Most pharmaceutical manufacturers provide free samples to health care professionals in an effort to 
influence the prescribing habits of physicians and accounts across the United States and the world. 
In the United States, samples distribution is regulated by the FDA and must be reconciled at least 
once a year. 

Pharma Handheld maintains a samples transaction record for samples transfer, receipt, 
disbursement, order, and inventory adjustment. The application assigns each samples transaction 
record a unique identifier for tracking purposes. Depending on the type of transaction, you can 
display this identifier as a transaction number, an order number, an invoice number, or a transfer 
number. 

This section describes managing and maintaining an electronic inventory of samples and promotional 
items within Pharma Handheld. As part of managing samples, you can track an electronic inventory 
of samples stock, create request orders and transfers for samples, and acknowledge receipt of 
sample transfers directly in Pharma Handheld. You can use either Siebel Pharma or Siebel Pharma 
Handheld to manage your samples, however you cannot use both applications to handle samples 
transactions. Reconciling inventory must be performed in Siebel Pharma. This section includes the 
following topics on managing samples in Pharma Handheld. 

■ “Keeping Server and Handheld Samples Records in Sync” on page 169

■ “Scenario for Managing Samples in Pharma Handheld” on page 170

■ “How Siebel Samples Management Works with Calls” on page 171

■ “About Pharma Handheld Inventory Periods” on page 172

■ “About Establishing an Initial Inventory Count in Pharma Handheld” on page 172

■ “About Pharma Handheld Samples Views” on page 174

■ “Creating a Samples Order in Pharma Handheld” on page 175

■ “Creating a Samples Transfer in Pharma Handheld” on page 176

■ “Acknowledging Receipt of a Samples Transfer in Pharma Handheld” on page 177

■ “Adjusting a Samples Transaction” on page 178

Keeping Server and Handheld Samples Records in Sync
Administrators can manage samples inventory using either Siebel Pharma Handheld or Siebel 
Pharma, but should not use both. In order to keep samples inventories in sync, end users should be 
prevented from submitting a samples transaction on the server when the same record is still editable 
on their handheld device.

When a user submits a record, the status changes to Submitted and it becomes read-only, meaning 
no additional operations are allowed on the record. By updating a user property and writing two small 
Visual Basic scripts, you can specify that synchronized records are also read-only. 
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■ First, the administrator changes the value of the user property “Update Status To Synchronized” 
to Y. 

Making this change invokes the UpdateStatusToSynchronized method on the Sample Txn 
business component. 

■ Then, the administrator writes a small Visual Basic script for this method to change the status 
on the Sample Txn to “Synchronized.” 

■ Finally, the administrator writes another Visual Basic script to specify that the record becomes 
read-only when its status changes to “Synchronized.” 

This prevents users from accidentally submitting the sample transactions on the server while the 
same record is still editable on their handheld device.

NOTE: Sample transactions are not logged upon submitting a sample drop. They only appear on 
the handheld device after syncing.

Scenario for Managing Samples in Pharma Handheld
This scenario is an example of a workflow performed by an end user. Your company may follow a 
different workflow according to its business requirements.

Near the end of the quarter, a sales representative in the U.S. prepares for FDA-mandated inventory 
reconciliation. She is required to take a physical inventory of her samples and make sure the 
quantities match the electronic inventory. To do so, she needs to make sure that all her sample 
transactions are up-to-date for the current period before submitting the inventory count.

The sales representative remembers that she made a sample disbursement mistake earlier in the 
day. She accidentally had a physician sign for 10 samples when she really only dropped off five. 
Therefore, she needs to make a samples adjustment for this transaction. 

In Pharma Handheld, she finds the sample transaction record. Then, she selects the adjust quantity 
feature, which automatically shifts the transaction status to “In Progress” for the new adjustment 
record and to “Adjusted” for the already-submitted sample transaction. When she submits the 
adjustment record, Pharma Handheld updates her inventory to reflect the lower quantity that was 
disbursed and changes the sample quantity for the actual call from ten to five.

The sales representative also had some samples that had expired, which she physically mailed back 
to her samples administrator. She now has to record this transaction into her electronic inventory. 
In the Samples Transfer view, she creates a new record. Then she adds three new sample line item 
records and selects the Submit button. This changes the status to submitted, locks the records, and 
updates the handheld inventory to reflect the transfer.

The sales representative is now ready for the actual inventory count. While physically standing in her 
personal samples closet with her handheld device, she opens the Samples Inventory Count view. 
From this view, she sees the products listed in her personal inventory according to the electronic 
count. She goes down the list, product by product, lot by lot, counting each product and lot number 
combination. 
Siebel Pharma Handheld Guide Version 7.8170 ■



Using Pharma Handheld ■ Managing Samples in Siebel Pharma Handheld
She enters the actual quantity that she finds into Pharma Handheld and notices that the application 
automatically updates the difference field to reflect discrepancies between the on-hand and 
electronic inventory. When she is finished, she verifies that the differences are zero. She is now ready 
to submit her inventory count. Submitting causes a new inventory period to open, displaying the 
current date and time.

How Siebel Samples Management Works with Calls
This section describes how Siebel Samples Management works with the Contact Call Detail and 
Account Call Detail views. For more information on recording calls, see “Planning and Recording Calls 
in Siebel Pharma Handheld” on page 151. 

When you select the Submit button in either the Contact Call and Account Call forms, the application 
verifies that:

■ The call’s date and time is the same as or earlier than the current date and time. A call cannot 
be submitted with a future date.

If dropped samples are recorded for the call, the application checks that:

■ The Ref# field is not empty. This is controlled by the user properties setting. If the user property 
for reference number required is set to Y, then the application displays an error message if this 
field is not populated by the user. Otherwise, the application will automatically populate this field. 

■ The samples exist in the inventory for the period indicated by the call’s date and time.

■ The period into which the samples will be recorded is an unreconciled period. If it is a reconciled 
period, a warning message appears.

■ A valid lot number has been specified for dropped samples tracked by lot number.

If the call passes these checks, the application:

■ Creates a samples disbursement transaction with a line item for each dropped sample recorded 
for the call. 

■ Submits a disbursement transaction to update the samples inventory. If the submission of the 
disbursement transaction is successful, the application changes the call’s Status field to 
Submitted. 

■ Converts many fields in the call record to read-only. 

An administrator can change the fields that become read-only after a call is submitted. 

NOTE: If attendees are recorded in an account call, an attendee call is created for each attendee, 
and the process described above is performed for each attendee call. Attendee calls are the same 
as contact calls except that they do not appear in the Activities view and they are submitted 
automatically when the account call is submitted. 
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About Pharma Handheld Inventory Periods
Siebel Samples Management provides three types of inventory periods for maximum flexibility. These 
period types are described in Table 36.

About Establishing an Initial Inventory Count in Pharma 
Handheld
Establishing an initial master inventory is only necessary if you are manually entering and tracking 
samples. Either an administrator or an end user may establish an inventory. However, because Siebel 
Samples Management routes and maintains transactions by Employee ID, only the user who creates 
an inventory (the initial inventory count) can create or manipulate that inventory. 

Before adding products to the master inventory, you must verify that the products are correctly 
defined for inventory tracking. In particular, make sure that the products are Orderable and have 
either Inventory or Lot # tracking. 

NOTE: End users do not need to perform the procedures described in this section if their initial 
counts consist only of samples transfers routed to them by their samples administrator. Instead, they 
should simply acknowledge the receipt of those shipments. For more information, see “To 
acknowledge receipt of a samples transfer” on page 177. However, end users do need to perform the 
procedures described in this section if their initial counts contain any records that they entered 
manually. End users who enter records manually must submit those counts and reconcile the initial 
inventory period.

To establish an initial master inventory:

■ Count products on hand. Establish an inventory count by physically counting the products 
currently on hand. This process creates a list of the products in your inventory and an inventory 
period solely for your initial count. 

■ Add products and submit count. Add products to the inventory and submit an initial count. 
(See “To add products to inventory and submit an initial count” on page 173.)

Table 36. Samples Inventory Periods

Period 
Type Description

Active The current period; it shows no end date and it is not reconciled. You can enter any 
type of samples transaction, including adding new products; inventory counts will be 
adjusted accordingly.

Inactive A past, unreconciled period; it shows an end date but has not been reconciled yet. 
Except for adding new products into inventory, you can enter any type of samples 
transaction.

Reconciled A past, inactive period; reconciled periods will not display on the handheld 
application.
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■ Submit adjustments. Create and submit adjustments for the initial count. For more 
information, see “To create and submit initial count adjustments” on page 173.

■ Reconcile. Reconcile the initial inventory period using Siebel Pharma. For more information, see 
Siebel Life Sciences Guide. 

To add products to inventory and submit an initial count

1 Navigate to the Samples Adjustments screen.

The Inventory Count list appears.

2 On the toolbar, tap the New Record button to add a new row.

3 Complete the necessary fields. 

NOTE: Some of the fields are described in the following table. Users cannot sort on the 
Difference and On Hand Qty fields in the Inventory Count applet.

4 Tap Submit.

The Difference field is cleared for all records. The application transfers the number you entered 
in the Count field to the On Hand Quantity field and clears the Count field. 

Once you submit an initial count, the Siebel Samples Management deactivates the inventory 
period into which you entered your initial counts and creates a new active inventory period. You 
can view this change using the My Samples History filter.

5 From the Show drop-down list, select Samples History.

The Samples History view appears. The inventory period into which you entered your initial 
counts becomes inactive—a date and time appear in the End Date field, and there is no check 
mark in the Active field. In addition, a new active period has been opened. 

NOTE: You cannot submit an adjustment transaction if the product is not currently active. Siebel 
Samples Management considers a product inactive if the administrator has made it inactive, or 
the product does not exist in the inventory count list. 

To create and submit initial count adjustments

1 Navigate to the Samples Adjustments screen.

2 From the Show drop-down list, select Adjustments.

The Samples Adjustments list appears.

Field Comments

Count The amount of your initial inventory.

Difference Shows a negative number after you enter a value in the Count field. 

Lot The lot number for this sample.

Sample The name of the sample to be added.
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3 On the toolbar, tap the New Record button add a new record.

The Sample Adjustment Details form and list appear.

4 Complete the necessary fields. 

Some of the fields are described in the following table.

5 From the Show drop-down list, select the Adj. Details view.

6 On the toolbar, tap the New Record button.

7 Complete the necessary fields. 

Repeat the previous steps to enter a line item for each sample needing adjustment.

8 Tap Submit.

The values in the Transaction Status field (in the Samples Adjustment form) and the Item Status 
fields (in the Line Items list) change to Submitted. 

NOTE: You must reconcile adjustments using Siebel Pharma. For more information, see Siebel Life 
Sciences Guide.

About Pharma Handheld Samples Views
Pharma Handheld contains these main screens related to sample management:

■ Samples. Navigate to this screen to display a history of samples and an inventory list.

■ Samples Adjustments. Navigate to this screen to adjust sample transaction records, such as 
correcting quantities dropped off, or to display your on-hand inventory count.

■ Samples Receipts. Navigate to this screen to acknowledge the receipt of a samples transfer or 
to display a list of receipts, and to review receipt details.

■ Samples Transfers. Navigate to this screen to create a transfer, to display a list of transfers to 
or from your inventory, and to review transfer details.

■ Samples Orders. Navigate to this screen to create an order for samples, to display a history of 
orders, and to review order details.

Field Comments

Txn. # Transaction Number. The application automatically generates an 
unique identifier. You can change this value.

Txn. Date Transaction Date. The date of the adjustment transaction. Make sure 
that this date falls within the valid date ranges for the appropriate 
Inventory Period.

Adj. Reason Adjustment Reason. Select Initial Count from the drop-down list.

Status The application automatically changes this field value to Submitted 
when you submit the adjustment.
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Creating a Samples Order in Pharma Handheld
You can request additional samples by creating a samples order using Pharma Handheld. 

After synchronizing, Siebel Pharma routes the samples order to the samples administrator. The 
samples administrator then creates a samples transfer that is routed back to the requestor. After the 
requestor acknowledges receipt of the transfer, Siebel Samples Management automatically enters 
the new inventory into their inventory counts.

To create a samples order

1 Navigate to the Samples Orders screen.

The Orders list appears.

2 On the toolbar, tap the New Record button.

3 In the new record, complete the necessary fields.

The application automatically sets the Order Date field to a date and time in the active period. 
It also automatically generates values for the Order # field, but it can be edited. You might want 
to edit this value to have the items appear in a particular order (other than the order in which 
you entered them).

NOTE: It is not necessary to change the Order Type field. You can include both samples and 
promotional items in a single order.

4 Drill down on the Order # hyperlink.

5 Tap the Samples Order Details list to select it.

6 On the toolbar, tap the New Record button.

7 Complete the necessary fields for the new record. 

Some of the fields are described in the following table.

8 Repeat the previous steps to enter a line item for each product or promotional item you want to 
order. 

9 Tap Submit. 

NOTE: You cannot modify or delete an order after it has been submitted.

The values of the Status field (in the form) and the Item Status field (in the list) change to 
Submitted. 

Field Comments

Sample The product to be ordered. Tap the arrow in the Sample field, choose the 
product from the Pick Product list, and then tap OK.

Quantity The sample quantity that you are ordering.

Item Status Initially set to In Progress. The application automatically changes this field 
value to Submitted when you submit the transaction.
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Creating a Samples Transfer in Pharma Handheld
You can create a samples transfer to exchange samples between one another or to return samples 
to the home office. 

After the samples transfer is submitted into the system, the recipient receives a samples transfer. 
After the recipient acknowledges the receipt of the transaction, the application enters the new 
inventory into his or her inventory count.

NOTE: Samples returns are defined as transfer transactions for which corresponding received 
shipment transactions have not been created. Returned samples are subtracted from the sender’s 
inventory counts but are not added to the master inventory, as they are typically expired or damaged 
products.

To create a samples transfer

1 Navigate to the Samples Transfers screen.

The Transfers list appears.

2 On the toolbar, tap the New Record button.

3 In the new row, complete the necessary fields. 

Some of the fields are described in the following table.

4 Drill down on the Transfer # hyperlink.

Field Comments

Transfer # The application automatically generates a unique identifier. You can change 
this value. 

Transfer Date The application automatically generates a date and time value that falls in the 
active period. 

Transfer Type Select the appropriate value:

■ Transfer Out - Indicates you are transferring samples to another 
employee.

■ Return - Indicates you are returning samples to the home office. Samples 
are typically returned because they are expired or damaged products that 
should be destroyed. Transfers with the Transfer Type field set to Return 
do not generate shipment transactions (because there is no recipient), 
and they are not added to the master inventory counts.

Status The application automatically changes this field value to Submitted when you 
submit the transaction.

Transfer Lst 
Name

Transfer Last Name. The employee to whom you are transferring the samples. 
If the value of the Transfer Type field is Transfer Out, then you must complete 
this field. Leave this field empty if the value of the Transfer Type field is 
Return. 
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5 Tap the Sent Samples Details list to select it.

6 On the toolbar, select the New Record button.

7 In the new row, complete the necessary fields. 

Some of the fields are described in the following table.

8 Repeat the previous steps to enter a line item for each product or promotional item you are 
transferring. 

9 Tap Submit.

NOTE: You cannot modify or delete a transfer transaction after it has been submitted. The 
transaction will appear in the Samples History list as part of the Inventory List view.

Acknowledging Receipt of a Samples Transfer in Pharma 
Handheld
Siebel Samples Management supports two ways of electronically moving samples inventory:

■ By creating a samples transfer (see “Creating a Samples Transfer in Pharma Handheld” on 
page 176.) 

■ By creating a samples order (see “Creating a Samples Order in Pharma Handheld” on page 175.)

In either case, the application creates a samples transfer transaction and routes it to the recipient 
for acknowledgement. After the recipient submits a receipt, the application transfers the new 
inventory into the recipient’s active inventory period. You can then view the new inventory in the 
Samples History view. 

To acknowledge receipt of a samples transfer 

1 Navigate to the Samples Receipts screen.

2 In the Samples Receipts view, drill down on the Invoice # hyperlink.

The Receipts Details view appears. In the form, samples transfers that have not been 
acknowledged as received show an Invoice Status value of In Progress. Those that have been 
acknowledged as received show an Invoice Status value of Submitted. 

Field Comments

Sample The samples being transferred.

Quantity The quantity that you are transferring.

Lot # The lot number for this samples transfer.

Item Status The application automatically changes this field value to Submitted when 
you submit the transaction.
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3 In the Receipts Details list, modify the Received Quantity field if the value does not accurately 
reflect the quantity received. 

4 Tap Submit. 

NOTE: The samples transfer quantities do not appear in end users’ inventory counts until they 
submit a samples receipt. However, after the samples receipt has been submitted, it cannot be 
modified or deleted. 

The values in the Invoice Status field (Received Samples list) and the Item Status field (Line 
Items list) change to Submitted. 

5 To verify the submitted transfer was recorded:

a Navigate to the Samples screen.

b From the Show drop-down list, select Samples History.

The Samples History view appears. 

c Highlight the appropriate inventory period to view the line items of the received transfers.

Adjusting a Samples Transaction
You can adjust inventory counts of samples stock by making adjustments to past samples 
transactions directly in Pharma Handheld. Common reasons for adjusting past transactions include 
product loss or expiration, counting mistakes, or data entry errors. End users can add products or 
adjust quantities for any type of samples transaction (disbursement, transfer, order, and so on). 

NOTE: End users cannot add a product to your inventory that did not exist when the original 
transaction was created. 

The inventory list view displays all the samples for the selected inventory period. 

To add a product to a samples transaction

1 Navigate to the Samples screen.

The Samples History list appears.

2 In the Inventory Periods list, select the period containing the transaction.

3 In the Sample History list, select the transaction you would like to update. 

You can identify the transaction record in the Samples History list by the Transaction Date, Last 
Name, or Transaction # field values. 

NOTE: To make it easier to find a transaction, sort the records in the Samples History list by the 
field you are using to identify the transaction. For example, if you know the Transaction #, sort 
the list by that field to locate the records you are looking for. 

4 In the Samples History list, tap Add, and then tap OK. 
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5 In the new row, complete the necessary fields.

When you add a record, the application adds a new line-item record for the transaction in the 
Samples History list and sets the line-item record’s Item field Status to In Progress. With the 
exception of the Item Status value, the new record is a copy of the record selected in the previous 
step.

Some of the fields are described in the following table.

To adjust a quantity in a samples transaction

1 Navigate to the Samples screen.

The Samples History screen appears.

2 In the Inventory Periods list, select the period containing the transaction. 

The samples for the selected period are displayed in the list below.

Field Comments

Item Status The application automatically changes this field value to Submitted when you 
submit the adjustment.

For any row that shows an item status of Submitted, you can also see one or 
more rows with the identical sample name and transaction number but with 
an item status of In Progress or Adjusted. 

Valid values include:

■ In Progress - Indicates that the adjustment record has not yet been 
submitted, so it can still be modified. However, the record’s data is not 
reflected in the inventory count.

■ Submitted - Indicates that the record has been submitted and therefore 
cannot be modified. Since it has been submitted, the record’s data is 
reflected in the inventory count.

■ Adjusted - Indicates that a previously submitted record has been 
superseded by a subsequent adjustment record. The record cannot be 
modified.

Lot # The correct lot number for this sample. Select the Add button to update this 
field.

Sample Verify that the correct product name is selected. Select the Add button to 
update this field.

Transaction # The transaction number or, in the case of samples disbursements, the 
reference number. The Transaction # value corresponds to the Ref # value 
displayed in the Contact Call Detail view.

Transaction 
Type

Displays the type of transfer. Valid values include Transfer Out and Transfer 
In.
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3 In the Samples History list, select the transaction you would like to update. 

You can identify the transaction record in the Samples History list by the Transaction Date, Last 
Name, or Transaction # field values. 

4 Tap Adjust Qty and then tap OK. 

The application copies the line-item record for the transaction in the Samples History list and sets 
the line-item record’s Item Status field to In Progress.

5 In the Samples History list, enter the correct quantity in the Quantity field.

6 Tap Submit, and then tap OK. 

The application adds the new item with an Item Status of Submitted and changes the original item 
record (whose quantity you adjusted) to an Item Status of Adjusted. The new quantity is reflected 
in the on-hand quantities in the Inventory Count view.

Setting Up MedEd Events in Siebel 
Pharma Handheld
This section describes how a pharmaceutical company can use Pharma Handheld to plan a medical 
education (MedEd) event. A MedEd event refers to a promotional or educational event attended by 
physicians and medical professionals. An event functions as a forum for exchanging information on 
a particular disease, illness, therapeutic class or product. A medical education event can be as simple 
as a lunch-and-learn in a physician's office or as complex as a seminar series or national sales 
meeting. 

Sales representatives in the field can use Pharma Handheld to view and create MedEd events and 
invite contacts to MedEd events. The following section provides instructions for MedEd procedures. 

■ Creating a MedEd Event in Pharma Handheld on page 180

■ Inviting Professionals to MedEd Events Using Pharma Handheld on page 181

Creating a MedEd Event in Pharma Handheld
You can create MedEd events directly in Pharma Handheld. 

To create a MedEd event

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select My MedEd Events.

3 On the toolbar, select the New Record button. 
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4 In the new list, complete the necessary fields. 

Some of the fields are described in the following table.

Inviting Professionals to MedEd Events Using Pharma 
Handheld
When you have scheduled a MedEd event and have decided what sessions will be offered, you can 
invite health care professionals to attend. 

To invite a contact to a MedEd event

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select Invitees.

3 Tap the Contacts list to select it.

4 On the toolbar, select the New Record button.

5 In the new row, complete the fields.

Some of the fields are described in the following table.

Field Comments

Budget The amount of money budgeted for the event. 

CME Credit Number of CME (Continued Medical Education) credits that can be earned at 
the event. 

Created By User name for the person who created the MedEd event.

End Date Date and time that the event ends. Set the time fields before selecting a 
calendar day. 

Start Date Date and time that the event starts. Set the time fields before selecting a 
calendar day. 

Event Status Indicates whether the event is active, cancelled, completed, in progress, 
inactive, or planned. 

Type The category of medical education event being offered. 

Field Comments

First Name Completed based on the last Name selection.

Last Name The contact/invitee. Select from the Pick Contact list.

Invitee Status Indicates whether the invitee has confirmed attendance, is on a wait list, and 
so on. Pending is the default value.

Role  Describes the selected contact’s role at the session.
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Creating Expense Reports in Siebel 
Pharma Handheld
You can track expenses and create expense reports using Pharma Handheld.

To create an expense report

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 On the toolbar, tap the New Record button.

4 In the new row, complete the necessary fields.

5 From the Show drop-down list, select More Info to view additional fields.

NOTE: You must complete the Submit To field or you will get an error message and your expense 
report will not be saved.

To add detailed line items

1 Navigate to the Expense Reports screen. 

2 From the Show drop-down list, select My Expense Reports.

3 In the Expense Reports list, drill down on the Name hyperlink. 

4 Tap the Line Items list to select it.

5 On the toolbar, tap the New Record button. 

6 In the new row, complete the necessary fields.

You can enter Line Items whose Start or End Date is outside of the Expense Report period. 

7 Repeat Step 4 through Step 6 to add line items. 
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A Troubleshooting
This appendix addresses some of the common issues faced while deploying Siebel Handheld. The 
appendix presents troubleshooting tips in three areas:

■ Installation

■ Performance

■ Log Files

The audience for this appendix is Siebel database administrators, system administrators, and 
application administrators.

■ “Installation” on page 183

■ “Synchronization” on page 184

■ “Log Files” on page 186

■ “SQLTrace” on page 188

■ “End User Error Messages” on page 189

■ “Web Server Timeout Errors” on page 189

■ “Handheld Device Timeout Errors” on page 190

■ “Performance” on page 190

Installation
Siebel Handheld supports a specific and limited set of devices, handheld OS, desktop OS, server OS, 
server databases, and languages. This range of devices and platform support varies widely across 
the range of Siebel Handheld releases and must be carefully checked to confirm support. See System 
Requirements and Supported Platforms on Siebel SupportWeb for your Siebel application for 
information on supported Handheld OS, desktop OS, server OS, and server databases.

Client Installation, Backup, and Restore
If you encounter problems while installing the Siebel Handheld application on client devices from a 
desktop PC, refer to the following checklist. Most installation problems are covered by this checklist.

■ Confirm that the device is certified and supported. Refer to System Requirements and Supported 
Platforms on Siebel SupportWeb.

■ Confirm that the device has 64 MB or higher of RAM with the majority of it available for the Siebel 
Handheld application.

■ Make sure an ActiveSync connection is running (green icon). If not, check your computer to make 
sure that the serial or USB port is activated and functioning correctly.
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Troubleshooting ■ Synchronization
■ If previous versions of Siebel Handheld were installed on the device, make sure you uninstall the 
application. See “Uninstalling the Siebel Handheld Application” on page 124.

Siebel Handheld binaries may also be installed to a CompactFlash card to conserve (RAM) memory. 
The application will still be loaded into memory when it executes. To install on the CompactFlash 
card, set the ApplicationBinariesLocation and ApplicationDataLocation parameters in the setup.ini 
file. See “Setting Up Siebel Handheld Application Installation on a CompactFlash Card” on page 107.

Siebel Handheld (application only - no data) may also be copied onto a CompactFlash card to aid in 
deployments. The initial backup image should be made of a device that has not done an initial 
synchronization. An initial synchronization will still be required by each user to receive the 
configuration and data. For information on backup utilities, see the documentation accompanying 
your handheld device.

It is also possible to back up Siebel Handheld on a PC using the Backup/Restore feature within 
ActiveSync.

Synchronization
Synchronization problems can be caused by incorrect settings in the Siebel Handheld setup.ini or .cfg 
files. Be sure that application names, data sources, and .srfs are correct.

Make sure to set the SyncURL setting in the client setup.ini file for all synchronization methods. Also, 
be sure to grant the user visibility to these views in the Administration - Application > Responsibilities 
view.

NOTE: Check the log files and confirm the accuracy of the generated connect string.

Companion Sync Checklist
Use the following list to troubleshoot problems you encounter using Companion Sync.

■ Is the latest version of ActiveSync (version 3.5 or later) installed and running?

■ Is ActiveSync connected (green icon)?

■ Do you have the correct data source defined in the handheld .cfg file?

■ If you have problems logging in, check to make sure that you can use the same credentials to 
log into the desktop client.

■ Remember to keep a 1:1 ratio of users to devices. Only a single user may log in to sync each 
device. Failure to do so causes data corruption.

When using a SRF with a custom configuration and the sync error occurs during initialization, follow 
the steps below to troubleshoot problems:

To troubleshoot Companion Sync configuration errors

1 Add HandheldSyncLogLevel = 5 to the [pda] section in the .cfg and look for more error details 
in the CompSync log.
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2 Use the Validate function in Siebel Tools to look for a configuration error.

3 Remove handheld views from user responsibility until synchronization passes the error point.

4 Remove DefaultBusObjs from Administration - Mobile > Application Administration > Settings 
until synchronization passes the error point.

Direct Server Sync Checklist
Use the following checklist to troubleshoot problems you encounter using Direct Server Sync.

■ Did you install all client and server components successfully?

■ Is there a PDA object manager (OM) running on the Siebel Server?

■ Did you bounce the IIS, SWE, and Siebel Server after installation?

■ Do you have network access to the URL for DSS? Can you ping the IIS server from inside and, if 
applicable, from outside the firewall?

■ Can you successfully run a SWE command?

■ Do you have the correct SyncURL defined in the setup.ini file?

■ Is the network connection working from the device? Try Pocket Internet Explorer.

■ If you have problems logging in, check to make sure that you can use the same credentials to 
log into the desktop client.

■ Remember to keep a 1:1 ratio of users to devices. Only a single user may log in to sync each 
device. Failure to do so causes data corruption.

When using a SRF with a custom configuration and the sync error occurs during initialization, follow 
the steps below to troubleshoot problems:

To troubleshoot Direct Server Sync configuration errors

1 Turn on Handheld Sync logging to 5 and look for more error details in the Siebel Handheld 
Synchronization OM log. For more information, see “Configuring Direct Server Sync Logging 
Levels” on page 98.

2 Use the Validate function in Siebel Tools to look for a configuration error.

3 Remove handheld views from user responsibility until synchronization passes the error point.

4 Remove DefaultBusObjs from Administration - Mobile > Application Administration > Settings 
until synchronization passes the error point.
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Re-synchronizing Problems
Generally if, for whatever reason, synchronization is terminated, the end user is prompted with a 
message and the synchronization process ends. In this situation the synchronization session is 
allowed to close. However, if the connection with the server is unintentionally broken, the session 
may not have a chance to close before the connection is broken. Therefore, if the end user tries to 
immediately synchronize again, he may get an error message and may not be able to synchronize. 
Should this occur, the end user should wait for a period of time (generally, 15 minutes) to allow the 
session to time out and terminate. Once the session terminates, the end user should be able to 
synchronize again.

Log Files
This section includes the following topics:

“Direct Server Sync Log and Output Files” on page 186

“Companion Sync Log and Output Files” on page 187

“Handheld Device Log” on page 187

Direct Server Sync Log and Output Files
The name of the Direct Server Sync Log is the OM name plus the task ID for that log session. The 
log is found in the log subdirectory under the Siebel root directory. Depending on the amount of detail 
enabled, this file can give a good perspective of what has happened during synchronization regarding 
the Siebel OM.

To assist Siebel Technical Support, collect the following files when logging a Siebel Handheld service 
request. The following files are found on the machine where Siebel Server is installed:

■ All server sync user files in the Siebel Root\siebsrvr\hhsync\application directory\user id\node id 
directory.

■ Server application event log extract.

■ Server system event log extract.

■ All files in the Siebel Root\siebsrvr\log directory including CompName_task.log.

where CompName is the name of an application server component, and task is a Siebel task 
number. Each sync session is assigned a new Siebel task, so there will be many of these. An 
example "CompName" value is "SalesCE_enu" (note that language is part of the component 
name itself). 

■ All files from all subdirectories under the Siebel Root\siebsrvr\logarchive directory.

■ Server perfmon log files (showing memory, network, disk performance), if available.

The following files are found on the machine where the Web Server (that is, IIS) is installed:

■ SWE log files from Siebel Root\eappweb\log (all files).
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■ IIS server application event log extract.

■ IIS server system event log extract.

■ IIS server perfmon log files (showing memory, network, disk performance), if available.

Companion Sync Log and Output Files
The name of the Companion Sync Log is compsync.log. It is found in the log subdirectory under the 
Siebel root directory. Depending on the amount of detail enabled, this file can give a good 
perspective of what has happened during synchronization regarding the Siebel object manager.

■ Siebel Root\client\hhsync\application directory\user id\node id directory.

■ NT application event log extract.

■ NT system event log extract.

■ All files in the Siebel Root\client\log directory.

■ Perfmon log files (showing memory, network, disk performance), if available.

Handheld Device Log
The siebel_ log.txt file is found in the /Program Files/Siebel Handheld directory on the handheld 
device. It is controlled by reg key DefaultLogLevel, with values 0-4. For more information on values, 
see “Siebel Handheld setup.ini Parameters” on page 103.

The default value of the reg key during installation is 2. This file logs all of the following:

■ Database objects that were imported during synchronization. 

■ All SQL statements generated by the application. You must set a parameter in the setup.ini file 
to turn this log on. DefaultLogLevel=3 and 4 will log SQL statements to the device log. See 
“Siebel Handheld setup.ini Parameters” on page 103 for more information about setting the 
parameter.

■ All system error messages. You must set a parameter in the setup.ini file to turn this log on. 
DefaultLogLevel=4 will give the most detailed log with debug info. See “Siebel Handheld setup.ini 
Parameters” on page 103 for more information about setting the parameter.

■ All of the messages displayed on the Sync Manager dialog box as well as some basic information 
about synchronization, such as data source and connect string. You can set the logging level for 
this file using the DefaultLogLevel parameter in the setup.ini file.
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Logging Handheld Synchronization Errors
Siebel Handheld Sync logs all the strings that the user sees in the sync message window as well as 
many informational messages that do not get displayed in the UI. These informational messages are 
used to help track down where an error occurred. Siebel Handheld Sync determines which messages 
get logged based on a value stored in the registry under the key DefaultLogLevel. The values range 
from 0 to 4; 0 logs all error messages and strings that the user sees, and 4 logs all data that Siebel 
Handheld Sync sends and receives.

If Siebel Handheld Sync fails, check the siebel_log.txt file immediately after the failure. If you need 
more detail, increase the logging level of DefaultLogLevel and run Siebel Handheld Sync again. For 
more information on changing DefaultLogLevel, see “Siebel Handheld setup.ini Parameters” on 
page 103.

You can determine when and where an error occurs during handheld synchronization by referring to 
siebel_log.txt and the Handheld Sync Object Manager log.

The device log, siebel_log.txt, shows the last HTTP command that was sent to server, for example, 
ExecuteLogin, Init, ProcessTransactionEx, ExtractDB, and so on. The Handheld Sync Object Manager 
log receives the request and invokes the corresponding method.

For example, in the device log (siebel_log.txt), the following indicates that the device is sending an 
"Init" request to server:

INFO0x6F46107E03/30/2005 16:58:27http ://PPP_PEER:2323/phce/
start.swe?SWEExtSource=siebelpda&SWEExtCmd=Init&PatchLevel=7.7.2.2PDA%5b18356_1]       
8.471262E-309NU&SyncFormat=CE0&SyncNodeId=&TimeStamp=1112230707

INFO0x6F46107E03/30/2005 16:59:20<Init ReturnCode="OK" Complete="100">

The server log (Handheld Sync OM log, that is, CompNameObjMgr_enu_xxxxx.log), shows that the 
"Init" request is received by the server and the "Init" method is invoked:

ObjMgrBusServiceLogInvokeMethod402005-03-23 10:45:27Begin: Business Service 
'Handheld Synchronization' invoke method: 'Init' at 10c2bc68 

HandheldSyncLogDebug502005-03-23 10:45:27Request Init received

(Where “CompName” is the server component name of the handheld synchronization for the specific 
handheld application.)

In addition to the device log, customers should also check the  CompSync log in laptop (for 
Companion Sync) or SalesCEObjMgr_enu_xxxxx.log in Siebel Server (for DSS).  For more 
information on changing logging levels, see “Configuring Direct Server Sync Logging Levels” on 
page 98 and “Configuring Companion Sync Logging Levels” on page 99.

SQLTrace
Use SQLTrace for diagnostic purposes if you encounter serious configuration errors or performance 
problems and cannot otherwise diagnose the problem. The problem may quickly become apparent 
in the log entries from SQL tracing.
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To enable SQL tracing

1 Log into srvrmgr prompt. 

2 At the DOS prompt, run server manager (srvmgr) from the <siebsrvr/bin> directory:
srvrmgr /g gateway /e enterprise /u sadmin /p sadmin

3 Run: change evtloglvl ObjMgrSqlLog=4 for comp [OMName], where [OMName] = the OM name 
(for example, PhCEObjMgr_enu). 

4 Log entries are written as described in “Log Files” on page 186.

CAUTION: When SQL tracing is enabled, synchronization is severely and adversely affected. 
Therefore, it is recommended that you turn SQL tracing on for a limited time to diagnose a 
specific problem, then turn SQL tracing off.

End User Error Messages
In addition to errors found in the siebel_log.txt file, you might receive a Transaction Errors Reported 
message during synchronization. These errors are logged in TXNError.hh. The message appears on 
the handheld device in the Syncmanager Status box. You can double-click the message at any time 
to see the errors.

You can make the following settings in setup.ini:

TXNErrorLevel = 0 (no log information)

TXNErrorLevel = 1 (report txn errors in the client)

For more information on end-user messages, see “Synchronization Troubleshooting with the Siebel 
Handheld Client” on page 138.

Web Server Timeout Errors
If synchronization times are long due to the size of the database file or the speed of the network 
connection, your end users may encounter Web server timeout errors and synchronization failures. 
First try to resolve this problem by reducing the size of your extract and configuring your server 
performance. You can reduce the size of the extract by fine-tuning filters, or if appropriate filters 
have already been defined, select ones that will return less data. If after doing this, your end users 
continue to experience timeout errors, then increase the timeout parameter on IIS for the default 
Web Server.

Follow the procedure for your platform to change the timeout parameter.

To change the timeout parameter on Windows 

1 From the Start menu, select Programs > Administrative Tools > Internet Services Manager.

2 From the Internet Information Services window, select the local machine, right-click on the 
Default Web Site, and select Properties from the pop-up list.

3 From the Web Site Properties window, select the Web Site tab.
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4 Under the Connections heading, locate the Connection Timeout property and increase the 
number of seconds.

5 Click OK.

Handheld Device Timeout Errors
The following three parameters are stored in device registry. They control the device timeout. For 
more information on device timeout errors, see the following parameters in “Siebel Handheld setup.ini 
Parameters” on page 103:

■ InternetOptionReceiveTimeout = 600000

■ InternetOptionSendTimeout = 600000

■ InternetOptionDataExtractionTimeout = 600000

Performance
This section discusses ways you can optimize your client performance, server performance, and 
network performance.

Client Performance
Client performance is affected primarily by the device capability (minimum 206 MHz processor and 
64 MB RAM), configuration, and the quantity of data loaded onto the device. In general, screen-to-
screen and view-to-view navigation times of 3 to 4 seconds or less should be considered normal. 

It is strongly recommended that customers follow these general guidelines to optimize the 
performance of their handheld applications:

■ Keep configuration under 30 views.

■ Keep RML file size under 1.75 MB.

■ Keep database files (dbfile.txt) under 2 MB. 

Use filters as outlined in the Siebel 2000 Handheld Synchronization Technical Note.

■ Keep the number of records for each business component under 2,500.

■ Avoid installing other applications on the device at the same time.

■ Users should synchronize their data frequently.

Additional configuration information can be found in the Siebel Technical Note 405.

The Siebel Handheld client will benefit from periodic closing and restarting the application to release 
memory consumed by the handheld operating system. Use File > Exit in the menu to exit from the 
Siebel Handheld application.

If an external VGA driver is or has been loaded on the device in the past and is no longer needed, 
be sure to unload it, because it is known to have significant performance impacts on handheld 
devices.
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Server Performance
Server performance affects the performance and scalability of Direct Server Sync processes. 
Customers should engage Expert Services to do a Scalability Review. The following guidelines are 
general in nature and pertain to the Siebel Handheld Sync components running on a Siebel Server:

■ Use Performance Monitor to track memory and processor performance on the Siebel server.

■ Make sure that the Servers (IIS, GW, OM and DB) are on the same high speed LAN segment.

■ Siebel Handheld Sync components will stress Siebel Server and database performance because 
of the intensive interactions during large concurrent synchronizations.

■ Estimate that 64 MB is used per Siebmtsh.exe instance.

■ To calculate the theoretical maximum concurrent users:

■ Numusers=Server_Memory*threads_per_process_ratio/64 MB.

■ Optimize the Threads per Process Ratio (Max Tasks/Max MT Servers) per Technical Note 405. 

■ Set Max Tasks=Max. number of concurrent users (for example, 150).

■ Set MinMTServers=MaxMTServers (for example, 30 for 5:1 ratio, if this is determined to be 
appropriate).

To optimize and tune a Siebel DB server:

■ Use Performance Monitor to track memory and processor performance on the DB server.

■ Turn on SQL tracing and search for long-running SQL calls.

■ Estimate 64 MB of RAM for each concurrent user.

■ Consider creating indexes to tune the queries (only performed with the assistance of Siebel 
Expert Services).

■ Consider using a RAID 0+1 disk array with an expanded number of spindles to optimize database 
performance.

NOTE: Make sure that DB Server settings are set to recommended values. Timeouts should be set 
at the Siebel Server. Be careful that the timeout is set longer than the longest SQL query.

Network Performance
The condition of the network affects Direct Server Sync performance and scalability. In general, a 
low-latency, high-bandwidth network is preferred with dedicated rather than shared network 
connections. The following are general network considerations:

■ Make sure there is adequate bandwidth throughout the entire round-trip of network packets and 
estimate where bottlenecks will occur due to high concurrent load. For example, if 50 users are 
concurrently synchronizing 1 MB each, 50 MB of data must pass through the network. If this data 
is passing through a single leased 56 KB per second line, then this data will minimally take 
500,000 KB/56 KB/sec=8928 seconds=148 minutes. In reality, a 56 KB per second line will offer 
only 30-40 KB per second average throughput, which causes further bandwidth constraints. 
Check the total available bandwidth of network providers (private or public ISP).

■ Verify that you have low latency lines with ping round trips of less than 1 second (1000 ms) with 
no dropped packets.
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■ Verify if roundtrips occur with less than 10 hops.

■ Check the actual throughput of network connections by performing simple file transfers with no 
Siebel software.

■ VPN software from third parties accounts for 30 to 60 percent of additional packet overhead 
because of the encryption.

Network problems can usually be resolved by working with network providers to size network 
connections and optimize network routing. Consider the use of burst networks, quality of service 
contracts, private networks, and dedicated modem banks directly into a high-speed LAN 
environment. 
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Siebel Handheld Client supports a subset of the screens and views supported by the Siebel Web Client 
application. Other screens and views can be configured for your Siebel Handheld Client application 
if they are based on currently supported classes. Application developers and application 
administrators will find the information in this appendix useful.

If you configure screens and views based on unsupported classes, you may see anomalous results. 
For information on how to determine the classes used by other screens and views, see Object Types 
Reference.

Screens and Views
The screens and views shipped with the Siebel Pharma Handheld sample application are shown in 
Table 37.

Table 37. Siebel Pharma Handheld Screens and Views

Screen View Name on UI

Contacts My Contacts

Contacts More Info

Contacts Private Notes

Contacts Shared Notes

Contacts License Numbers

Contacts Activities

Contacts Calls

Contacts Affiliations

Contacts Best Time to Call

Contacts Addresses

Contacts Rx Data

Accounts My Accounts

Accounts Shared Notes

Accounts More Info

Accounts Private Notes

Accounts Activities
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Accounts Best Times to Call

Accounts Addresses

Accounts Calls

Accounts Affiliations

Accounts Sales Data

Activities My Activities

Activities More Info

Calendar Daily

Calendar Weekly

Calendar Monthly

Calendar Contact Participants

Calendar Employee Participants

Calendar Add/Modify Activity (note: not displayed from the drop-down menu)

Contact Call Details

Contact Call Promotional Items

Contact Call Issues

Contact Call Samples Dropped

Account Call Details

Account Call Attendee

Home Page Home Page

Personal Lists Details

Personal Lists Promotional Items

Personal Lists Samples

Med Ed My Med Ed Events

Med Ed Invitees

Expense Reports My Expense Reports

Expense Reports More Info

Expense Reports Expense Items

Samples Samples History

Samples Inventory List

Table 37. Siebel Pharma Handheld Screens and Views

Screen View Name on UI
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Samples 
Adjustments

Inventory Count

Samples 
Adjustments

Adjustments

Samples 
Adjustments

Adj. Details

Samples Receipts Receipts

Samples Receipts Receipt Details

Samples 
Transfers

Transfers

Samples 
Transfers

Transfer Details

Samples Orders Orders

Samples Orders Order Details

Table 37. Siebel Pharma Handheld Screens and Views

Screen View Name on UI
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C Business Components and 
Classes
Siebel Handheld Client supports a subset of the business components and classes supported by the 
Siebel Web Client application. This appendix lists the supported business components, business 
component classes, and applet classes.

■ “Supported Business Components for SiebelPharma Handheld” on page 197

■ “Business Component Classes” on page 200

■ “Applet Classes” on page 201

Supported Business Components for 
SiebelPharma Handheld
Table 38 lists the supported business components for Siebel Pharma Handheld.

Table 38. Siebel Pharma Handheld Business Components

Supported Business Components

Account

Account Contact Affiliation

Account Note

Account Private Note

Action

Action Contact

Action Employee

Admin SEA Field

CSLS Contact Best Times - CE

CUT Address - CE

CUT Address for Account/Contact

CUT Address Inter Table - CE

Com Organization

Contact

Contact Account Affiliation
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Contact (All)

Currency

Database Version

Decision Issue

Employee

Employee (MM)

Expense

Expense Item

Expense Item Type

Internal Division

Internal Product

LS Product Indiction

Language Def

List of Values

List of Values Child

List of Values Dynamic

Opportunity

Order Entry - Order Types

Order Entry - Orders

Period

Pharma Account Call - CE

Pharma Address Inter Table - CE

Pharma Area

Pharma Call Decision Issue

Pharma Call Decision Issue - CE

Pharma Call Products Detailed

Pharma Call Products Detailed - CE

Pharma Call Sample Dropped - CE

Pharma Call Signature

Pharma GA Markets

Pharma GA Rx Consumption

Table 38. Siebel Pharma Handheld Business Components

Supported Business Components
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Pharma Internal Product

Pharma Inventory Period

Pharma Inventory Period - CE

Pharma ME Event

Pharma ME Event Professional Invitee Inter 
Table

Pharma Personal Inventory - CE

Pharma Personal Products - CE

Pharma Personal Promotional Items - CE

Pharma Personal Samples - CE

Pharma Product Issue

Pharma Professional Addresses - CE

Pharma Professional Call - CE

Pharma Professional Note

Pharma Professional Position

Pharma Professional Primary Specialty

Pharma Professional Private Note

Pharma Professional State Licenses

Pharma Professional Items Dropped - CE

Pharma Sales Consumption

Pharma Sample And Promo Order

Pharma Sample And Promo Order Item

Pharma Sample Order And Adjustment

Pharma Sample Order And Adjustment 
Item

Pharma Sample Stocked Lots

Pharma Sample Stocked Products

Pharma Sample Transaction History Item - 
CE

Pharma Samples

Pharma Signature Disclaimer

Pharma Template Call

Table 38. Siebel Pharma Handheld Business Components

Supported Business Components
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Business Component Classes
NOTE: The business component classes for the handheld application are based on the classes for the 
Web Client. However, in most instances, because of the limitations of the handheld, only the subset 
of the class functionality that is required for the handheld is supported.

Table 39 lists the supported business component classes for Siebel Pharma Handheld.

Picklist Generic

Picklist Hierarchical

Position

Price List

Query List

Retail Outlet Best Call Time

SIS HH Contact Activity

Shift

Shift Exception

System Preferences

Time Expense Map

Time Zone

Table 39. Siebel Pharma Handheld Business Component Classes

Supported Business Component Classes

CSSBCAccountSIS CSSBCPosition

CSSBCAutoProduct CSSBCPriceList

CSSBCBase CSSBCProdRev

CSSBCBSampleLot CSSBCProductDetailed

CSSBCContactSIS CSSBCPromoItemsDropped

CSSBCDivision CSSBCSample

CSSBCDocInvoice CSSBCSampleDropped

CSSBCExpitm CSSBCSampleInventory

CSSBCExprpt CSSBCStateModel

Table 38. Siebel Pharma Handheld Business Components

Supported Business Components
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Applet Classes
You may create additional screens and views for your handheld application. Any new screens and 
views must be based on classes and business components that are supported for the Pharma 
Handheld application. Refer to Table 40 for the supported applet classes.

CSSBCFINOppty CSSBCStateModelState

CSSBCFINSActivity CSSBCStateTransition

CSSBCHHInventoryPeriod CSSBCUser

CSSBCHHPharmaCall CSSBusComp

CSSBCHHSample CSSCommandShell

CSSBCHHSampleItem CSSExpenseAutoGenService

CSSBCInventoryPeriod CSSOMAlarmMgr

CSSBCLineItem CSSPreferencesService

CSSBCPeriod CSSQueryExporter

CSSBCPharmaAddress CSSSIABCOrder

CSSBCPharmaCall CSSSISOMPricerService

CSSBCPharmaCallComponent CSSSMCacheService

CSSBCPharmaDisclaimer CSSTimeSheetAutoGenService

CSSBCPharmaSign

Table 40. Siebel Pharma Handheld Applet Classes

Applet Classes

CSSDurationFrameList

CSSFrame

CSSFrameAcctCall

CSSFrameBase

CSSFrameCECalAddModify

CSSFrameCEGridDay

CSSFrameCEGridMonth

Table 39. Siebel Pharma Handheld Business Component Classes

Supported Business Component Classes
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Siebel Pharma Handheld Objects That 
Should Not Be Modified
Refer to Configuring Siebel Business Applications for guidelines on modifying existing objects. 

There are certain objects in the Siebel Pharma Handheld Client which should not be changed. 
Table 41 lists these objects.

CAUTION: If these objects are changed, the behavior of the Siebel Pharma Handheld application 
cannot be predicted

CSSFrameCEGridWeek

CSSFrameCEHome

CSSFrameCEMultPart

CSSFrameList

CSSFrameListBase

CSSFrameListExpitm

CSSFrameListPharmaActivity

CSSFrameListSample

CSSFrameListSampleItem

CSSFrameNewCall

CSSFramePopupCurrency

CSSFrameProfCall

CSSFrameSISAction

CSSFrameSample

CSSSWEFrameListPick

CSSSWEFrameListTargetAssoc

CSSSWEFrameListVisibilityAssoc

CSSSWEFrameListVisibilityPick

CSSSubmitFrame

Table 40. Siebel Pharma Handheld Applet Classes

Applet Classes
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Table 41. Siebel Pharma Objects that Should Not Be Modified

Type of Object Objects

Business Objects Action - Account - CE

Action - Asset - CE

Action - Contact - CE

Action - Internal Product - CE

Action - Service Request - CE

Asset - Contact - CE

Asset - FS Inventory Location - CE

FS Activity Rec Parts & Tools - Order - CE

FS InvLoc Product - Internal Product - CE

FS Part Browser - FS Inventory Location - CE

Line Items - Action - CE

Line Items - Internal Product - CE

Order - Asset - CE

Order - Service Request - CE

Service Request - Account - CE

Service Request - Asset - CE

Service Request - Contact - CE

Service Request - Internal Product - CE

Business Components Action - CE

Service Request - CE

Hidden Picklists BusComp - CE
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D User Properties
This appendix documents the handheld-specific user properties and methods for the Siebel Handheld 
application.

CUT Address – CE Business Component

Table 42. User Properties for CUT Address – CE Business Component

CUT Address – CE Business Component

User Property Value Description

Propagate Address BC 
Fields

City,Postal 
Code,State,Street,Addres
s,Country, Phone#

Specifies the fields that must be updated in 
the S_ADDR_PER table that are propagated 
to the inter table. Fields are separated by 
commas.

Propagate Address 
Fields To Parent BC

City|City CE, Postal 
Code|Postal Code CE, 
State|State CE,Street 
Address|Street Address 
CE,Country|Country CE

Specifies the source and destination fields 
that are propagated to the parent business 
component. Source and destination fields are 
separated by a vertical bar (|) and the pairs 
of fields are separated by commas.

In the example City|City CE, “City” is the 
source field and “City CE” is the destination 
field.
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Pharma Account Call – CE Business Component

Table 43. User Properties for Pharma Account Call – CE Business Component

Pharma Account Call – CE Business Component

User 
Property Value Default Value Description

Cascading 
Fields

,Field name, ,Start Date,Start 
Time,Account 
Id,Address,Account 
Address Id,Account 
State,Duration 
Minutes,Brick Id,

Specifies fields that must be 
cascaded to the attendee call. 
These fields have to be made force 
active in the child business 
component. 

Use field names as defined in 
Siebel Tools. Add a comma to the 
beginning and end of the field 
name.

Must Detail 
Products

Y or N Y Specifies whether a product must 
be detailed or not before the call 
can be submitted.

OnlySubmitBy
Position

Y or N Y Specifies whether the position that 
entered the record is the only 
position that can submit the call.

Read Only If 
Status 
Synchronized

Y or N N Specifies whether the record is 
Read Only if the call status is 
“Synchronized.”

SubCall 
Component 
CE

,Business 
Component 
Name,

Pharma Professional Call - 
CE

Child business component to which 
the changes are cascaded. Use 
business component names as 
defined in Siebel Tools.

Submit At 
Handheld 
Sync

Y or N Y Y indicates call should be submitted 
at sync to create samples 
transactions and update sample 
inventory. N will not create any 
sample transactions.

Template 
Components

,Business 
Component 
Name,

Pharma Call Products 
Detailed - CE

Specifies the business components 
that need to be copied from the call 
template when a smart call is 
applied to a call. Use business 
component names as defined in 
Siebel Tools.
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Update After 
Submit

,Field name, ,Comment, Specifies fields that are editable 
after the call is submitted. Use field 
names as defined in Siebel Tools. 
Add a comma to the beginning and 
end of the field name.

Update Status 
To 
Synchronized

Y or N Y Specifies whether the status of 
calls downloaded to the handheld is 
updated to “Synchronized.” When 
the status is “Synchronized,” the 
calls are read-only on the server.

Validate 
Product 
Property

Y or N N If set to Y, it throws an error during 
submit if product detail priority is 
not in a sequential order starting 
with 1.

Table 44. User Properties for Pharma Address Business Component

Pharma Address Business Component

User Property Value Description

Propagate Address BC 
Fields

City,Postal 
Code,State,Street 
Address,Country

Specifies the fields that must be updated in the 
S_ADDR_PER table that are propagated to the 
inter table. Fields are separated by commas.

Propagate Address 
Fields To Parent BC

City|City, Postal 
Code|Postal Code, 
State|State,Street 
Address|Street Address, 
Country|Country 

Specifies the source and destination fields that 
are propagated to the parent business 
component. 

Update Inter Table BC 
Fields

DEA#,DEA Expr Specifies list of fields that must be updated in 
the inter table (S_CON_ADDR).

Validate DEA Number Y or N Whenever a DEA# is entered, the field value is 
set only when it is a valid number.

Table 43. User Properties for Pharma Account Call – CE Business Component

Pharma Account Call – CE Business Component

User 
Property Value Default Value Description
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Table 45. User Properties for Pharma Professional Call – CE Business Component

Pharma Professional Call – CE Business Component

User 
Property Value Default Value Description

Attendee Call 
Read Only

,Start 
Date,Start 
Time,Call 
Status,SubTy
pe,Address,D
uration 
Minutes,

,Start Date,Start Time,Call 
Status,Sub 
Type,Address,Duration 
Minutes,Last Name, 
(default)

Specifies read-only fields when the 
call is an attendee call. Use the field 
names as they are defined in Siebel 
Tools. Add a comma to the 
beginning and end of the field 
name.

Electronic 
Signature 
Read Only

,Field name, ,Last 
Name,Address,Chosen 
Template,Start 
Date,CallStatus,Paper 
Signature,

Specifies fields that are read-only 
after a signature is taken. Use the 
field names as they are defined in 
Siebel Tools. Add a comma to the 
beginning and end of the field 
name.

Must Detail 
Products

Y or N N Specifies whether a product must 
be detailed before the call is 
submitted.

OnlySubmitBy
Position

Y or N Y Specifies whether the position that 
entered the record is the only 
position that can submit the call. 

Paper 
Reference 
Number 
Required

Y or N Y Specifies whether the reference 
number is required or not in order 
to submit a call with a paper 
signature.

Paper 
Signature 
Read Only

,Field name, ,Call Status,Signature 
Captured,

Specifies fields that are read-only 
when Paper Signature is true. Use 
the field names as they are defined 
in Siebel Tools. Add a comma to the 
beginning and end of the field 
name.

Read Only If 
Status 
Synchronized

Y or N N Specifies whether the record is 
Read Only if the call status is 
“Synchronized.”
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SRE 
Professional 
Types

Professional 
Type

No default Specifies a list of professions. Add 
a comma to the beginning and end 
of the professional type. An 
example would be: 
,Physician,Central Lab Technician,

SRE Reference 
Number 
Required

Y or N N Specifies whether a reference 
number is required before the call 
can be submitted.

Sample 
Disbursed 
Required

Y or N N Specifies whether samples must be 
dropped when the call is submitted.

Template 
Components

,Business 
Component 
Name,

Pharma Call Products 
Detailed - CE,Pharma Call 
Sample Dropped - CE

Specifies the business components 
that need to be copied from the call 
template when a smart call is 
applied to a call. Use business 
component names as defined in 
Siebel Tools.

Update After 
Recreate 
Receipt

,Field name, ,Last Name,Address,Start 
Date,Comment,Signature 
Captured,

Specifies fields that are editable 
when Recreate Receipt is selected. 
Use field names as defined in Siebel 
Tools. Add a comma to the 
beginning and end of the field 
name.

Update After 
Submit

,Field name, ,Comment, Specifies fields that are editable 
after the call is submitted. Use field 
names as defined in Siebel Tools. 
Add a comma to the beginning and 
end of the field name.

Update Status 
To 
Synchronized

Y or N Y Specifies whether the status of 
calls downloaded to the handheld is 
updated to “Synchronized.” When 
the status is “Synchronized,” the 
calls are read-only on the server.

Validate DEA 
Number

Y or N Y Specifies whether the DEA Number 
must be validated before the user 
can sign and submit the call.

Validate DEA 
Number 
Expiration

Y or N Y Specifies whether DEA Expiration 
Date must be validated before the 
user can sign and submit the call.

Table 45. User Properties for Pharma Professional Call – CE Business Component

Pharma Professional Call – CE Business Component

User 
Property Value Default Value Description
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Validate 
License 
Number

Y or N Y Specifies whether License Number 
must be validated before the user 
can sign and submit the call.

Validate 
License 
Number 
Expiration

Y or N Y Specifies whether License Number 
Expiration must be validated before 
the user can sign and submit the 
call.

Validate 
License 
Number 
Status

Y or N Y Specifies whether License Number 
Status must be validated before the 
user can sign and submit the call.

Validate OK to 
Sample

Y or N Y Specifies whether it is OK to drop a 
sample to a contact the call.

Validate 
Product 
Priority

Y or N N  If set to Y, it throws an error during 
submit if product detail priority is 
not in a sequential order starting 
with 1.

Validate 
Professional 
Profile

Y or N Y

Validate Sign 
Lot Number

Y or N Y Specifies whether Lot Number is 
required before the user can sign.

Validate 
Submit Lot 
Number

Y or N Y Specifies whether Lot Number is 
required before the user can submit 
the call.

Table 46. User Properties for Pharma Address Inter Table – CE Business Component

Pharma Address Inter Table – CE Business Component

User Property Value Default Value Description

Validate DEA 
Number

Y or N Y Specifies whether the DEA 
number must be validated. An 
example of a valid DEA number 
is: AA1234563.

Table 45. User Properties for Pharma Professional Call – CE Business Component

Pharma Professional Call – CE Business Component

User 
Property Value Default Value Description
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Pharma Call Products Detailed – CE Business 
Component

Table 47. User Properties for Pharma Call Decision Issue – CE Business Component

Pharma Call Decision Issue – CE Business Component

User 
Property Value Default Value Description

Template 
Fields

,Field name, Name Specifies the fields that need to 
be copied from the call 
template when a smart call is 
applied. Use field names as 
defined in Siebel Tools. Add a 
comma to the beginning and 
end of the field name.

Table 48. User Properties for Pharma Call Products Detailed – CE Business Component

Pharma Call Products Detailed – CE Business Component

User 
Property Value Default Value Description

Max Auto 
Generated 
Priority

number 3 Maximum number of priorities that 
are automatically generated.

Skip Conflict 
Resolution for 
Duplicate 
Records

Y or N Y Specifies the behavior of Object 
Manager when it encounters a 
duplicate record during 
synchronization. If Y, the Object 
Manager drops the record from the 
handheld client and keeps the 
record on the server. 

Template 
Fields

,Field name, Name,Priority,Indication Specifies the fields that are copied 
from the call template when a 
smart call is applied. Use field 
names as defined in Siebel Tools. 
Add a comma to the beginning and 
end of the field name.
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Pharma Call Sample Dropped – CE Business Component

Table 49. Pharma Inventory Period – CE Business Component

Pharma Inventory Period – CE Business Component

User 
Property Value Default Value Description

Maximum 
Periods

Number 2 Specifies the number of 
unreconciled periods, 
including the active period.

Table 50. User Properties for Pharma Call Sample Dropped – CE Business Component

Pharma Call Sample Dropped – CE Business Component

User 
Property Value Default Value Description

Signature 
Body Text 
Field: 1

Field name Quantity Field name that must appear in 
the signature body text.

Signature 
Body Text 
Field: 2

Field name Name Field name that must appear in 
the signature body text.

Signature 
Body Text 
Field: 3

Field name Vendor Name Field name that must appear in 
the signature body text.

Skip Conflict 
Resolution For 
Duplicate 
Records

Y or N Y Specifies the behavior of 
Object Manager when it 
encounters a duplicate record 
during synchronization. If Y, 
the Object Manager drops the 
record from the handheld client 
and keeps the record on the 
server.
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Template 
Fields

,Field name, ,Name,Lot Name,Quantity, Specifies the fields that need to 
be copied from the call 
template when a smart call is 
applied. Use field names as 
defined in Siebel Tools. Add a 
comma to the beginning and 
end of the field name.

Update After 
Recreate 
Receipt

 ,Field Name,  ,Name,Quantity, Fields that can be updated after 
Recreate Receipt.

Table 51. User Properties for Pharma Promotional Items Dropped – CE 

Pharma Promotional Items Dropped – CE Business Component

User 
Property Value Default Value Description

Template 
Fields

,Field name, ,Name,Quantity, Specifies the fields that need to be 
copied from the call template when 
a smart call is applied. Use field 
names as defined in Siebel Tools. 
Add a comma to the beginning and 
end of the field name.

Table 50. User Properties for Pharma Call Sample Dropped – CE Business Component

Pharma Call Sample Dropped – CE Business Component

User 
Property Value Default Value Description
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E Print Tagging Language
This chapter describes the print tagging language that is used to create print templates for your 
handheld device.

The audience for this appendix is Siebel application developers.

“Overview of Siebel Handheld Print Tagging Language” on page 215

“Using Variables in Print Templates” on page 231

Overview of Siebel Handheld Print 
Tagging Language
You can create the print template file in any text editor.

■ Tags are enclosed in angle brackets and identified with the keyword TAG, followed by a colon.

For example: <TAG: ....>

■ Parameters are specified with a keyword, followed by an equals sign. Arguments are in 
uppercase, surrounded by quotation marks.

For example, Font = "FONT FACE"

■ Values are in uppercase and lowercase, surrounded by quotation marks. 

For example: Font = "Helvetica"

■ Tags may appear in any order in the file. The only required tag is the Title tag.

■ Variables within a print template must be uniquely named. Variable names must be one-word 
strings and spaces are not allowed.

The following tags are used to specify the format of the print output, which applets are included, and 
the query that is executed:

■ Applet—Specifies which applets are used in the document.

■ Comment—Adds comments that do not appear in the final document.

■ Divider—Adds visual lines to visually separate different parts of the document.

■ Footer—Adds information such as page numbers, date, and time.

■ Format—Specifies characteristics such as font, boldface, italics, and underline.

■ Header—Adds information such as page numbers, date, and time.

■ Page Break—Specifies a break in the text, forcing the text that follows to appear on the next 
page.

■ Picture—Adds graphic images to the document.
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■ Title—Specifies a name for the template that appears in the print job list.

In addition, you may add static text in the print template.

The following print tags allow you to calculate additional information and add it to your reports:

■ GetTotal—Calculates the total for a column of data.

■ GetField—Gets the value of a field.

■ GetCount—Calculates the number of records.

You can also calculate dates and times using the GetDate and GetTime tags, and you can retrieve 
the value of the registry using GetRegistry.

All of this information is stored in variables that you specify. In addition, you can assign any value 
to a variable using the SetVariable tag. You can present this information in your report using the Cell 
and EndofLine tags to create tables of information. See “Using Variables in Print Templates” on 
page 231 for an example of how variables can be used to present information in print templates.

Applet

Description
Specifies the applet to be printed.

Usage
Any data that appears in your document must be generated from the applets in the view. Therefore, 
you must create applets that will produce the data required for your document.

Use the Applet tag to specify any number of list or form applets within the template and to locate 
the applet in your document. In the form view, a maximum of two fields per row are supported.

Syntax
<TAG:Applet Name="APPLET NAME" Query="QUERY STRING" Caption="CAPTION" 
Headerdivider="HEADERDIVIDER" Recorddivider="RECORDDIVIDER" Wrap="WRAP">

Parameter Description

TAG:Applet (Required) Applet tag indicator.

APPLET NAME (Required) Applet name as defined in Siebel Tools.

QUERY STRING (Optional) Specifies the query string directly set to the business component 
supporting the document.

If the query string is not specified, the currently active query string in the view 
is applied to expose the relevant records.
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Example
<TAG:Applet Name="Order List" Headerdivider="TRUE">

Cell

Description
Prints the string stored in STRING or VARIABLE NAME at the specified location on the current line.

Usage
Use the Cell tag to create cells of data in a row in a table. Use it with the EndOfLine tag. If the data 
exceeds the width of the cell specified by Startat and Endat, it wraps to the next line.

CAPTION (Optional) Specifies whether the captions in the form applets are suppressed.

Valid values are TRUE (default) and FALSE. This parameter does not apply to 
list applets. Column headings in list applets are always enabled.

HEADERDIVIDER (Optional) Specifies whether a divider is printed below the column heading in 
list applets.

Valid values are TRUE and FALSE (default). This parameter does not apply to 
form applets.

RECORDDIVIDER (Optional) Specifies whether a horizontal divider is printed between records in 
list applets.

Valid values are TRUE and FALSE (default). This parameter does not apply to 
form applets.

WRAP (Optional) Specifies whether text field values are word wrapped. 

Valid values are TRUE and FALSE (default). This parameter does not apply to 
numeric fields.

Parameter Description
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Syntax
<TAG:Cell Startat="START" Endat="END" Name="STRING" Variable="VARIABLE NAME" 
Align=ALIGNMENT"

Example
<TAG:Divider Weight="3" Startat="20" Endat="80">
<TAG:Cell Startat="0" Endat="50" name="TOTAL:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvv1total" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="TOTAL Defective:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvDefectiveTotal" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="TOTAL Good:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvGoodTotal" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="Defective Count:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvDefectiveCount" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="Good Count:" Align="RIGHT">

Parameter Description

TAG:Cell (Required) Required tag indicator.

START (Required) Specifies the starting point of the cell, expressed as a percentage 
of the printable page width. For example, if 
START =10, then the cell starts at the point that is 10% from the left edge 
of the printable width.

END (Required) Specifies the end point of the cell, expressed as a percentage of 
the printable page width. For example, if END=50, then the cell ends at the 
point that is 50% from the left edge of the printable width.

STRING (Optional) String value. If Variable is not specified, then String is a required 
parameter. 

VARIABLE NAME (Optional) Name of variable where the value is stored. If String is not 
specified, then Variable is a required parameter.

ALIGNMENT (Optional) Specifies the alignment of the string.

Valid values are LEFT (default), CENTER, and RIGHT.
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<TAG:Cell Startat="50" Endat="100" Variable="vvvGoodCount" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="50" Endat="100" Variable="vvv3reg">
<TAG:EndOfLine>
<TAG:Cell Startat="50" Endat="100" Variable="vvv5str">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="30" Variable="vvv4date">
<TAG:Cell Startat="30" Endat="70" Variable="vvv4longdate">
<TAG:Cell Startat="70" Endat="100" Variable="vvv8time">
<TAG:EndOfLine>

Comment

Description
Adds code comments to the print template.

Usage
Use to add explanatory notes or documentation to explain and maintain the print template. Comment 
tags are ignored during printing and do not appear in the printed document.

Syntax
<REM: COMMENT>

Example
<REM: Quotation Print Template. This template includes four applets.>

Divider

Description
Renders a horizontal line across the width of the page.

Parameter Description

REM (Required) Comment tag indicator.

COMMENT (Optional) Comment text.
Siebel Pharma Handheld Guide Version 7.8 219



Print Tagging Language ■ Overview of Siebel Handheld Print Tagging Language
Usage
Use to visually separate the different sections of your document. The Divider tag can be used 
between other tags; therefore, you may add a line between two applets. However, you cannot embed 
a Divider within an applet.

Syntax
<TAG:Divider Weight="WEIGHT" Startat="START" Endat="END">\

Example
<TAG:Divider Weight="2" Startat="20" Endat="80">

EndOfLine

Description
Specifies the end of a row and advances to the next line.

Usage
Use to create rows of data in a table. Used with the Cell tag.

Syntax
<TAG:EndOfLine>

Example
<TAG:Cell Startat="0" Endat="50" Name="TOTAL:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvv1total" Align="RIGHT">
<TAG:EndOfLine>

Parameter Description

TAG:Divider (Required) Divider tag indicator.

WEIGHT (Optional) Specifies line thickness.

Valid values are 1–5. The default value is 1, which produces a line 0.2 mm 
wide. Increasing the value by 1 increases the width by 0.2 mm. A 5 produces 
a line that is 1 mm wide.

START (Optional) Percentage that specifies the starting point of the line. The default 
is 0%, the farthest left point.

END (Optional) Percentage that specifies the end point of the line. The default is 
100%, the farthest right point.
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Footer

Description
Adds footer information such as page numbers, the current date, and the current time.

Usage
You may, for example, always want the text “Thank you for your business!” to appear on the bottom 
of your receipts. If so, you may include this text in a Footer tag.

The Footer tag may be specified anywhere in the template file; however, it will always appear at the 
very bottom of your document. Only one Footer tag is applied to the document. If you have multiple 
Footer tags in the file, only the last Footer tag is used; any other Footer tags are ignored.

If you include a Footer tag in your template, then you must set the BottomMargin in setup.ini to a 
minimum of 20.

The footer has three sections, Left, Center, and Right, which are used to position the information in 
the footer.

The text in the footer is formatted in 10 point, Helvetica font. If Helvetica is not available on your 
system, the default font is used. You cannot customize text formatting of the Footer tag. The Format 
tag does not affect the formatting of the footer.

Syntax
<TAG:Footer Left="DATA" Center="DATA" Right="DATA">

Example
<TAG:Footer Left="<date>" Right="<page>"

Parameter Description

TAG:Footer (Required) Footer tag indicator.

DATA (Optional) Static text or one of the following data tags:

Data tag Description

<page> Page number

<date> Date of the printing

<time> Time of the printing
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Format

Description
Specifies the characteristics of the text—the typeface or font, whether the text is in boldface, italics, 
or underlined, and the text alignment.

Usage
The font specification specifies the characteristics of all text that follows the tag until the next Format 
tag.

The text alignment tag (Align) behaves somewhat differently. When the applet is rendered, the field 
alignment specification takes precedence over the Align parameter.

Syntax
<TAG:Format Face="FONT FACE" Size="FONT SIZE" Bold="BOLD" Italic="ITALIC" 
Underline="UNDERLINE" Align="TEXT ALIGNMENT">

Example
<TAG:Format Face="Helvetica" Size="10">

Parameter Description

TAG:Format (Required) Format tag indicator.

FONT FACE (Required) Specifies the typeface of the text.

Any typeface installed on the handheld device may be specified. There is no 
default for this parameter.

FONT SIZE (Required) Specifies the text size.

Any installed font size for an installed typeface on the handheld device may 
be specified. There is no default for this parameter.

BOLD (Optional) Specifies whether the text is in bold.

Valid values are TRUE or FALSE (default). If TRUE, text is set to bold.

ITALIC (Optional) Specifies whether the text is in italic. 

Valid values are TRUE or FALSE (default). If TRUE, text is set to italic.

UNDERLINE (Optional) Specifies whether the text is underlined.

Valid values are TRUE or FALSE (default). If TRUE, text is set to underline.

TEXT ALIGNMENT (Optional) Specifies the text alignment.

Valid values are LEFT (default), RIGHT, and CENTER.
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GetCount

Description
Calculates the number of records in the selected rows and assigns this value to a variable.

Usage
Use GetCount to calculate the number of records and print this value in your report.

Syntax
<TAG:GetCount Appletname="APPLET NAME" Query="QUERY STRING" Variable="VARIABLE 
NAME">

Example
<TAG:GetCount Appletname="CS HH Product Bucket List Applet" Query="Status|Good" 
Variable="StatusGood">

GetDate

Description
Gets the current date, offsets the date by the number of days specified in Dayoffset, and stores the 
result in a variable.

Usage
Use GetDate to print a specific date in your report.

Parameter Description

TAG:GetCount (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

QUERY STRING (Optional) Search specification for the rows to be included in the row set. If 
not specified, the current search specification is used.

The syntax for the query string is: Field Name|Query Statement. You may 
specify one or more query strings separated by a vertical bar (|).

For example, Query="Name|LIKE 'Sieb*'"|"Location|LIKE 'H*'"

VARIABLE NAME (Required) Name of variable where the value is stored.
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Syntax
<TAG:GetDate Dayoffset="NUMBER OF DAYS" Variable="VARIABLE NAME" Logformat="DATE 
FORMAT">

Example
<TAG:GetDate Longformat="TRUE" Variable="LongDate">

GetField

Description
Gets the value of the specified column of the first row of selected rows and assigns the result to a 
variable.

Usage
Use GetField to print a value without developing a print applet. Design the query and sort strings so 
that the desired record is the first record in the selected rows. GetField only allows you to get the 
value in the first record.

Syntax
<TAG:GetField AppletName="APPLET NAME" Fieldname="FIELD NAME" Query="QUERY STRING" 
Sort="SORT STRING" Variable="VARIABLE NAME">

Parameter Description

TAG:GetDate (Required) Required tag indicator.

NUMBER OF DAYS (Optional) Number of days by which the current date is offset. For example, 
–100 subtracts 100 days from the current date; 100 adds 100 days to the 
current date. The default is 0.

VARIABLE NAME (Required) Name of variable where the value is stored.

DATE FORMAT (Optional) TRUE prints the date in long date format (for example, Monday, 
February 11, 2002). FALSE prints the short date format (for example, 2/21/
02). The default is FALSE.

Parameter Description

TAG:GetField (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

FIELD NAME (Required) Name of the field or column.

QUERY STRING (Optional) Search specification for the rows to be included in the total. If not 
specified, the current search specification is used.
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Example
<TAG:GetField AppletName="CS HH Product Bucket List Applet" Fieldname="Quantity" 
Variable="ProdBucketListField">

GetRegistry

Description
Gets a value in the registry for Siebel Handheld and assigns it to a variable.

Usage
Use GetRegistry to print the contents of the registry key in your report.

Syntax
<TAG:GetRegistry Name="REGISTRY NAME" Variable="VARIABLE NAME">

Example
<TAG:GetRegistry Name="InstallDir" Variable="Registry">

SORT STRING (Optional) Sort specification. If not specified, the current sort specification 
is used.

The syntax is: Field Name [ASC][DESC]. The default is ASC (Ascending).

For example: Sort="Account DESC, Date". In the example, the Account field 
is sorted in descending order, then the date field is sorted in ascending order.

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description

TAG:GetRegistry (Required) Required tag indicator.

REGISTRY NAME (Required) Value the registry.

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description
Siebel Pharma Handheld Guide Version 7.8 225



Print Tagging Language ■ Overview of Siebel Handheld Print Tagging Language
GetTime

Description
Gets the current time, offsets the time by the number of seconds specified in Secondoffset, and 
assigns the result to a variable.

Usage
Use GetTime to print a specific time in your report.

Syntax
<TAG:GetTime Secondoffset="NUMBER OF SECONDS" Variable="VARIABLE NAME">

Example
<TAG:GetTime Secondoffset="3600" Variable="Time">

GetTotal

Description
Calculates the total for the specified column for all selected rows and assigns the value to a variable.

Usage
Use GetTotal to calculate a column total and display the total in your report.

Syntax
<TAG:GetTotal AppletName="APPLET NAME" FieldName="FIELD NAME" Query="QUERY STRING" 
Variable="VARIABLE NAME">

Parameter Description

TAG:GetTime (Required) Required tag indicator.

NUMBER OF SECONDS (Optional)Number of seconds by which the current time is offset. For 
example, –100 subtracts 100 seconds from the current time; 100 adds 
100 seconds to the current time. The default is 0.

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description

TAG:GetTotal (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.
Siebel Pharma Handheld Guide Version 7.8226 



Print Tagging Language ■ Overview of Siebel Handheld Print Tagging Language
Example
<TAG:GetTotal AppletName= "CS HH Product Bucket List Applet" Fieldname="Quantity" 
Variable="ProdBucketListTotal">

Header

Description
Adds header information such as page numbers, the current date, and the current time.

Usage
You may always want the current date and time to appear on your invoices. If so, you may include 
this information in a Header tag.

The Header tag may be specified anywhere in the template file; however, it always appears at the 
very top of your document. Only one Header tag is applied to the document. If you have multiple 
Header tags in the file, only the last Header tag is used; any other Header tags are ignored.

If you include a Header tag in your template, then you must set TopMargin in setup.ini to a minimum 
of 20.

The header has three sections, Left, Center, and Right, which are used to position the information in 
the header. The Left parameter aligns the text with the left margin, and the Right parameter right 
aligns the text with the right margin. The Center parameter centers the text in the header.

The text in the header is formatted in 10 point, Helvetica font. If Helvetica is not available on your 
system, the default font is used. You cannot customize text formatting of the Header tag. The Format 
tag does not affect the format of the header. 

FIELD NAME (Required) Name of the field or column. Specify a field or column with 
numeric data. If you specify a field with non-numeric data, a 0 is assigned 
to the variable.

QUERY STRING (Optional) Search specification for the rows to be included in the total. If not 
specified, the current search specification is used.

The syntax for the query string is: Field Name|Query Statement. You may 
specify one or more query strings separated by a vertical bar (|). 

For example, Query="Name|LIKE 'Sieb*'"|"Location|LIKE 'H*'"

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description
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Syntax
<TAG:Header Left="DATA" Center="DATA" Right="DATA"

Example
<TAG:Header Center="Company Confidential">

Page Break

Description
Forces text that follows the tag to appear on the next page.

Usage
Use this for multipage documents or forms.

Syntax
<TAG:PageBreak>

Example
<TAG:PageBreak>

Picture

Description
Specifies graphic files included in the print template.

Parameter Description

TAG:Header (Required) Header tag indicator.

DATA (Optional) Static text or one of the following data tags:

Data tag Description

<page> Page number

<date> Date of the printing

<time> Time of the printing

Parameter Description

TAG:PageBreak (Required) Page break tag indicator.
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Usage
Use to add graphic images, such as a company logo, to your documents. 

The supported file formats are BMP and JPG. 

Graphics files are located in the \Program Files\Siebel Handheld\templates directory on the handheld 
device. Specify the full path name of the file for the Name parameter.

Scaling or graphics operations, such as inverse image, are not supported.

The Alignment and Position parameters are used together to place the graphic. Alignment specifies 
the left edge, the center, or the right edge of the graphic. Position is distance, specified in 
millimeters, from the left edge of the paper. 

■ If Alignment ="Left" and Position="30", then the left edge of the graphic is set 30 millimeters 
from the left edge of the paper. 

■ If Alignment = "Center" and Position = "30", the center of the graphic is set 30 millimeters from 
the left edge of the paper.

■ If Alignment = "Right" and Position = "30", the right edge of the graphic is set 30 millimeters 
from the left edge of the paper.

If Position is not specified, it defaults to 0. Depending on the Alignment setting, the graphic is left-
aligned (Alignment = "Left"), the graphic is right-aligned (Alignment = "Right"), or the graphic is 
centered (Alignment ="Center")

Syntax
<TAG:Picture Name="FILE NAME" Alignment="ALIGNMENT" Position="POSITION">

Example
<TAG:Picture Name="\Program Files\Siebel Handheld\templates\logo.bmp" Alignment="Right" 
Position="88">

Parameter Description

TAG:Picture (Required) Picture tag indicator.

FILE NAME (Required) Specifies the full path and name of the graphics file.

ALIGNMENT (Optional) Specifies the left edge, the center, or the right edge of the graphic. 
Used with the Position parameter to specify the horizontal position of the graphic.

Valid values are LEFT (default), CENTER, and RIGHT.

POSITION (Optional) Specified in millimeters, it is the distance from the left edge of the 
paper. Used with the Alignment parameter to specify the horizontal position of the 
graphic. The default is 0.
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SetVariable

Description
Sets a value to a variable.

Usage
Use SetVariable to assign a value to a variable. You can then print the value by specifying the variable 
in the Cell tag.

Syntax
<TAG:SetVariable Name="VALUE" Variable="VARIABLE NAME>

Example
<TAG:SetVariable="100" Variable="TotalQuantity">

Static Text
You may add static text anywhere in your template by using the current Format settings. The text 
goes across the entire page width. If it exceeds the width of the page, it wraps to the next line.

Example
This quote is valid for 60 days from the date on this quotation.

Title

Description
Name used to identify the template.

Usage
The Title tag is a required tag in your print template file. 

Parameter Description

TAG:SetVariable (Required) Required tag indicator.

VALUE (Required) A value.

VARIABLE NAME (Required) Name of variable where the value is stored.
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When you print your document, this title appears in the print job list. This title does not appear on 
the document that is printed. Use static text to add the document title to your template.

Syntax
<TAG:Title Title="TITLE">

Example
<TAG:Title Title="Quotation">

Using Variables in Print Templates
The following example shows how to use variables in a print template.

<TAG:Title Title="Inventory Report">

<REM: **********Variable Assignment Examples**************>

<TAG:SetVariable name="THIS IS VARIABLE" variable="VarStr">
<TAG:GetRegistry name="InstallDir" variable="VarReg">
<TAG:GetDate dayoffset="10" variable="VarDate">
<TAG:GetDate longformat="TRUE" variable="VarLongDate">
<TAG:GetTime secondoffset="-3600" variable="VarTime">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
variable="VarTotal">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
query="Status|Good" variable="VarGoodTotal">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
query="Status|Defective" variable="VarDefectiveTotal">
<TAG:GetField appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
variable="VarQuantityField">
<TAG:GetCount appletname="CS HH Product Bucket List Applet" query="Status|Good" 
variable="VarGoodCount">
<TAG:GetCount appletname="CS HH Product Bucket List Applet" query="Status|Defective" 
variable="VarDefectiveCount">

<REM: **********Variable Assignment Examples End************>

<REM: Inventory Print Template. This template includes 3 applets. The ENU template>

<TAG:Format Face="Helvetica" Size="16" Align="Center">
[Distributor Name
Street Address
City, Country Postal Code
Phone Number   Fax Number]

Parameter Description

TAG:Title (Required) Title tag indicator.

TITLE (Required) Title text. May be between 1–255 characters.
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<TAG:Format Face="Helvetica" Size="20" Bold="TRUE" Align="Center">
Inventory Report
<TAG:Format Face="Helvetica" Size="8" >
<TAG:Applet Name="CS HH Inv Loc Print Applet" Caption="TRUE" Wrap="TRUE">
<TAG:Applet Name="CS HH Product Bucket List Applet" Line="FALSE" Headerdivider="TRUE" 
Recorddivider="FALSE" Wrap="TRUE">

<REM: *************Variable Usage Example***************>

<TAG:Divider Weight="3" startat="20" endat="80">
<TAG:Cell startat="0" endat="50" name="TOTAL:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarTotal" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell startat="0" endat="50" name="TOTAL Defective:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarDefectiveTotal" Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="TOTAL Good:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarGoodTotal" Align="RIGHT"
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="Defective Count:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarDefectiveCount" Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="Good Count:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarGoodCount" Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="50" endat="100" variable="VarReg">
<TAG:EndOfLine>

<TAG:Cell startat="50" endat="100" variable="VarStr">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="30" variable="VarDate">
<TAG:Cell startat="30" endat="70" variable="VarLongDate">
<TAG:Cell startat="70" endat="100" variable="VarTime">
<TAG:EndOfLine>

<REM: ***********Variable Usage Example End***************>

<TAG:Divider Weight="2">
<TAG:Format Face="Helvetica" Size="12" Align="LEFT">
Warehouse Signature
<TAG:Divider Weight="2">
<TAG:Format Face="Helvetica" Size="12" Align="RIGHT">

Rep Signature
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F Print Configuration Settings
This appendix includes the following topic:

“Overview of Siebel Handheld Print Configuration Settings” on page 233

Overview of Siebel Handheld Print 
Configuration Settings
The administrator sets up the default printer setting in the setup.ini file located in the setup directory.

There are a number of parameters to specify printing on the handheld. The parameters specify the 
following:

■ Printer attributes (printer model, port, baud rate, and printer handshake).

■ Printing attributes (portrait or landscape orientation, print density and quality, use of 
compression techniques, and advancing continuous–feed paper).

■ Dimensions of the paper (U.S. or European standard paper sizes or custom–size paper).

■ Margin settings of the pages (left, right, top, and bottom margins).

These parameters are specified in the [Printing] section of the setup.ini file located in the setup 
directory. The file contains default settings for all the printing parameters. Review the settings in the 
file to verify that these settings will work for your printing environment. If necessary, edit the 
settings as required. You may use any text editor to edit the file.

See Appendix E, “Print Tagging Language,” for a list of the printing parameters and valid values.

The parameters are set using the following syntax:

PARAMETER_NAME = VALUE

For example: PrinterType = 1

The parameters are listed below in alphabetical order by the parameter name.

MarginBottom
Use the MarginBottom parameter to specify the dimensions of the bottom margin of your page. 
Specify the margin in millimeters using a whole number; decimal fractions are not valid. The default 
is 5 millimeters.

The data specified in the Footer tag of the print template is printed in the margin specified by 
MarginBottom. Therefore, if the print template includes a Footer tag, you must specify a wide enough 
bottom margin to accommodate the footer. MarginBottom should be set to a minimum of 20 
millimeters. For more information, see “Footer” on page 221.
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MarginLeft
Use the MarginLeft parameter to specify the width of the left margin of your page. Specify the margin 
in millimeters using a whole number; decimal fractions are not valid. The default is 5 millimeters.

MarginRight
Use the MarginRight parameter to specify the width of the right margin of your page. Specify the 
margin in millimeters using a whole number; decimal fractions are not valid. The default is 5 
millimeters.

MarginTop
Use the MarginTop parameter to specify the dimensions of the top margin of your page. Specify the 
margin in millimeters using a whole number; decimal fractions are not valid. The default is 5 
millimeters.

The data specified in the Header tag of the print template is printed in the margin specified by 
MarginTop. Therefore, if the print template includes a Header tag, you must specify a wide enough 
top margin to accommodate the footer. MarginTop should be set to a minimum of 20 millimeters. For 
more information, see “Header” on page 227.

PaperHeight
If the paper that your printer uses is not one of the supported standard sizes, then set PaperSize to 
5 (custom paper dimensions). Then, specify the height of the paper, in millimeters, using the 
PaperHeight parameter. You must use a whole number; decimal fractions are not valid. The default 
is 280 millimeters. If you specify a value of 1–4 for PaperSize, the PaperHeight parameter is ignored.

Use the PaperWidth parameter to specify the width of the paper.

PaperSize
Specify one of the standard paper sizes or specify a custom paper size. (See Table 52.) If you specify 
custom paper size (5), you must also specify the PaperWidth and PaperHeight parameters. The 
default is custom paper dimensions.
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See also PaperWidth and PaperHeight.

PaperWidth
If the paper that your printer is printing to is not one of the supported standard sizes, then set 
PaperSize to 5 (custom paper dimensions). Then, you must specify the width measurement of the 
paper, in millimeters, using the PaperWidth parameter. You must use a whole number; decimal 
fractions are not valid. The default is 5 millimeters. If you specify a value of 1–4 for PaperSize, the 
PaperWidth parameter is ignored.

Use the PaperHeight parameter to specify the length of the paper.

PrinterBaudrate
Use PrinterBaudrate to specify the speed of the data transmission for the printer. (See Table 53.)

Table 52. Paper Dimensions

Value Description

1 Letter size (8.5" x 11.5")

2 A4 (210 mm x 297 mm)

3 B5 (176 mm x 250 mm)

4 Legal size (8.5" x 14")

5 (default) Custom paper dimensions (Specify PaperWidth and PaperHeight parameters.)

Table 53. Printer Baud Rate

Value Description

0 Always use 0 for LPT or Network printer ports or for COM ports that communicate 
with the printer at 4800 baud

1 (default) 9600 baud

2 19200 baud

3 38400 baud

4 57600 baud

5 115200 baud
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PrinterCompressed
Use PrinterCompressed to specify the data compression mode. (See Table 54.) For the printers 
supported in this release, always set PrinterCompressed to 1.

PrinterDensity
Use the PrinterDensity parameter to get a lighter or darker output from the printer. Start with the 
default setting, 2, which corresponds to the printer manufacturer’s default. As you get feedback from 
the field, you may need to adjust this setting.

The valid values are 0–4 where 0 is the lightest print density, 4 is the heaviest print density, and 2 
is average print density.

PrinterDither
Use to specify the method by which different colors are represented. (See Table 55.) For the printers 
supported in this release, PrinterDither should always be set to 0.

PrinterDraftMode
Use PrinterDraftMode to specify the quality of the printing. (See Table 56.) For the printers supported 
in this release, PrinterDraftMode should always be set to 0.

Table 54. Data Compression

Value Description

0 No compression techniques used

1 (default) Use any known compression

Table 55. Print Dithering

Value Description

0 (default) Use color diffusion

1 Use dithering

Table 56. Print Quality

Value Description

0 (default) Use the highest quality printing

1 Use a lower quality printing if available
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PrinterFormFeed
Use PrinterFormFeed to specify how paper advances to the next page. (See Table 57.) If using sheets 
of paper, set PrinterFormFeed to 0. 

Specify 1 or 2 for continuous–feed paper:

■ Set PrinterFormFeed to 1 if you do not need to conserve paper or if you want pages of uniform 
length. The printer scrolls to the length specified by the PageHeight parameter and trims the 
page there. 

■ Set PrinterFormFeed to 2 to conserve paper or if it does not matter if your pages are of varying 
length. In this case, the printer scrolls 25 millimeters beyond the last printed line and trims the 
page there. The scroll distance, 25 mm, is not customizable.

For both values, 1 and 2, the page length never exceeds PageHeight.

PrinterHandshake
Use PrinterHandshake to define the serial port handshake. (See Table 58.) The PrinterHandshake 
parameter applies only when the printer port is a Com1 or Com2 port. If PrinterPort is set to Com1 
or Com2, then set PrinterHandshake to 1. 

Table 57. Printer Form Feed

Value Description

0 (default) Printer sends a form feed command to the printer at the end of each page. Use 
this setting for sheet paper.

1 Printer scrolls the page to the length specified by the PaperHeight parameter.

2 Printer scrolls the page 25 millimeters past the last printed line of the page.

Table 58. Printer Handshake

Value Description

0 Uses Xon/Xoff

1 (default) Uses hardware control lines

2 No handshaking of serial port
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PrinterOrientation
Specify whether the paper is to be oriented vertically (portrait) or horizontally (landscape). (See 
Table 59.) Not all printers can print in landscape orientation. Therefore, you will need to check the 
specifications for your printer.

PrinterPort
Specify the port to which the printer is connected with the PrinterPort parameter. (See Table 60.)

If PrinterPort is an LPT port or a network path (2 or 9), then the PrinterBaudrate must be set to 0.

NOTE: The communication port on the printer must be set to be compatible with the host PDA. For 
IrDA, the serial communication setting must be set correctly to allow reliable printing. You should 
contact your printer manufacturer and Field Software for more information.

Table 59. Paper Orientation

Value Description

1 (default) Portrait (vertical)

2 Landscape (horizontal)

Table 60. Printer Port

Value Description

0 Com1: serial port

1 Com2: serial port

2 LPT: parallel port

3 (default) IR Infrared port

4 Com3: serial port

5 Com4: serial port

6 Com5: serial port

7 Com6: serial port

8 Print to file OUTPUT.PRN

9 Print to network address

10 Bluetooth BlueCard solution by Wireless Solutions

11 Socket PNC Bluetooth card support

12 Bluetooth BlueCard solution by Anycom
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PrinterType
Specify the type of printer using the PrinterType parameter. See Table 61 for a list of printers 
supported by the Printer CE print driver used by the Siebel application.

13 Com7: serial port

14 Com8: serial port

Table 61. Supported Printers

Value Description

0 Canon BubbleJet compatible printers 

1 Citizen PD-04

2 Citizen PN60i

3 Epson ESC/P 2 compatible printers

4 Epson Stylus compatible printers

5 HP PCL compatible - includes DeskJet and LaserJet

6 Pentax PocketJet 200

7 Pentax PocketJet II 

8 Seiko DPU-3445

9 Generic Epson compatible 180DPI 24-pin printers (LQ/
ESC)

10 Generic Epson compatible 360DPI 24-pin printers (LQ/
ESC)

11 Generic Epson compatible 203DPI 24-pin printers (LQ/
ESC) 

12 Extech 2"

13 Extech 3"

14 O'Neil MicroFlash

15 DymoCoStar label printers

16 Seiko LabelWriter printers

17 Extech 4"

Table 60. Printer Port

Value Description
Siebel Pharma Handheld Guide Version 7.8 239



Print Configuration Settings ■ Overview of Siebel Handheld Print Configuration Settings
Default Printing Settings
The following are the printing parameters from the setup.ini file. The values shown are the default 
settings.

[Printing]

PrinterType= 14
PrinterPort= 3 
PrinterBaudrate= 1
PrinterHandshake= 1
PrinterOrientation= 1
PrinterDensity= 2
PrinterCompressed= 1
PrinterDither= 0
PrinterDraftMode= 0
PrinterFormFeed= 0
PaperSize= 5
PaperWidth= 115
PaperHeight= 280
MarginLeft= 5
MarginRight= 5
MarginTop= 5
MarginBottom= 5

18 SiPix A6 printer

102 Generic 40 column Dot Matrix Printer

108 Generic 80 column Dot Matrix Printer

Table 61. Supported Printers

Value Description
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about recording information 160
default sync filters, about 89
deleting

unused account call records 164
unused attendee calls 164
unused records 158

deploying
CompactFlash card, setting handheld 

application installation on 107
DSS components, using Siebel Server 

installer 97
external media, installing handheld 

application from 108
multiple synchronization servers 100
optimizing server process 

management 100
patches, deploying with Companion 

Sync 110
patches, deploying with Direct Server 

Sync 109
patches, distributing 109
patches, downloading 112
print templates, installing 107
server installation, server topology 

overview 96
server installation, support of Siebel Handheld 

Client 95
server logging levels, configuring 98
setup.ini file, editing 102
Siebel Handheld application, process of 

installing 102
Siebel Handheld Client, issues and 

validation 29
Siebel Handheld Direct Server Sync, server 

installation process 97
stand-alone installer, creating 108
synchronization performance and 

scalability 100
synchronization security 101
SynchURL, changing on handheld 

device 108
upgrade kits, creating to remotely deploy 

patch files 111
user database backups, enabling 105

diagnostics
enabling SQLTrace 188

Direct Server Sync
architecture 15
deploying, about 96
described 14
optimizing server process 

management 100
patches, deploying using 109

Direct Server Sync by Means of Proxy 15

Direct Server Sync deployments
stand-alone deployments 89

Direct Server Synchronization
checklist, using to troubleshoot 185
handheld application, using to install 123
handheld client, using with 137
log files, using for troubleshooting 186
network performance, 

troubleshooting 191
server performance, troubleshooting 191

direct synchronization server, 
described 14

disclaimer text, administering 71
distributor names, configuring 71
Divider print tag 219
documents, defining 33
downloading patches 112
drilldowns, about 29
drilling down, about 128
DSS components

using Siebel Server installer 97
dynamic drilldown, about 128
dynamic hyperlink, about 29

E
ellipsis, and expandable fields 128
end user error messages

See troubleshooting
EndofLine print tag 220
error messages

See troubleshooting
errors

error data, accessing 119
error details, obtaining from synchronization 

session 67
general synchronization errors 138
synchronization transaction conflicts 139

exchanging samples
creating a samples transfer 176

expense reports
creating 182
detailed line items, adding 182

exporting data 132
extended insert processing

about and synchronization 116
processing settings, recommended 119

extended pick processing
about and synchronization 113
enabling 114
processing settings, recommended 116

external media
backing up to 106
Siebel Handheld application, installing 
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from 108
stand-alone installer, creating 108

F
features, new 11
Find

about using 131
Footer print tag 221
form applets, configuring

about 26
designing, about 34
group boxes, about 26
labels, about 26
layout sequence 26

Format print tag 222

G
general activities

See activities, creating general activities
general sync filters, about 89
GetCount print tag 223
GetDate print tag 223
GetField print tag 224
GetRegistry print tag 225
GetTime print tag 226
GetTotal print tag 226
GotoView method, using 24
group boxes

about configuring 26
guidelines

Siebel Handheld client, configuration 
guidelines 20

H
handheld device logs

list of log files 187
synchronization errors, logging 188

handheld interface
See interface

handheld synchronization
See synchronizing

Header print tag 227
History button, about 129
Home Page applet, using 27
hot keys

about locked keyboard hot keys 161
hyperlinks, about 29

I
Inactive inventory period 172
initial master inventory

establishing, about 172

initial count adjustments, creating and 
submitting 173

products, adding to inventory and submitting 
initial count 173

installing
client installation, backup, and restore 

troubleshooting 183
CompactFlash card, setting handheld 

application installation on 107
Companion Sync, using to install handheld 

application 121
Direct Server Sync checklist, using 185
Direct Server Sync, using to install handheld 

application 123
external media, installing handheld 

application from 108
patches, deploying with Companion 

Sync 110
patches, deploying with Direct Server 

Sync 109
patches, distributing 109
patches, downloading 112
reinstalling the handheld application 124
resynchronization problems 186
Siebel Handheld application, editing setup.ini 

file 102
Siebel Handheld application, process of 

installing 102
software on handheld. about 121
stand-alone installer, creating 108
synchronization, about problems caused 

by 184
SyncURL, changing on handheld 

device 108
uninstalling handheld application 124
upgrade kits, creating to remotely deploy 

patch files 111
upgrade, preparing from a previous 

release 121
user database backups, enabling 105

interface
application-level menu 126
components, about and diagram 125
expandable fields 128
Minimize button 127
More Info view, navigation level 137
Queries drop-down list 127
screens menu, about 126
screens menu, navigation level 128
Show drop-down list, about 126
Show drop-down list, navigation level 128
Siebel toolbar, about 127
Siebel toolbar, customizing 127
status bar 127
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URLs in applet fields 128
inventory

initial count adjustments, creating and 
submitting 173

initial inventory count, about 
establishing 172

inventory counts, adjusting samples 178
inventory periods, configuring user properties 

for closing 75
inventory periods, types of 172
locations, setting up 58
products, adding to inventory and submitting 

initial count 173

K
keyboard hot keys, about locked 161

L
labels, about configuring 26
license information

adding and editing 143
list applets, configuring

about 25
designing, about 34
recommended strategy 25

log files
Companion Sync logs, using for 

troubleshooting 187
Direct Server Sync logs, using for 

troubleshooting 186
handheld device logs, using for 

troubleshooting 187

M
MarginBottom parameter 233
MarginLeft parameter 234
MarginRight parameter 234
MarginTop parameter 234
Maximize Minimize Applet button

about 127
MedEd events, setting

about 180
contacts, inviting to 181
creating a MedEd event 180

media
backing up to external media 106
Siebel Handheld application, installing from 

external media 108
stand-alone installer, creating 108

medical education
See MedEd events, setting

memory, increasing 139
menu bar, about 28

Microsoft ActiveSync, about 15
Minimize button, about 127
Mobile Web Client

note, about receiving and installing upgrade 
kits 111

More Info View
navigation level 137

multiple synchronization servers 100
Multi-Value Group applet, support of 19

N
Name field drop-down list

samples do not appear 159
naming conventions, about 22
network performance, about 191
new features 11
notes

adding about accounts 149
adding private or shared notes about a 

contact 145

O
objections

decision issues discussed during call 160
objects

caution, do not modify 202
OverridePopupVisibility

note, if used 93

P
Page Break print tag 228
PaperHeight parameter 234
PaperSize parameter 234
PaperWidth parameter 235
parent form applet, about 23
patches

Companion Sync, deploying using 110
Direct Server Sync, deploying using 109
distributing 109
downloading to the handheld device 112
upgrade kits, creating to remotely deploy 

patch files 111
PDQs

and Queries drop-down list 127
performance

application memory, increasing 139
client performance, about 190
improving by identifying user activities 20
improving performance, about 139
network performance, about 191
server performance, about 191
SQLTrace and synchronization 188

personal lists
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about 151
creating 154
scenario for setting up 152

pick applets
business object declaration examples 90
popup visibility, overriding 92
visibility, designating 91

Picture print tag 228
pop-up lists

about using auto pop-up lists 27
popup visibility, overriding 92
predefined queries

and Queries drop-down list 127
preferences

setting user preferences 133
prescription data, viewing 146
print applets

about designing 34
Print buttons, configuring 35
print tagging language

See print templates
print templates

Applet print tag 216
Cell print tag 217
Comment print tag 219
creating print templates 36
Divider print tag 219
EndofLine print tag 220
Footer print tag 221
Format print tag 222
GetCount print tag 223
GetDate print tag 223
GetField print tag 224
GetRegistry print tag 225
GetTime print tag 226
GetTotal print tag 226
Header print tag 227
Page Break print tag 228
Picture print tag 228
print template file example 231
print template file, creating overview 215
SetVariable print tag 230
Static Text print tag 230
Title print tag 230
variables, example using in template 231
views, associated with 24

print templates, installing 107
PrinterBaudrate parameter 235
PrinterCompressed parameter 236
PrinterDensity parameter 236
PrinterDither parameter 236
PrinterDraftMode parameter 236
PrinterFormFeed parameter 237
PrinterHandshake parameter 237

PrinterOrientation parameter 238
PrinterPort parameter 238
PrinterType parameter 239
printing

receipts for samples dropped 85
printing with handheld application 132
printing, configuration settings

default printing settings, list of 240
MarginBottom parameter 233
MarginLeft parameter 234
MarginRight parameter 234
MarginTop parameter 234
PaperHeight parameter 234
PaperSize parameter 234
PaperWidth parameter 235
parameters and syntax 233
PrinterBaudrate parameter 235
PrinterCompressed parameter 236
PrinterDensity parameter 236
PrinterDither parameter 236
PrinterDraftMode parameter 236
PrinterFormFeed parameter 237
PrinterHandshake parameter 237
PrinterOrientation parameter 238
PrinterPort parameter 238
PrinterType parameter 239

printing, configuring from handheld 
application

about 33
applet, configuring for printing 35
documents, defining 33
form applets, designing 34
list applets, designing 34
print applets, designing 34
Print buttons, configuring 35
print templates, creating 36

private notes
adding for accounts 149
adding for contacts 145

products
products detailed information, entering for 

account call 164
recording information about products 

detailed 158
samples transaction, adding to 178

professionals
affiliations, indicating between accounts and 

professionals 149
MedEd event, inviting to 181

projects
naming conventions, and 22

promotional items dropped, recording 
information about 160
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Q
queries

about using 131
creating/executing/refining a query 131

Queries drop down list
about 127

R
receipts, preparing for calls 85
Reconciled inventory period 172
record navigation buttons 129
recording account calls

about 164
attendee information, entering for account 

call 165
completed account call, submitting 165
products detailed information, entering for 

account call 164
recording contact calls

about 158
account calls, about 162
account calls, adding from Account Call 

view 163
account calls, adding from Accounts 

view 162
all contacts, showing 161
completed contact call, submitting 161
decision issues discussed during call, 

recording information about 160
promotional items dropped, recording 

information about 160
recording information about products 

details 158
samples dropped, recording 

information 159
Signature Capture view, changing 

contacts 161
signature, capturing 160
unused account call records, deleting 164
unused attendee calls, deleting 164

records
deleting unused records 158

records, navigating a list of
about 128
Back button 129
record navigation buttons 129

reinstalling the handheld application 124
removing

business component filter setting 49
business object filter section 51

reports
associating views with 24
expense reports, adding detailed line 

items 182
expense reports, creating 182

repository
compiling 30

responsibilities
assigning 47

restoring data
from a backup 134
Siebel Handheld Client, using 133
troubleshooting 183

restoring from a backup 107
returning samples

creating a samples transfer 176
Rx Data view

using to view prescription data 146

S
sales data, viewing 150
sample records, managing 70
samples

Name field drop-down list, samples do not 
appear 159

recording information about samples 
dropped 159

samples, managing
about 169
initial count adjustments, creating and 

submitting 173
initial inventory count, about 

establishing 172
inventory periods, types of 172
managing samples scenario 170
products, adding to inventory and submitting 

initial count 173
samples management, working with 

calls 171
samples order, creating 175
samples transaction, adjusting 

quantity 179
samples transfer, acknowledging 

receipt 177
samples transfer, adjusting 178
samples transfer, creating 176
samples views, about 174
server and handheld samples records, 

keeping in sync 169
screens

administrative screens, about 46
designing screens for Siebel Handheld, 

about 23
screen allocation 23
views, and 193

screens menu
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about 126
navigation level 128

scripting
Siebel Handheld Client, issues and 

validation 29
server installation

DSS components, using Siebel Server 
installer 97

hardware and network configuration 
recommended 96

optimizing server process 
management 100

server logging levels, configuring 98
server topology overview 96
Siebel Handheld Client, support of 95
Siebel Handheld Direct Server Sync, server 

installation process 97
server logging levels, configuring 98
server performance

troubleshooting 191
servers

multiple synchronization servers 100
ServiceCE Generic

about 28
Session Administration screen 46
SetVariable print tag 230
shared notes

adding for accounts 149
adding for contacts 145

Show drop-down list
about 126
navigation level 128

Siebel eConsumer Handheld
business component classes, list of 200

Siebel Handheld application
CompactFlash card, setting installation 

on 107
external media, installing from 108
patches, deploying with Companion 

Sync 110
patches, deploying with Direct Server 

Sync 109
patches, distributing 109
patches, downloading 112
process of installing 102
setup.ini file, editing 102
stand-alone installer, creating 108
SyncURL, changing on handheld 

device 108
upgrade kits, creating to remotely deploy 

patch files 111
user database backups, enabling 105

Siebel Handheld Client
application memory, increasing 139

auto-pop-up list, using 27
backing up and restoring data, using 133
configuration guidelines 20
Direct Server Synchronization, using with 

handheld client 137
form applets, about configuring 26
general synchronization errors 138
hardware and network configuration 

recommended 96
Home page applet, about 27
hyperlinks, about 29
improving performance, about 139
list applets, configuring 25
menu bar, about 28
Multi-Value Group applet, support of 19
printing, configuring 33
process of configuring 17
repository, compiling 30
scripting, issues and validation 29
server installation, support of Siebel Handheld 

Client 95
server topology overview 96
Siebel Web Client, differences in 

configuring 18
status bar, about 29
synchronization transaction conflicts 139
testing the handheld application 43
toolbars, about 28
unsupported functions 19
user functionality, defining 20
user interface elements, about 

configuring 25
Siebel Handheld Direct Server Sync

DSS components, using installer 97
optimizing server process 

management 100
process of server installation 97
server logging levels, configuring 98

Siebel Handheld projects
about creating and naming conventions 22

Siebel Handheld Synchronization
application memory, increasing 139
Direct Server Synchronization, using with 

handheld client 137
general synchronization errors 138
handheld client, using 135
improving performance, about 139
synchronization transaction conflicts 139

Siebel Medical Handheld, administering
administering process 69
DEA number, validating 84
disclaimer text, administering 71
distributor names, configuring 71
inventory period, configuring user properties 
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for closing 75
receipts, preparing for calls 85
sample records, managing 70
sign and submit button, validation logic 77
signature audit, performing 72
signature capture verification, configuring 

user properties 76
signature capture, verifying 73

Siebel Mobile Web Client
caution, about submitting calls 162

Siebel Pharma Handheld
applet classes, list of 201
business component classes, list of 200
business components, list of 197
objects (list), do not modify 202
screens and views, list of 193

Siebel toolbar
about 127
customizing 127

Siebel Web Client
Multi-Value Group applet, support of 19
Siebel Handheld client, differences in 

configuring 18
unsupported functions 19

Sign button, validation logic 77
Signature Capture view

changing contacts 161
signatures

audit, performing 72
capture verification, configuring user 

properties 76
capturing for recording contact calls 160
checksums, outcomes of 73
Signature Capture view, changing 

contacts 161
signature key, about 73
user properties 74
verifying signature capture, about 73

Smart Call
about 151
contact calls shortcut 155
Smart Call template, applying 157

software
about installing on handheld 121

SQLTrace, enabling 188
.SRF file

compiling repository file 30
SSL (Secure Sockets Layer)

synchronization security 101
stand-alone deployments, about 89
stand-alone installer, creating 108
Static Text print tag 230
status bar

application window, appears at bottom 

of 127
toolbar, located above 29

Submit button, validation logic 77
submitting

completed account call 165
synchronization sessions

error details, obtaining from 67
monitoring 67
monitoring, about 66
synchronization conflicts, obtaining 

information 68
synchronization sessions, obtaining an audit 

trail 68
synchronization transaction errors, acting 

on 69
synchronization, conflict handling and 

recovery
about 113
Client Wins conflict resolution 116
error data, accessing 119
extended insert pick processing settings, 

recommended 119
extended insert pick processing, 

about 116
extended pick processing settings, 

recommended 116
extended pick processing, about 113
extended pick processing, enabling 114

synchronizing
application memory, increasing 139
automatic backup after 

synchronization 134
Companion Sync 15
data, about 135
Direct Server Sync 15
Direct Server Sync by Means of Proxy 15
Direct Server Synchronization, using with 

handheld client 137
filters, general and default business object 

filters 89
general synchronization errors 138
handheld synchronization errors, 

logging 188
improving performance, about 139
methods and architecture 14
multiple synchronization servers 100
overview 14
performance and scalability, about 100
resynchronization problems, 

troubleshooting 186
servers, types of 14
Siebel Handheld Synchronization, using with 

handheld client 135
synchronization security 101
Siebel Pharma Handheld Guide Version 7.8250 



Index ■ T
transaction conflicts 139
troubleshooting, about problems caused 

by 184
SyncURl

changing on handheld device 108

T
templates

install templates, installing 107
print templates, creating 36
print templates, views associated with 24
Smart Call template, applying 157

testing the handheld application 43
timeout parameter

changing on Windows 2000 189
Title print tag 230
toolbars

about 127
configuring 28
customizing 127
toolbar functions 28

troubleshooting
client installation, backup, and restore 183
client performance, about 190
Companion Sync checklist, using 184
Companion Sync log files 187
Direct Server Sync checklist, using 185
Direct Server Sync log files 186
general synchronization errors 138
handheld device logs 187
network performance, about 191
resynchronization problems 186
server performance, about 191
SQLTrace, enabling 188
synchronization transaction conflicts 139
synchronization, about problems caused 

by 184
timeout parameter, changing on Windows 

2000 189

U
ui

See user interface elements, configuring
uninstalling the handheld application 124
upgrade kits

creating to remotely deploy patch files 111
upgrading

handheld application 124
preparing to upgrade 121

URLs
in applet fields, 128

User Administration screen 46
user database backups

backup, restoring from 107
database backup parameters, editing 106
enabling, about 105
external media, backing up to 106

user functionality, defining
about 20

user interface elements, configuring
about 25
auto pop-up lists, about using 27
buttons, about and behavior 27
form applets, about configuring 26
Home Page applet, about 27
hyperlinks, about 29
list applets, about configuring 25
menu bar, about 28
status bar, about using 29
toolbars functions 28
toolbars, about configuring 28

user preferences
about customizing 133

user properties
CUT Address - CE business component 205
Pharma Account Call - CE business 

component 206
Pharma Address business component 207
Pharma Address Inter Table - CE business 

component 210
Pharma Call Decision Issue - CE business 

component 211
Pharma Call Products Detailed - CE business 

component 211
Pharma Call Sample Dropped - CE business 

component 212
Pharma Inventory Period - CE business 

component 212
Pharma Professional Call - CE business 

component 208
Pharma Promotional Items Dropped 213

users, setting up
barcode definition, creating 64
barcode definition, process of creating 64
barcode scanning, enabling the SHCE Service 

FS Activity Parts Movements 
views 65

barcode scanning, enabling views for 63
barcode settings, administering 58
business component filter setting, 

adding 49
business object filter section, adding 50
business object filter section, removing 51
component level settings, configuring 58
error details, obtaining from synchronization 

sessions 67
new barcode definitions, creating 59
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process tasks 47
responsibilities, assigning 47
synchronization conflicts, obtaining 

information 68
synchronization sessions, about 

monitoring 66
synchronization sessions, monitoring 67
synchronization sessions, obtaining an audit 

trail 68
synchronization transaction errors, acting 

on 69
user level settings, removing 49
views, administering 47
views, methods for specifying 48

V
views

default behavior, overriding 24
drill-down only 23
print templates or reports, associated 

with 24
Siebel Handheld, about designing views 

for 23

views, administering
business component filter setting, 

adding 49
business object filter section, adding 50
business object filter section, removing 51
component level settings, configuring 58
tasks associated with 47
user level settings, removing 49
views, methods for specifying 48

visibility
designating in default Business Object 

declarations 91
OverridePopupVisibility, if used 93
popup visibility, overriding 92

W
Web server timeout errors

changing timeout parameter on Windows 
2000 189

Windows
changing timeout parameter on Windows 

2000 189
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